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About This User’s Manual

This manual provides detailed instructions on how to set up, use, and maintain Atrust mt188L mobile thin clients.

Manual Structure and Subjects

Chapter Subject
1 Provides an overview of Atrust mt188L mobile thin clients.
2 Provides detailed instructions on how to set up Atrust mt188L mobile thin clients.
3 Provides the basics of how to use Atrust mt188L mobile thin clients.
4 Provides instructions on how to configure client settings and customize Atrust mt188L

mobile thin clients with the Atrust Client Setup console.

Provides supplementary instructions on advanced settings, maintenance, and upgrade for

Appendices Atrust mt188L mobile thin clients.

Specifications Provides detailed information on key components of Atrust mt188L mobile thin clients.

Notes, Tips, and Warnings

Throughout this manual, the notes, tips, and warnings in the following formats are used to provide important
information, useful advice, and prevent injuries to you, damage to your devices, or loss of data on your system.

NOTE

(alll |

« A note provides important information for a specific situation.

TIP

74

- Atip gives a piece of useful advice to perform a task more efficiently.

@ WARNING

« A warning provides crucial information that must be followed to prevent injuries to
you, damage to your devices, or loss of data on your system.



Style Conventions

The following styles are used throughout this manual while referring to operational items on input devices,
hardware panels, or application interfaces.

Item
keys on the keyboard

application windows or
entry lists

buttons or tabs on a
window, toolbars, taskbar,
or menu

options on a window,
screen, list, or menu

selecting a series of options

Style
bold
first letter

capitalized

bold

bold

bold

Example
Ctrl + F2, Alt + F9, Alt + Tab
Confirm Dialog window, RDP Connection list, ICA Connection list,

View Connection list

OK, Next, Save, Applications tab

Add, Domain, Connection Type, High Quality

Applications > Citrix ICA, Applications > Remote Desktop,
Applications > VMware View, Network > Wireless,
Devices > Printer, System > Time Zone



Safety and Regulatory Information

Regulatory Statement

Federal Communications Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one of the following measures:

« Reorient or relocate the receiving antenna.
« Increase the separation between the equipment and receiver.
« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

« Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Any changes or modifications not expressly approved by the party responsible for compliance could
void the user’s authority to operate this equipment. This device complies with Part 15 of the FCC Rules. Operation is
subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

IMPORTANT NOTE:

FCC Radiation Exposure Statement
This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with minimum distance 20 cm between the radiator & your body.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.



Regulatory Information

WEEE (Waste Electrical and Electronic Equipment) Directive
In the European Union, this symbol indicates that this product should not be disposed of with
household waste. It should be deposited at an appropriate facility to enable recovery and recycling. For
mmm  proper disposal, please contact your local recycling or hazardous waste center.

Safety Information

@ WARNING

+ Use only power supplies listed in the user instructions.

@ WARNING

- Danger of explosion if battery is incorrectly replaced. Replace only with the same or
equivalent type recommended by the manufacturer.

@ WARNING

- For safety, do not make mechanical or electrical modifications to the equipment.

- Do not remove equipment covers and access any of the components inside the
equipment. Any access inside the equipment without an authorized or certified
technician may cause serious injuries and damage. For any problem, contact your
dealer for assistance.

+ You should only make repairs as authorized by the product documentation.
Repairs, replacement, expansion, and upgrades not performed by a certified service
technician may cause injuries to you, damage your system, and void your warranty.
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Overview

This chapter provides an overview of Atrust mt188L.

1.1 Introduction
Desktop virtualization and simple endpoint devices

1.2 Features
Key features of Atrust mt188L

1.3 Package Contents
Check your package contents

1.4 Exterior Components
Exterior components of Atrust mt188L

1.5 Before Getting Started
About the Battery Sleep mode
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Introduction

1.1 Introduction

Desktop virtualization provides a new perspective to reconsider the design and implementation of an IT
infrastructure. In a desktop virtualization infrastructure, a station is no longer a cumbersome desktop, but simply
an endpoint device for users to access delivery services from the server(s).

With the introduction of the desktop virtualization technologies, you can considerably benefit from:

« On-demand applications/desktops

« Centralized management of work environments

« Drastically reduced endpoint software/hardware issues

«  Simplified system maintenance and improved system security

+  More scalability with low-cost endpoint devices

1.2 Features

The key features of Atrust mt188L mobile thin clients are:

+  Built-in Wireless 802.11 ac/a/b/g/n, Bluetooth 4.2, and Ethernet network interface
«  Support for a wide range of desktop virtualization solutions from industry-leading companies:

o Microsoft® Remote Desktop
o Citrix® XenApp™, XenDesktop®, and VDI-in-a-Box™
o VMware® View™ and Horizon View™

Support for high-definition technologies
o Microsoft® RemoteFX®
o Citrix® HDX™
o VMware® View™ PColP®

Simple click-access to various applications/desktops

Built-in Atrust Client Setup as the local client management console

1.3 Package Contents

Please check your package contents. Ensure that all of the items are present in your package. If any items are
missing or damaged, please contact your dealer immediately.

Atrust mti188L AC adapter Quick Start Guide

Atrust s

NOTE: Your package may not contain a hard copy of the Quick Start Guide.
In this case, a soft copy in PDF format will be provided.

3
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Exterior Components

1.4 Exterior Components

Display and Base Components

No. Sign Component Description

1 LCD display Built-in display for visual output.

2 Microphone Built-in microphone for audio input.

3 Webcam (optional) Built-in video camera for real-time video.

4 Keyboard Built-in keyboard for control and input.

5 Touchpad Built-in pointing device for control and input.
e Glows yellow when the system is on.

6 Power LED e Goes off when the system is off.

e Glows red when the system is in Sleep mode.




Fn Key Combinations

With the combination of Fn }
adjust hardware settings to suit your needs.

Overview
Exterior Components

plus another specific key (with one printed blue symbol on it), you can quickly
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« To use an Fn key combination, press and hold Fn, and then press another key.

Combination Description

Combination Description

. . . . Use to increase the brightness of
Use to switch the use of displays. + % the LCD display.
= [+[7 2] Use to enable/ disable the touchpad. R R Use to decrease the brightness of

% J the LCD display.

Use to launch the defined application.
NOTE: This may not be applicable.

Use to decrease the volume of the
) built-in speakers.

Use to enable / disable the ECO mode.
ECO Mode: Screen Off mode

en

Use to increase the volume of the
L) built-in speakers.

en

Use to enable / disable the Webcam.

en

Use to mute / unmute the sound.

Use to enable / disable the Airplane mode.
Airplane Mode: disabled networks of all types

BN

en

Use to function as a Home key.

Use to enter the System Sleep mode.
Press the Power button or any key to exit.

BN

en

Use to function as an End key.
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Digits and Symbols in Num Lock Mode Description

Use to type in the desired digit or symbol.

NOTE: You must enable the Num Lock mode first.

00D E®

No. Sign Component Description

7 Sleep mode LED Glows orange when in Sleep mode.

8 Storage LED Blinks blue when flash memory is being accessed.
9 Num Lock LED Glows blue when Num Lock is enabled.

10 Caps Lock LED Glows blue when Caps Lock is enabled.

11 Bluetooth LED Glows blue when Bluetooth is enabled.

Glows blue when Airplane mode is enabled.

12 Wireless LED Airplane mode: disabled networks of all types

¢ Glows orange when the battery is being charged.
13 Battery LED e Glows blue when the battery is fully charged.
e Blinks orange when the battery power is low.
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Left and Right Side Components

A

No. Sign Component Description

14 Kensington security slot Connects a Kensington cable to secure the mobile thin client.
15 LAN port Connects to a network.

16 USB port (USB 3.0) Connects to a USB device.

17 Headphone port Connects to a set of headphones or a speaker system.
18 Microphone port Connects to a microphone.

19 DCIN Connects to an AC adapter.

20 mini DisplayPort Connects to a monitor.

21 HDMI port Connects to a high quality digital audiovisual device.
22 USB Type-C Connects to a USB Type-C device.

23 USB port (USB 2.0) Connects to a USB device.

e Press to power on your mt188L when the lid is opened.

24 Power button e Press to enter Sleep mode when your mt188L is on.
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Used to press the button inside to enter the Battery Sleep mode.

Built-in speakers for audio output.
Please see “"About the Battery Sleep Mode” on page 9 for details.

Description

Q@
- 2
= c
=
- o -1 o
= [=] 9] >
al X o
el § £
B < sl 2| %
©) O n o
e
2 @
m c
n o
) Qo c
a £ 2 W-J
£ () 0
20 Y
0 ©
= e £
> 0 o
[ )
U o =
> .
O & 5 = S

il




Overview |9
Before Getting Started

1.5 Before Getting Started

About the Battery Sleep Mode

For first time use, you must connect your mt188L to a power outlet using the supplied AC adapter for the built-in
battery to exit the Sleep mode.

To enter the Battery Sleep mode when needed, please do the following:

1. Shut down and unplug your mt188L.

2. Use the tip of an unfolded paper clip (or a similar object without a sharp tip) to gently press the button inside
the Battery Off hole.

%/ NOTE

. Please note that, to exit the Battery Sleep mode and power on your mt188L, you will
need to plug it in first using the supplied AC adapter.
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Getting Started

This chapter provides the basics of how to use your mt188L.

2.1 Learning the Basics

Topic 1:
Topic 2:
Topic 3:
Topic 4:
Topic 5:
Topic 6:

Atrust Quick Connection

Setting Up a Wireless Connection
Configuring the Time Zone

Accessing Desktops or Applications
Using Built-in Applications

Viewing and Managing the Use of Power

14
16
18
19
33
35
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2.1 Learning the Basics

The following topics will guide you through the basics of using your mt188L:

Topic 1:
Topic 2:
Topic 3:
Topic 4:

Atrust Quick Connection
Setting Up a Wireless Connection
Configuring the Time Zone

Accessing Desktops or Applications

«  Microsoft Remote Desktop Services (RDP sessions)
«  Citrix Services (ICA sessions)
« VMware View or Horizon View Services (View sessions)

Topic 5: Using Built-in Applications

Topic 6: Viewing and Managing the Use of Power

=) NOTE
7
« In case that by default your mt188L is Auto Setup enabled, its user environment
might be different from here and will vary with preset configurations. See section
3.2.9 and appendix A.4, and consult your IT administrator for details.
=) NOTE
7

« Three client modes are available for your mt188L:

No. Mode Description

The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.

Available actions include: (n/a to Web browser)

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection screen

3 Quick Connection after system startup.

+ In Quick Connection mode, you can access Microsoft Remote Desktop / Citrix /
VMware View or Horizon View services quickly without much client configuration
required. The main purpose of this chapter is to guide you through the use of your
mt188L under the Quick Connection mode. The default of your mt188L is NOT the
Quick Connection mode (after restart it will enter the local Linux desktop rather
than Atrust Quick Connection screen), but you can enter Atrust Quick Connection
screen through its shortcut on the local desktop or START menu.

+ To understand other modes, configure advanced settings, and customize your
mt188L, please refer to chapter 3 “Configuring Client Settings” on page 37.

13
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Learning the Basics

Topic 1: Atrust Quick Connection

To start using your mt188L, please do the following:

1. Press the Power button to turn on the client. Wait a moment for the system to enter the local Linux desktop.

Local Linux Desktop

Atrust

A [ [Terminal - user@atr. ..

2. Click Atrust Quick Connection on the desktop to enter Atrust Quick Connection screen.

2y

-

)

Atrust Quick Connection

Atrust

A [ [Terminal - user@atr. ..
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3. (a) Go to Topic 2 to set up a wireless connection if needed.
(b) Go to Topic 3 to set the time zone for the first time use.
(c) Go to Topic 4 for service access if the time zone had been set.

Atrust Quick Connection Screen

- Remote Desktop

Citrix

Atrust Quick Connection

& VMware View

"% Remote Desktop

| Citrix

& VMware View

Atrust

4 5 6

No. Icon

Description

1 Power Off

Click to shut down, suspend, or restart the system.

2 Local Desktop Click to return to the local Linux desktop.
3 Setup Click to launch Atrust Client Setup.
4 Mixer Click to configure audio settings.
Indicates the power source (adapter, battery, or both) and status.
Click to launch Power Management for details.
NOTE: Power Management enables you to configure power-saving settings for your
mt188L. You can choose appropriate options to suit your needs. See “Topic 6:
Viewing and Managing the Use of Power” on page 35 for details.
5 Power

NOTE: When your mt188L enters System Sleep mode manually (Fn + F12 or

@ > Suspend) or automatically (configured in Atrust Client Setup through
System > Power Management), it still requires a certain amount of power.

You can use Shut down option instead to save the power to a greater degree.

NOTE: When using only the battery as the power source, ensure that it has enough
power to prevent data loss.

6 Network

Indicates the network type (wired or wireless) and status.
Click to configure network settings.

NOTE: To set up a wireless connection, please see "Topic 2: Setting Up a Wireless
Connection” on page 16.

15
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Topic 2: Setting Up a Wireless Connection

To set up a wireless connection, please do the following:

1. On Atrust Quick Connection screen, click the Network ig icon. Atrust Client Setup is launched.

[0)
Atrust

VPN
Hosts

- Host Name
Wireless

~ Proxy

Navigator General
Ethernet

Atrust Client Setup alla Lol

Applications User Interface Derices Network System
- Interface N

. ¥ Enable ‘
¢ IP Address |
‘ IP Type: DHCP 1o ‘
- DNS <
‘ DNS Type: Dynamic DNS (via DHCP) hd i ‘
+ Wake On LAN \
‘ Wake On LAN: Enabled hd 'S ‘

Save H Cancel

2. Click Wireless. The Wireless Network list will be shown under the Connections sub-tab.

- anmtlamteme e
®H Atrust Client Setup | F=H Rl B
Atrust Applications User Interface Devices Newiork System
Navigator Connections Wireless
-~ Ethernet
- WPN + Add = Delete O, scan
- Hosts
[ Host Name SSID Priority  Signal  ~  Security status Comment -~
3 HP-Print-Fo-L... 20 100 Insecure
Praxy T-4P02 20 100 WFA
SMCWGBR14... 20 100 WPA
roaming24 20 100 WPA
roamings 20 100 WFA
Demo-APO1 20 a7 WPA BOZ.1x
HTC Portable... 20 94 WPA
TP-LINK_F38B... 20 a4 WPA
MIX2 20 a1 WPA
sophia_2.4G 20 8l WPA
Demo-APO2 20 81 WPA
KiKi-KR2 20 80 WPA
guest00l 20 80 WFA
TP-LINK_EFO1... 20 74 WPA
Batterylife 5G 20 72 WPA
IT-APO3 20 70 WFA
DSR-1000N 20 70 WPA -
KerKer~HerH... 20 68 WPA
MIXS 20 64 WFA
IT-APOL 20 62 WPA
HITRON-69B0 20 &0 WPA
HITRON-8920 20 55 WPA
CHT1081 20 54 WPA
;L min home 20 54 WPA | _l;l
B 3

%J‘ NOTE

-+ Your mt188L will perform network discovery once and specify all available wireless
networks in the Wireless Network list under the Connections sub-tab. To refresh this

Wireless Network list, click

3. Click to check the desired wireless network. The Connect button # Connect

Wireless Network list.

Ol!; Scan

on the top of the list.

then appears on the top of the
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- e e
®H Atrust Client Setup o=l
Atrust Applications  User Interface Devices Nemwork System
Navigator Connections Wireless
- Ethernet
VPN + Add = Delete O scan  # connect
Hosts
ssiD Priority  Signal # Security Status Comment |
- e“ HP-Prnt-Fe-L.. 20 100 Insecure
« IT-4P02 20 100 WPA
SMCWGBR14.., 20 100 WPA
roaming24 20 100 WPA
roamings 20 100 WPA
Demo-AP01 20 97 WPA 802.1x
HTC Portable... 20 94 WPA
TP-LINK_F38B... 20 94 WPA
MIX2 20 a1 WPA
sophia_2.4G 20 81 WPA
Demo-AP02 20 8l WPA
KIKi-KR2 20 80 WPRA
guest0ol 20 80 WPA
TP-LINK_EFO1... 20 74 WPA
Batterylife_S5G 20 72 WPA
IT-APO3 20 70 WPA
DSR-1000M 20 70 WPA -
Kerker~HerH... 20 68 WPA
MIXS 20 64 WPA
IT-4P01 20 62 WPA
HITRON-69B0 20 60 WPA
HITRON-8920 20 55 WPA
CHT1081 20 54 WPA
| min home 20 54 WPA | _I;I
B .

4. Click # Connect to create a wireless network connection through the selected wireless network.

5. A window appears prompting for confirmation or authentication.

o Wireless Network Authentication Required

Authentication required by wireless network. Passwords or encryption
keys are required to access the wireless network.

[WPa & wPA2 Personal |

Wireless Security:
Key g ]

Show character

Connect Cancel

% NOTE

- If you ever accessed this wireless network before, the password will be automatically
recorded for future access. In this case, you don’t need to provide the password
again; you only need to confirm the establishment of a wireless connection.

« Consult your network administrator for required information on authentication.

6. Type in the required password, and then click Connect to continue. Or, click OK to confirm the establishment
of a wireless connection.

7. Upon completion, the Status column of the wireless network will show connected.

SSID Priority  Signal Security Status *  Comment
IT-AP0O2 20 100 WPA connected Connected before
sophia_2.4G 20 92 WPA

roamings 20 87 WPA

roaming24 20 100 WPA

guest00l 20 87 WPA

dlink_DWR-113 20 38 WPA

dir-810-5g 20 45 WPA

dir-810-2g 20 94 WPA

amphencl_S5... 20 72 WPA

8. Close Atrust Client Setup.
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Topic 3: Configuring the Time Zone

To set the time zone for your mt188L, please do the following:

1. Click the Setup @ icon to launch Atrust Client Setup.

Navigation Area
Click to select

a setting item
or entry.

Atrust Client Setup

® Atrust Client Setup ol LOLILES
Atrust Applications  User Interface Devices Network System
Navigator Applications

‘Remote Desktop
" Citrix ICA
VMware View
-~ 55H
Web Browser
- Parallels 2X Client

gl’, Remote Desktop fvailable Sessions: 0
[ Configure RDP (Remote Desktop Protocol) connection settings

Citrix ICA Available Sessions: 0

Configure Citrix ICA connection settings

@ VMware View £vailable Sessions; 0
Configure WMware View connection settings

SSH Available Sessions: 0
&% Configure S5H (Secure Shell) session settings

, Web Browser Available Sessions: 0
Configure local browser settings

Parallels 2X Client Availzble Sessions: 0
Configure Parallels 2X Client settings

3 NOTE

« For detailed instructions on how to configure client settings and customize your

mt188L with Atrust Client Setup, please refer to chapter 3 “Configuring Client
Settings” on page 37.

2. On Atrust Client Setup, click System > Time Zone.

(Time Zone )
\_\_

Atrust

Navigator General
Time Zone

-~ Password

-~ Firmware Update
-~ Appliance Mode

- Auto Setup
- Quick Connection

- Power Management

al
R }mn
| Save l & Manaaer

~——

Information

[ save

System

Applications  User Interface Devices Newwork System

¢ Time Zone

| Time Zone:

(GMT) Coordinated Universe | |

« NTP
| NTP Server Address

+ [poolntp.org &

|| cancel

3. Click the Time Zone drop-down menu to select the desired time zone.

4. Click Save to apply, and then close Atrust Client Setup.

Category Tabs
Click a tab to select
a setting category.

Time Zone
drop-down menu
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Topic 4: Accessing Desktops or Applications

Through Atrust Quick Connection screen, you can access three types of desktop virtualization services:
Remote Desktop, Citrix, and VMware View.

Atrust Quick Connection Screen
= Remote Desktop

Citrix

Atrust Quick Connection

emote Desktop == o
& VMware View
® | Citrix

" @ VMware View

Atrust

=

Icon Description
Remote Desktop Click to access Microsoft Remote Desktop services.
Citrix Click to access Citrix XenApp, XenDesktop, or VDI-in-a-Box services.

VMware View Click to access VMware View or Horizon View services.

Page
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Accessing Microsoft Remote Desktop Services

To access Microsoft Remote Desktop services, please do the following:

1. Click BERRALEEE ol o, Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared window, type in the computer name or IP address of the server, user name, password, and
domain (if any), and then click Connect.

~

d

Session name: <Quick Connection: 'I
MR- ]
WMS

Remote Destkop
Connection

___ To return to the previous screen, press Esc.
) Use Alt + Tab to select and restore a hidden or minimized
~  application or deskiop session.

—=)) NOTE

Ll

« To discover available Windows MultiPoint Server systems over your network,
please do the following:

ey
1. Click we™ on the left of the Computer field.
2. Upon completion, a window appears with the search result.

Confirm Dialog

Windows MultiPeint Servers' list, please select one that you
want to connect:

|EE-SV1 (192.168.11.108) ﬂ

3. Click the drop-down menu to select the desired system, and then click OK.
4. The IP address of the selected system will appear in the Computer field.

» To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.

3. The remote desktop will be displayed on the screen.
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Accessing Citrix Services

Connecting to the Server

To connect to the server through which Citrix services are accessible, please do the following:

1. Click on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the appeared Atrust Citrix Connection screen, enter the appropriate IP address / URL / FQDN of the server,
and then click Log On.

Atrust Citrix Connection Screen

Citrix Receiver

NOTE

(alll |

- For newer versions of XenDesktop and XenApp, you may need to further specify
the sub-path of the server. Refer to the following table for details:

Component to

Citrix Product Connect

Connection Address

XenApp 6.5 or

earlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5

+ FQDN is the acronym of Fully Qualified Domain Name.

- To return to Atrust Quick Connection screen (see the screen in Topic 4), press Esc.
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Logging On to Citrix Services

When connected to the server, the Citrix Logon screen appears. The appeared screen and required credentials for
Citrix services may vary with the service type and version.

@ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “3.2.17 Importing Certificates for
Remote Computers” on page 68.To bypass, click | Understand the Risks > Add
Exception > Confirm Security Exception.

The following are some examples of Citrix Logon screens.
XenDesktop 5.6 Platinum:
Citrix Logon Screen

Citrix XenDesktop

Type the required
user name, password,
and then click

Log On to access
virtual desktops.

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet

CITRIX" (0%

@ NOTE

«+ To return to Atrust Quick Connection screen, press Esc.
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XenApp 6.0 Fundamentals:

Citrix Logon Screen

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

NOTE

(]

+ To return to Atrust Quick Connection screen, press Esc.

- If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.

XenApp 6.5 Platinum:

Citrix Logon Screen

Citrix XenApp

Type the required

user name, password,
domain, and then click
Log On to access
virtual applications.

Logon

e
s I
-

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

cimRix (=2

NOTE

Wl

« Toreturn to Atrust Quick Connection screen, press Esc.

« If your XenApp server doesn’t belong to any domain, type the computer name of
the server in the Domain field.
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VDI-in-a-Box:

Citrix Logon Screen

Type the required user
name, paSSWOrd, Citrix Receiver

and then click

Log On to access
virtual desktops.

NOTE

ol

+ To return to Atrust Quick Connection screen, press Esc.

XenApp and XenDesktop 7.5 Platinum:

Citrix Logon Screen

Type the required user CitrixReceiver
name, password,

and then click

Log On to access
virtual desktops.

NOTE

[l

« Toreturn to Atrust Quick Connection screen, press Esc.
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Accessing Virtual Desktops and Applications

You will enter the Desktop Selection or Application Selection screen after logon. On the screen you can click to select
the desired desktop or application(s).

5’/ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

TIP

« Use Alt + Tab to select and restore a hidden or minimized application or desktop.

@

The following are some examples of Selection screens and delivered desktops and applications.
XenDesktop 5.6 Platinum:

1. The Desktop Selection screen appears after logon.

Desktop Selection Screen

& cmx

Setings Log

2. Click to select the desired desktop.

3. The selected virtual desktop will be displayed on the screen.
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Virtual Desktop Example: Windows 7 Ultimate

) Wecometoyou i HenDeskiop

Welcome to the virtual workstyle

Your desktop, jocuments at your fingertips
urv ine freedom t0 do whatever, wheneve

—w
20 a4

XenApp 6.5 Platinum:

1. The Application Selection screen appears after logon.

Application Selection Screen

—— S8 cmpe

2. Click to select the desired application(s).

3. The selected application(s) will be displayed on the screen.
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Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

Open a Recent File Acrobat.com Services

TR cresepor onine

i/ NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore

a hidden or minimized application window.

+ Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

< Click to launch another virtual desktop if any or to launch other applications.
<~ Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.

XenApp and XenDesktop 7.5 Platinum:

1. The Application Selection / Desktop Selection screen appears after logon.

Application Selection Screen

27
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You might see this
screen when you log
in to XenApp 7.5 for
first time. Just click
to add your favorite

apps from a list. Al ADD YOUR

~ || FAVORITE APPS}

Desktops

— Two buttons may be available
for your to switch between
Application and Desktop
Selection screen, depending on
your server-side deployment.

Desktop Selection Screen

2. Click to select the desired application(s) or desktop.

3. The selected application(s) or desktop will be displayed on the screen.
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Virtual Desktop Example: Windows Server 2008 R2

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

vecmas §) 8 12 5 11 5

=) NOTE

« Clicking on Application Selection screen will bring the screen to the front and leave
all launched application windows hidden behind. Use Alt + Tab to select and restore
a hidden or minimized application window.

« Exiting a virtual desktop or application will return to the Desktop Selection or
Application Selection screen. On the screen, you can:

<~ Click to launch another virtual desktop if any or to launch other applications.
< Click Log Off on the top of the screen to return to the Citrix Logon screen.
< Press Esc to return to Atrust Quick Connection screen directly.
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Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Click ol on Atrust Quick Connection screen (see the screen in Topic 4).

2. On the opened window, double-click Add Server icon or click New Server in the top-left corner. A window
appears prompting for the name or IP address of the VMware View Connection Server.
3. Enter the required information, and then click Connect.

P N
_lle  Connect

VMware Horizon Client

File Connection View Help

+ New Server

+ New Server

Add Server

Add Server

vmware Horizon

Enter the name of the Connection Server,
Add Server I
Connect

|
Connect

Cancel

NOTE

- To return to Atrust Quick Connection screen (see the screen in Topic 4), close the
opened window.

=

4. A Welcome window might appear, click OK to continue.

5. A window appears prompting for the credentials. Enter your user name, password, click the Domain
drop-down menu to select the domain, and then click OK.

PR

Server Login

vmware Horizon

Server: (@ bitps:i/AMCSVHV poc

Username: |
Password:
Domain: WHY A4

Cancel
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@‘/ NOTE

« A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.
To import a security certificate, please refer to section “3.2.17 Importing Certificates
for Remote Computers” on page 68.To bypass, click Connect Insecurely.

6. The Desktop and Application list appears with available desktops and/or applications for the provided
credentials. Double click to select the desired desktop or application.

G-l

@ VMware Horizon Client
H

lle Connection View Help

&Y | [ HHpsIMVCS VHVpoc w X

B ” =
/8 / &
< >
Acrobat Reader Calculator Mozilla Firefox Notepad Paint

Snipping Toal Ww7U WS0BR2 Windows Media
Player

7. The virtual desktop or application will be displayed on the screen.

Virtual Desktop Example
Windows 7 Ultimate

)| Eie - Connection ~ View v Connect USB Device ~ Help ~ | (D &)
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Virtual Application Examples (VMware Horizon 6 with View)
Adobe Reader, Windows Media Player, Mozilla Firefox, and Calculator

[®] e~ Connection v View~ Hep~ | DB ®

1B Adobe Acrobat Reader DC EIEE)
Fie Edt View Window Help
Home Tools. @ signin

o lm =
| M Getto know Mo x\ +
€)@ o 5| o/ /ool orgen-US/aboututm medium=Referlgutm_| G || Q0 Search wE $ A9 =
2 ] " INTERNETHEALTH  WEBINNOVATIONS  DONATE mozilla
- i
mozitta
Comment Fill & Sign Edit PDF 1 caletator o] = [
View Edit Help
Open |+ Open |+ Open |+

o D e

Create PDF Combine Files Send & Track

Open  ~ Add |- Open |~

&5

Certificates Organize Pages

Learn more about our projects,
products and principles designed to
help people take control and explore
the full potential of their lives online.

Open |~ Add |~

—=J) NOTE

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to
recall the Desktop and Application list.

@ Connection » View ¥ Connect USB Device ¥ Help~ | (O O X
= Disconnect from Server. ..
| Return to Desktop and Application List

{38 Preferences

o] Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

File * Connection v yieT Hep~ | & B X

) Windowed

® Full Screen - This Monitor

O Full Screen - All Monitors
Resize »
Show Favarites

Bl Adobe Acrobat Reader DC
@ Firefox

[} Windows Calculator

(& Windows Media Player

= W7U
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Topic 5: Using Built-in Applications

To use built-in applications (Web browser, PDF viewer, LibreOffice, etc), please do the following:

%J’ NOTE

- The access shortcuts for built-in applications may be hidden by default. You need to
enable the display of those shortcuts on the desktop and START menu first.

1. Enable the display of application shortcuts on the local desktop and START menu.
1) On the local desktop, click START > Settings > Atrust Client Setup to launch Atrust Client Setup.
2) On Atrust Client Setup, click User Interface > Desktop.

. anechemsenn R
® Atrust Client Setup sl |LEL LG

Atrust Applications User Interface Devices Network System

General

- System Language -
Language: English [

Screensaver This setting will take effect after reboot.

 Desktop Fonts
Default Font:

Default Font Style: Regular

Defauit Fo ize

Title Font:

Title Font Style: Regular

remieee

Title Font Size: 12 -

- Desktop lcons
Remote Desktop
Citrix

=

L[ VMware View
¥ Firefox Web Browser
LibreOffice

PDF Viewer (Document Viewer) |

=
=

save || Cancel

3) Click to check LibreOffice and PDF Viewer, and then click Save to apply.

Atrust Client Setup

Atrust Applications User Interface Derices Network System

Navigator General
"~ Displa: -
Dasktop - System Language §
Keyboard Language: 5]
- Mouse
‘- Screensaver This setting will take effect after reboot.
( Desktop Fonts ————————ware View
Default Font
efaul Font sl v Firefox Web Browser
Default Font Size:
Title Font v Libreoffice

Title Font Style:
Title Font Size:

+ PDF Viewer (Document Vie

- Desktop lcons
Remote Desktop
Citrixc

|| Cancel |

=

L [ VMware View
| v Firefox Web Browser
. ¥ Lbreoffice

¥ PDF Viewer (Decument Viewer)

save || cancel

4) Close Atrust Client Setup.
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2. The shortcuts appear on the local desktop and START menu.

|2 Document Viewer
@ Firefox Web Browser
[ LibreOffice

@ Atrust Quick Connection
[Accessofes b (<4 Document Viewer
P | @ Firefox Web Browser
[ LibreOffice

| |@ (Terminal - User@at... |

3. Click shortcuts on the desktop or START menu to launch applications.

Atrust

us O «less) 14:48]
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Topic 6: Viewing and Managing the Use of Power

To view and manage the use of power for your mt188L, please do the following:

1. On Atrust Quick Connection screen or on the local Linux desktop, click the Power @ icon in the
bottom-right corner to launch Power Management. Here you can view the use and settings of power.

— Power Management dallodlo
General
rinformation
Current power source : AC power
Charge status : Charging
Remaining battery power : 79%

rSetting

AC power saving mode: | Low

Battery power saung mode:

Dimmed LCD: Dimmed LCD: 5 minutes later
Turn off LCD: Turn off LCD: 10 minutes later
@ Suspend ) Shut down @ Suspend ) Shut down 1 hour later

You can click Adjust button to change settings.

2. If needed, click Adjust to launch Atrust Client Setup to configure the settings of power.

®) Atrust Client Setup ealloalii=liie.S
Atrust Applications  User Interface Derices Network System
Time Zone
- Password ¢ Power button action
- Appliance Mode E P -
- Auto Setup - .
- Quick Connaction ¢ Power Management 1
AC power saning mode: &
- Terminal
A Dimmed LoD, &
- Certificate Manager .
 ertfcate Mansger ||| mum o Lo &
+ System Information Enter Suspend or Shutdown: e
Suspend or Shutdown after (Mever = Disable) B
Battery power saving mode: e
Dimmed LCD: S minutes later e
Turn off LCD: 10 minutes later =
Enter Suspend or Shutdown: [
Suspend or Shutdown after (Never = Disable) 1 hour later e
Save H Cancel

3. Choose the desired power-saving mode for your AC power and battery, or choose Custom to customize
individual settings, and then click Save to apply.

=) NOTE
5 "°
+ When your mt188L enters System Sleep mode manually (Fn + F12 or @ >
Suspend) or automatically (configured in Atrust Client Setup through System >
Power Management), it still requires a certain amount of power. You can use
Shut down option instead to save the power to a greater degree.

@ WARNING

« When using only the battery as the power source, ensure that it has enough power
to prevent data loss.

35



36| Getting Started

Learning the Basics



Configuring Client Settings

This chapter provides instructions on how to configure advanced
settings and customize your mt188L with Atrust Client Setup.

3.1 Atrust Client Setup

Interface overview 39
Available settings at glance 40

3.2 Configuring System Settings

System tab overview 41
Available settings at a glance 42

3.3 Configuring User Interface Settings
User Interface tab overview 74
Available settings at a glance 75

3.4 Configuring External Device Settings

Devices tab overview 88
Available settings at a glance 89

3.5 Configuring Network Settings
Network tab overview 97
Available settings at a glance 98

3.6 Configuring Service Access Settings

Applications tab overview 120
Available settings at a glance 121
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3.1 Atrust Client Setup

Your mt188L comes with Atrust Client Setup, the built-in local client management console to help you configure
client settings and customize your mt188L.

3.1.1 Interface Overview
To access Atrust Client Setup on your mt188L, please do the following:
1. On Atrust Quick Connection screen, click the Setup @ icon to launch Atrust Client Setup.

2. The Atrust Client Setup window appears.

Interface Overview

o 6 ® O (5]

ceee
cece
ceee
ceee
ceee

Atrust Client Setup
.

g g g g
Atru'—'-'t Applications User Interface Devices Network System
sesscsscssdeseeRemote Desktop
@ Citrix ICA 4 . Remote Desktop Avzilable Sessions: 0 R b ."‘..."0
VMware View 4 configure RDP (Remote Desktop Pratocol) connection settings
SSH

Web Browser

Parallels 2X Client Citrix ICA Available Sessions: 0

Configure Citrix ICA connection settings

VMware View Available Sessions: 0

Configure WMware View connection settings

8SH Available Sessions: 0
<F Configure SSH (Secure Shell) session settings

. Web Browser Available Sessions: 0
Configure local browser settings

Parallels 2X Client &vailable Sessions: 0
Configure Parallels 2X Client settings

Interface Elements

No. Name Description
1 Applications tab Click to configure settings for service access through the client.
2 User Interface tab Click to configure settings for the user interface of the client.
3 Devices tab Click to configure settings for external devices of the client.
4 Network tab Click to configure settings for the connectivity of the client to networks and servers.
5 System tab Click to configure settings for the operation and maintenance of the client.
6 Navigation area Click to select a setting item under a selected tab or to select a setting entry under

a selected setting item.

7 Configuration area Configures setting values when a setting item or entry is selected.
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3.1.2 Client Settings at a Glance

The following table provides a brief description of each setting item under five main setting categories.

Tab

System

User Interface

Devices

Network

Applications

Setting Item

Configuring time zone and time server
Configuring passwords

Configuring remote assistance settings
Updating firmware

Enabling/Disabling the Appliance mode
Enabling Auto Setup

Configuring Quick Connection
Managing the use of power

Managing the action of Power button

Enabling/Disabling the execution of the
text-based (command-line) functions

Collecting event logs, capturing related

screens, and upload files for error reporting
Importing certificates for remote computers

Enabling/Disabling Auto Registration

Viewing system and network information

Configuring display settings

Customizing desktop and system language

Hiding/Showing Quick Access shortcuts
Using a custom wallpaper

Adjusting keyboard settings

Adjusting mouse settings

Configuring screensaver settings

Configuring settings for USB storage devices

Configuring settings for audio devices

Configuring settings for local/network printers

Configuring wired network settings
Configuring VPN settings

Creating the mapping of IP addresses to the

names or aliases of hosts

Creating the Failover Cluster list
Changing the host name of your client
Configuring wireless network settings

Configuring proxy settings for Web-based

access to services

Configuring Microsoft RDP connection settings
Configuring Citrix ICA connection settings
Configuring VMware View connection settings

Configuring SSH connection settings

Configuring Parallels 2X connection settings

Configuring local Web browser settings

Section

3.2 Configuring System Settings

3.3 Configuring User Interface Settings

3.4 Configuring External Device Settings

3.5 Configuring Network Settings

3.6 Configuring Service Access Settings

Page
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3.2 Configuring System Settings

3.2.1 System Tab Overview

System tab enables you to configure settings for the operation and maintenance of clients. To access available
settings of System tab, click the tab on Atrust Client Setup.

System Tab Overview
® Atrust Client Setup CEN =N W= [
AtrUSt Applications User Interface Derices Network System
a“"”". OGOO'PI'iamSl:wZOUrr;e _7 ime Zone P 1§ -ooc-oo-og
Firmware Update U et the time zone and time server
Appliance Mode
Auto Setup P i
Quick Connection l‘ asswor
Power Management Configure administration privileges and remote assistance settings
Terminal
Error Report Firmware Update
Certificate Manager t’ da ﬁUP_ are th hth work
Advanced Update firmware through the networl

System Information
%, Appliance Mode

Configure Appliance mode

E. » Auto Setup
== Configure Auto Setup Mode

ru Quick Connection
\La’
Configure Quick Connection mode

= Power Management
Configure the Power Management

Terminal
&L Configure the access of command-line interface

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under System tab.

2 Configuration area Configures setting values when a setting item or entry is selected.
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3.2.2 Available Settings at a Glance

Tab Setting

Time Zone

Password

Firmware Update

Appliance Mode

Auto Setup

System Quick Connection

Power
Management

Terminal

Error Report

Certificate
Manager

Advanced

System
Information

Icon

Ly

2

a 17

]

4

@ » &l ©

Description

Click to configure the time zone and time server for
your mt188L.

Click to configure the access privileges of Atrust Client
Setup for mt188L users.

Click to set the login password for the local desktop.
Click to configure settings for remote assistance.

Click to update firmware through the network. This
feature is applicable to the client only when the client is

managed by the remote Atrust Device Manager console.

Click to enable/disable the Appliance mode to allow

/ disallow the automatic RDP / ICA / View / Web /

2X sessions. In Appliance mode, the client starts up
directly with the desired RDP / ICA / View / Web / 2X
session and performs the configured action after exiting
the session.

Click to enable Auto Setup to allow the client to get its

preset configurations on startup and enter the desired
user environment automatically.

Click to configure the Quick Connection mode.

Click to manage the use of power.

Click to manage the action of Power button.

Click to enable/disable the execution of the
text-based (command-line) functions.

Click to collect error log and launch the screen
capturing program for error reporting.

Click to upload files to a specified FTP server for error
reporting.

Click to import or manage certificates for
remote computers.

Click to configure advanced settings such as
Auto Registration.

Click to view detailed system and network information.

Section
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3.2.5

3.2.6

3.2.7

3.2.8
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3.2.12

3.2.13

3.2.14

3.2.15
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3.2.19
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NOTE

i)

« Atrust Device Manager is a remote and mass client management console,
helping you remotely manage a large number of endpoint devices in a desktop
virtualization infrastructure. For more information about Atrust Device Manager,
please refer to the User’s Manual for Atrust Device Manager.

3.2.3 Configuring Time Zone and Time Server

The Time Zone setting allows you to configure the desired time zone and time server to get the accurate system
time for your mt188L.

To set the desired time zone and time server, please do the following:

1. On Atrust Client Setup, click System > Time Zone.

Atrust Client Setup

Atl'l.l St Applications User Interface Derices Network System.
Navigator General
Time Zone
- Password - Time Zone \
~ Firmware Update ‘ Time Zone: [GMT+9:00 -le ‘
-~ Appliance Mode L J
-~ Auto Setup
- Quick Connection [ NTP 1
- Power Management NTP Server Address # [poolntp.org | =
-~ Terminal .
- Error Report S —
- Certificate Manager | Save ] | Cancel
- Advanced B

- System Information

2. Under the Time Zone section, click the drop-down menu to select the desired time zone.

3. Under the NTP (Network Time Protocol) section, use the default or type in the desired time server.

—=)) NOTE
=
- The IP address of the default time server is pool.ntp.org. For more information on
the default, please refer to the website for the NTP Pool Project at www.pool.ntp.org.

« Ensure the connectivity of your mt188L to the network or Internet in order to get
accurate time from the time server.

4. Click Save to apply.
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3.2.4 Configuring the Access Privileges and Passwords of Atrust Client Setup

You can configure the access privileges of Atrust Client Setup for mt188L users by the Password setting.

=) NOTE

&l

+ All mt188L users are allowed to access Atrust Client Setup by factory default.
You can make changes as desired using this setting.

Setting Access Privileges and Password Only for Administrators
To set access privileges and password only for administrators, please do the following:

1. On Atrust Client Setup, click System > Password.

& Atrust Client Setup o alliCS
Atru St Applications User Interface Devices Network System
Navigator General
- Time Zone
Password ¢ Administrator
Firmware Update ‘ L Active Admin Authorization ‘
- Appliance Mode L
- Auto Setup

- Quick Connection ¢ Local Desktop

- Power Management
-~ Terminal g
-~ Error Report - Shadow

e Enable Password Authentication for Local Desktop ‘

- Certificate Manager
Advanced .. ¥ Enable shadow

- System Information

Change Password

| Save H Cancel |

2. Under the Administrator section, click to check Active Admin Authorization.

3. The access privileges for administrators are granted and a window appears for you to set the password.

- - T T
® Set Password diala
Confirm Password = :]

* Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.
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Setting Access Privileges and Password Also for Standard Users
To set access privileges and password also for standard users, please do the following:

1. On Atrust Client Setup, click System > Password.

2. Under the User section, click to check Active User Authorization.

®) Atrust Client Setup o [alliCS
Atrust Applications  User Interface Derices Network System.
Navigator General
- Time Zone
Password ¢ Administrator

- Firmware Update

- Appliance Mode

- Auto Setup

- Quick Connection

- Power Management

L ¥ Active Admin Authorization ‘

Change Password

. r User
- Terminal
-~ Error Report [ Active User Authorization
-~ Certificate Manager .
~ Advanced ¢ Local Desktop

- System Information . Enable Password Authentication for Local Desktop ‘

r Shadow
.. ¥ Enable shadow ‘

Change Password

| Save ] | Cancel

%J‘ NOTE

« The User section appears only when Active Admin Authorization is checked.

3. The access privileges for standard users are granted and a window appears for you to set the password.

Set Password

Confirm Password = :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.

a5
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3.2.5 Configuring the Login Password for the Local Desktop

To enable and set the login password for the local desktop, please do the following:

%J’ NOTE

« The default behavior is to enter the local desktop without any login password.

1. On Atrust Client Setup, click System > Password.

®) Atrust Client Setup o Lol

Atl'l.l St Applications User Interface Derices Nemvork System

Navigator General

-~ Time Zone

Password - Administrator

- Firmware Update ‘ - Active Admin Authorization ‘
- Appliance Mode L

- Auto Setup - Local Desktop ‘

- Quick Connection
- Power Management ‘ e Enable Password Authentication for Local Desktop

- Terminal .
-~ Error Report - Shadow
- Certificate Manager

Enable Shad
- Advanced k= ¥ Enable Shadow
- System Information

Change Password

| Save H Cancel |

2. Under the Local Desktop section, click to check Enable Password Authentication for Local Desktop.
A window appears for you to set the password.

Set Password

Confirm Password = :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 20 characters long.

3. Type in the desired password, and then click OK to confirm.

4. Click Save to apply.
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NOTE

« When this feature is enabled, each time when you start or restart your mt188L,
you will be prompted to provide the Login password for the local desktop.
The Login screen is shown as below.

Login Screen of Local Desktop

Enter your local password

Possworc:

Atrust
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3.2.6 Configuring Shadow Settings for Remote Assistance

The Shadow feature allows an administrator to remotely assist client users in resolving problems or configuring local
settings. When this feature is enabled, an administrator can monitor and control a client from a remote computer
just like a local user.

NOTE

+ To use the Shadow feature on a remote computer, you need to install the Atrust
Device Manager console on that computer, and add your mt188L into a managed
group under Atrust Device Manager. For details, please refer to the User’s Manual
for Atrust Device Manager.

% :

To enable the Shadow feature and set the password for remote assistance, please do the following:

1. On Atrust Client Setup, click System > Password.

Atrust Client Setup

Atru St Applications User Interface Devices Network System
Navigator General
- Time Zone
Password ¢ Administrator
Firmware Update ‘ L Active Admin Authorization ‘
- Appliance Mode L
- Auto Setup

- Quick Connection ‘ Local Desktop

- Power Management
- Terminal L
- Error Report - Shadow
- Certificate Manager

Advanced .. ¥ Enable shadow
- System Information

e Enable Password Authentication for Local Desktop ‘

Change Password

| Save H Cancel |

2. Under the Shadow section, click to check Enable Shadow if it's not checked.

NOTE

«+ By default, the Shadow feature is enabled. Click Change Password, and then follow
the next step to set your password.

=

3. The Shadow feature is enabled and a window appears for you to set the password for remote assistance.
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[ e

Set Password

Confirm Password * :]

*Your password can contain letters, numbers, and
special characters.
* It must be 4 to 8 characters long.

NOTE

(alll |

- On aremote computer, an administrator will need this password to use the Shadow
feature (remote assistance) with the Atrust Device Manager console. For more
information, please refer to the User’s Manual of Atrust Device Manager.

4. Type in the desired password, and then click OK to confirm.

5. Click Save to save all the changes.

NOTE

i

+ When the Shadow feature is performed from a remote Atrust Device Manager, on

the target client, an icon appears on the Taskbar of the local Linux desktop
and a notification pops up in the bottom-right corner. If you are under the Quick

Connection mode, a notification would pop up in the bottom-right corner on
Atrust Quick Connection screen.
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3.2.7 Updating Firmware from the Management Computer

Update Firmware allows client users to update firmware from its management computer.

il

NOTE

« Ensure that your mt188L has been added into a managed group under Atrust

Device Manager installed on a remote computer, and that you have imported client
firmware files into Atrust Device Manager. These are prerequisites of this feature.

+ For more information on firmware update and Atrust Device Manager, please refer
to the User Manual for Atrust Device Manager.

To update firmware from the management computer, please do the following:

1.

- Time Zone

- Password
Firmware Update

- Appliance Mode

- Auto Setup

uick Connection

- Power Management

- Terminal

Error Report

- Certificate Manager

- Advanced

- System Information

Applications

General

- Firmware Update

Current VWersion: Ver. 5.25-PREE

This setting will take effect after reboot.

User Interface Derices Network System

On Atrust Client Setup, click System > Firmware Update.

Check Firmware

Cancel

4. Click Yes to continue.

®

2. Under the Firmware Update section, click Check Firmware.

3. Upon completion, a window appears notifying you that the Firmware list has been loaded.

Confirm Dialog

(:\ List Loading Completed!
J

.
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5. Click the drop-down menus to select the desired firmware version and other update options.

Atrust

- Time Zone

- Password

Firmware Update

- Appliance Mode

Auto Setup

- Quick Connection
- Power Management
- Terminal

Error Report
Certificate Manager

Advanced
- System Information

Applications User Interface Devices

General

- Firmware Update
Current VWersion: Ver. 5.25-PREE

Firmware Version: |ATRUSTL\NUX 5.25-FPREE h

(o
Language: |Eng\ish hd il T
Reboot Immediat ely: [Mo -l o

Check Firmware

This setting will take effect after reboot.

Update ﬁrmwarel ‘ Cancel

Firmware Update Options

Item

Description

Firmware Version

Click to select the desired firmware version.

Language

Click to select the interface language of the system, including the
Atrust Client Setup console.

NOTE: Available languages may vary with the selected firmware version.

Reboot Immediately

Click to choose whether to restart the system immediately for firmware update
or manually restart the system later.

6. Click Update firmware to confirm your selections. The system will start updating its firmware after restart.
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3.2.8 Enabling or Disabling the Appliance Mode

The Appliance mode allows your mt188L to start up directly with the desired Microsoft Remote Desktop, Citrix
ICA, VMware (Horizon) View, Web, or 2X session. Under this mode, users will feel as if they were using a standalone
desktop computer; the underlying client operating system, Atrust Linux, is hidden from the very beginning.

—=)) NOTE
)
« There are three similar but different modes for your mt188L and only one mode
will take effect if all are enabled. Three modes and the order of priority are listed

as follows:
No. Mode Description
The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.
Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.

Available actions include: (n/a to Web browser)

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection screen

3 Quick Connection after system startup.

- For more information on these modes, please refer to sections:

< 3.2.10 on page 56 and 2.1 on page 13 (Quick Connection mode)
3.2.8 on page 52 (Appliance mode)

3.6.5 on page 137 (Autostart mode for RDP sessions)

3.6.11 on page 176 (Autostart mode for ICA sessions)

3.6.14 on page 209 (Autostart mode for View sessions)

IR

(
3.6.19 on page 220 (Autostart mode for Web sessions)
3.6.22 on page 228 (Autostart mode for 2X sessions)
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Enabling the Appliance Mode
To enable the Appliance mode, please do the following:

1.

NOTE

Wi

- Ensure that you have configured the connection settings for the desired Microsoft
Remote Desktop, Citrix ICA, VMware (Horizon) View, Web, or 2X session under
Applications tab. You need to specify which service type and connection settings
entry will be used under the Appliance mode. For detailed instructions, please see
sections:

< “3.6.3 Configuring Basic RDP Connection Settings” on page 122

“3.6.6 Configuring Basic ICA Connection Settings” on page 153

“3.6.12 Configuring Basic VMware View Connection Settings” on page 205
“3.6.17 Configuring Basic Settings for Browser Sessions” on page 217
“3.6.20 Configuring Basic RAS / RDP Connection Settings” on page 221

R

NOTE

- Please note that the Autostart mode also enables the client to start up directly with
an RDP /ICA /View session and provides more configuration flexibility than the
Appliance mode. For detailed information on the Autostart mode, please refer to
the following sections:

(]

< “3.6.5 Configuring Advanced RDP Connection Settings” on page 137
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176
“3.6.14 Configuring Advanced View Connection Settings” on page 209
“3.6.19 Configuring Advanced Settings for Browser Sessions” on page 220
“3.6.22 Configuring Advanced RAS / RDP Connection Settings” on page 228

R

On Atrust Client Setup, click System > Appliance Mode.

Atrust Client Setup

Atl'l.l St Applications User Interface Derices Network System.
Time Zone
Password + Basic Settings
Firmware Update Enable Appliance Mode

- Appliance Mode = PP

Auto Setup
Quick Connection e [ —
Power Managemeant | save ] | cancel |
Terminal

Error Report
Certificate Manager
Advanced

System Information
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2. Click to check Enable Appliance Mode.

3. Other settings of the Appliance mode appear. Click drop-down menus to select the application (or service)

type: Citrix ICA, Remote Desktop, VMware View, Web Browser, or Parallels 2X Client, the specific service
available in that type, and the desired action after exiting a session.

~ Basic Settings

. ¥ Enable Appliance Mode
Application Type:

[Citrix 1CA - o
Use Session: |XD LI e
On Application Exit: [shutdown -l o

* To launch Console: Shift+Ctri+Delete

* To minimize ICA Fullscreen Desktop: Press Left Ctri+F2 then Alf+F9

~ Basic Settings

. ¥ Enable Appliance Mode
Application Type:

[Remote Desktop |
Use Session: |WMS LI E
On Application Exit: [shutdown -l o

* To launch Console: Shift+ Ctri+Delete

* To toggle RDP fullscreen: Ctri+Alf+Enter

~ Basic Settings

. ¥ Enable Appliance Mode
Application Type:

|\.-"I\-r1ware View

Use Session:

[vHV e
0on Application Exit: | Shutdown =
* To launch Console: Shift+Ctri+Delete

* To release keyboard and mouse from the virtual desktop, press Cirl+Alt

~ Basic Settings

. ¥ Enable Appliance Mode
Application Type:

[web Browser

Use Session:

[ Grnail | =
On Application Exit: [shutdown -l o

* To launch Console: Shift+Ctri+Delete

* To restart system : Shift+ Ctri+End

~ Basic Settings

.. ¥ Enable Appliance Mode
Application Type:

[Parallels 2X Client | e
Use Session: [P2xRAS-G &
On Application Exit: [shutdown | =

* To launch Console: Shift+ Ctri+Delete

* To restart system : Shift+ Ctri+End
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NOTE

(alll |

+ No matter which Resolution option you choose for the selected RDP /ICA / View
service, RDP /ICA / View sessions under the Appliance mode will always use the
Full Screen mode to display the remote/virtual desktop.

4. Click Save to confirm your selections.

5. The system will enter the Appliance mode after restart.

NOTE

(Wlil]

- To disable the Appliance mode or to access Atrust Client Setup under the Appliance
mode, please refer to “Disabling the Appliance Mode” on page 55.

Disabling the Appliance Mode
To disable the Appliance mode, please do the following:

1. Under the Appliance mode, exit the Full Screen mode of the RDP / ICA / 2X session, minimize the Web

browser window, or release the keyboard and mouse from the View session (virtual desktop):
« To exit the Full Screen mode of the RDP session, press Ctrl + Alt + Enter, and then minimize
the session window.
- To exit the Full Screen mode of the ICA session, press Ctrl + F2, and then Alt + F9.
« To exit the Full Screen mode of the 2X session, log out from the remote desktop.

To release the keyboard and mouse from the View session (virtual desktop), press Ctrl + Alt.

%J NOTE

« Please note that the View session (virtual desktop) will remain on the background
after you release the keyboard and mouse from the View session (virtual desktop).

2. Click Ctrl + Shift + Del to launch Atrust Client Setup.

NOTE

(alll |

+ You cannot access the Taskbar of the client operating system (Atrust Linux) under
the Appliance mode.

3. On Atrust Client Setup, click System > Appliance Mode.

4. Click to uncheck Enable Appliance Mode, and then click Save to apply the change.
5. Return to the current RDP / ICA / View / Web / 2X session:

- Toreturn to the current RDP / ICA / Web / 2X session, use Alt + Tab (press and hold Alt, and then press
Tab to switch between different items) to select and restore the current session.
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« To return to the current View session, click any place of the View session (virtual desktop) on the
background.

6. End or log off from the current RDP / ICA / View / Web / 2X session.

7. The client might shut down then. Restart your client manually.

3.2.9 Enabling or Disabling Auto Setup

Auto Setup allows your thin client to get its preset configurations on startup and enter the desired user environment
automatically. Its operation requires Auto Setup environment and network connectivity, except for Auto Setup on
the client side. For details, please refer to “A.4 Auto Setup Flowchart” on page 251 and User’s Guide for Auto Setup.

=)) NOTE

al

- To disable Auto Setup after your thin client got its preset configurations, reset
your client. Please refer to “A.1 Resetting Your mt188L to the Factory Default” on
page 241.

3.2.10 Configuring the Quick Connection Mode

The Quick Connection mode enables you to enter the Atrust Quick Connection screen after system startup.
This setting is disabled by default for mobile thin clients.

NOTE

Ll

» For detailed instructions on how to use your mt188L under the Quick Connection
mode, please refer to section“2.1 Learning the Basics” on page 13.

«+ There are three similar but different modes for your mt188L and only one mode
will take effect if all are enabled. Three modes and the order of priority are listed
as follows:

No. Mode Description

The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired RDP
/ ICA / View / Web / 2X session and perform the
configured action after exiting the session.

Available actions include: (n/a to Web browser)

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection screen

3 Quick Connection after system startup.
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« To use the Quick Connection mode, ensure that both the Appliance and Autostart
modes are disabled. If either of two modes are enabled, the Quick Connection
mode will fail to work.

- For more information on the Appliance mode, please refer to section “3.2.8 Enabling
or Disabling the Appliance Mode” on page 52.

« For more information on the Autostart mode, please refer to the following sections:

<>

R

“3.6.5 Configuring Advanced RDP Connection Settings” on page 137

“3.6.11 Configuring Advanced ICA Connection Settings” on page 176

“3.6.14 Configuring Advanced View Connection Settings” on page 209

“3.6.19 Configuring Advanced Settings for Browser Sessions” on page 220
“3.6.22 Configuring Advanced RAS / RDP Connection Settings” on page 228

To enable/disable the Quick Connection mode, please do the following:

1. On Atrust Client Setup, click System > Quick Connection.

Atrust

Navigator

Time Zone
- Password

- Terminal
Error Report

- Advanced

-~ Firmware Update
- Appliance Mode

Auto Setup
Quick Conneaction

- Power Management

- Certificate Manager

- System Information

Atrust Client Setup

Applications User Interface Devices Network Syseem
General
Basic Settings
e Enable Quick Connection after Power-up
Save l | Cancel

2. Click to check/uncheck Enable Quick Connection after Power-up to enable/disable the Quick Connection
mode, and then click Save to apply the changes.

i)

NOTE

- For advanced Quick Connection settings, please refer to the next section (3.2.11).
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3.2.11 Configuring Advanced Quick Connection Settings

You are allowed to configure advanced Quick Connection settings for Remote Desktop, Citrix ICA, and
VMware View sessions through System > Quick Connections on Atrust Client Setup.

Advanced Quick Connection Settings for Remote Desktop Sessions
To configure advanced Quick Connection settings for Remote Desktop sessions, please refer to the table below:

- Remote Desktop Option
. ¥ Multimedia Redirection

Remote Desktop Option

Item Description

Check/Uncheck to enable/disable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

Multimedia Redirection

It's enabled by default (when Quick Connection mode is enabled).

Advanced Quick Connection Settings for Citrix ICA Sessions
To configure advanced Quick Connection settings for Citrix ICA sessions, please refer to the tables below:

« Citrix ICA Option
.. [¥| Client Rendering

. ¥/ HDX RealTime WebCam

=4 Use H264 Compression

Citrix ICA Option

Item Description

Check/Uncheck to enable/disable client rendering.
Client Rendering
When Client Rendering is disabled, Server Rendering is used.

This item is available only when Client Rendering is selected.
HDX RealTime WebCam
When Yes is selected, a locally attached webcam can be used in an ICA session.

Check to enable H.264 compression support on the client, allowing session data

Use H264 Compression are sent from the server side using H.264 format encoding.
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ke Redirect Connected USB Devices

* All connected USB devices will be redirected unless more specific settings are
specified below,

* Enabling USB Redirection an the server side is also required for this feature.

Citrix ICA Option

Item

Description

Redirect Connected

USB Devices

Check to enable redirection for connected USB devices in Quick Connection
mode. All connected USB devices will be redirected unless more specific settings
are specified below.

UUse of USB Storage Devices: |Mapping ;l =

Use of USB Printers: [Mapping ~1 [

Citrix ICA Option

Item

Description

Use of USB Storage Devices

Click to select how to use USB storage devices in ICA sessions. Three options are
available: Mapping, Redirection, and Disabled.

Use of USB Printers Click to select how to use USB printers in ICA sessions. Three options are

available: Mapping, Redirection, and Disabled.

Plugged USE Devices: o
(Wendor; 2047 Product: 03df) Texas Instruments

Mendor: Obda Product: 0128) Realtek Semiconductor Corp. RTS5128 Card Reader Con

Redirection Rules: 9

*

* ¥

Use redirection rules to manage specific USB devices.

Maximum number of rules: 10

Aow =] vendorio: [ productos [ ] Akt &

Citrix ICA Optio

Item

Description

Redirection Rules

Create redirection rules on 9 to manage specific USB devices with information on a

%J‘

NOTE

« All attached USB devices will be listed under Plugged USB Devices (0) with vender
and product information needed for creating rules.
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Advanced Quick Connection Settings for VMware View Sessions
To configure advanced Quick Connection settings for VMware View sessions, please do the following:

1. On Atrust Client Setup, click System > Quick Connection.

Atrust Client Setup

Atl'l.l St Applications User Interface Derices Network System.
Time Zone ¢ CALIG ApPPILELIUTT BULLUNTS 7=l
- Password L | | Web Browser
- Firmware Update . . . .
- Appliance Mode * This setting will take effect after you re-enter the Quick Connection mode,
Auto Setup -
Quick Connection « WMware View Option
- Power Management Mass Storage: [Enabled -l —
Terminal
- Error Report Smart Card: [Disabled &
- Certificate Manager o
- Advanced K Human Interface Device: |D|sab|ed j e
System Information Brinter: |Enab\ed LI -

Plugged USB Devices: -
(vendor: 2047 Product: 03df) Texas Instruments Keyboard and Touchpad
(vendor: 046d Product: ¢52e) Logitech, Inc. 9
(Wendor: 5986 Product: 0547} BisonCam, NB Pro

Redirection Rules:
¥ Use redirection rules to manage specific USB devices.
* Maximum number of rules: 10 9

Wow =] vendorios [ eroducsios [ ] Add

| Save H Cancel l

2. Click drop-down menus to configure Generic Settings (0) for mass storage devices, smart cards, and human
interface devices. Two options are available: Enabled or Disabled.

Mass Storage: [Enabled -] "
Smart Card: [ Disabled -] ke
Human Interface Device: [ Disabled ~] e
Printer: [Enabled -] b

3. Use Redirection Rules (@) to manage specific USB devices:

Plugged LISB Devices: 9
(Wendor: 046d Product: ¢52e) Logitech, Inc.

Redirection Rules: e
¥ Use redirection rules to manage specific USE devices.

* Maximum number of rufes: 10

vendor ID: | | Product ID: | Add

« Referto (@) to fill in the Vender and Product IDs for a specific device, click the drop-down menu to select
Allow or Deny.

« Click Add on the right to add a rule on (e).
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%J‘ NOTE

+ All attached USB devices will be listed under Plugged USB Devices (9) with vender
and product information needed for creating rules.

« Redirection Rules (9) have priority over Generic Settings (0).

4. Click Save to apply.

Accessing the Internet Locally in Quick Connection Mode

To access the Internet locally in Quick Connection mode, you can configure to show the Web Browser button on
Atrust Quick Connection screen:

~ Extra Application Buttons
._-_ Web Browser

* This setting will take effect after you re-enter the Quick Connection mode.

Atrust Quick Connection Screen

Atrust Quick Connection

5 =% Remote Desktop
" Citrix
] @ VMware View

| ) Web Browser

" ) Web Browser
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1. On Atrust Client Setup, click System > Power Management.

3.2.12 Managing the Use of Power

To manage the use of power for your mobile thin client, please do the following:

& Atrust Client Setup o alliCS
Atrust Applications  User Interface Derices Network System.
Navigator General
- Time Zone
- Password - Power button action
- Firmware Update Setting: Suspend -
-~ Appliance Mode ‘ g | P J =
-~ Auto Setup h
Quick Connection - Power Management
AC power saving mode: Low 1e
- Terminal
G, Dimmed Lo &
Certificate Manager .
- Centficate Manager ||| 1um off L &
- System Information Enter suspend or Shutdown: E
Suspend or Shutdown after (Never = Disable) e
Battery power saving mode: =
Dimmed LCD: 5 minutes later e
Turn off LCD: 10 minutes later e
Enter Suspend or Shutdown: =
Suspend or Shutdown after (Never = Disable) 1 hour later e
Save ] | Cancel

2. Choose the desired power-saving mode for your AC power and battery, or choose Custom to customize
individual settings, and then click Save to apply.

? NOTE

« When your mt188L enters System Sleep mode manually (Fn + F12 or @ >
Suspend) or automatically (configured in Atrust Client Setup through System >
Power Management), it still requires a certain amount of power. You can use
Shut down option instead to save the power to a greater degree.

@ WARNING

« When using only the battery as the power source, ensure that it has enough power
to prevent data loss.



1. On Atrust Client Setup, click System > Power Management.

3.2.13 Managing the Action of Power Button
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To manage the action of Power button for your mobile thin client, please do the following:

. lalEEE
® Atrust Client Setup o [alliCS
Atrust Applications  User Interface Derices Network System.
Navigator General
- Time Zone
- Password - Power button action
~ Firmware Update Setting: Suspend -
-~ Appliance Mode ‘ g | P _I =
-~ Auto Setup h
Quick Connection - Power Management
AC power saving mode: &
- Terminal
G, Dimmed Lo &
Certificate Manager .
- Centficate Manager ||| 1y off L &
- System Information Enter suspend or Shutdown: E
Suspend or Shutdown after (Never = Disable) e
Battery power saving mode: =
Dimmed LCD: 5 minutes later e
Turn off LCD: 10 minutes later e
Enter Suspend or Shutdown: =
Suspend or Shutdown after (Never = Disable) 1 hour later e
Save ] | Cancel

2. Choose the desired Power button action: Suspend, Power Off, or Do Nothing, and then click Save to apply.

N

NOTE

« The default setting is Suspend.

63



64

Configuring Client Settings
Configuring System Settings

3.2.14 Enabling or Disabling the Command-line Functions

To enable/disable the execution of the text-based (command-line) functions, please do the following:

1. On Atrust Client Setup, click System > Terminal.

® Atrust Client Setup il oL Gl
Atrust Applications  User Interface Derices Network System.
- Time Zone
- Password - Basic Settings

- Firmware Update
-~ Appliance Mode -
- Auto Setup .. ¥ Enable Terminal Hotkey

Quick Connection

- Power Manaiement -
| Save ] E Cancel i

- Error Report - .
Certificate Manager

- Advanced

- System Information

Enable

2. Click to configure your settings:

. To allow the execution of command-line functions via a shortcut on Start menu, check Enable.
+ To allow the execution of command-line functions via a hotkey, check Enable Terminal Hotkey.

+ To completely disable Terminal, uncheck both.

NOTE

- To open Terminal via the shortcut, click START > Settings > Terminal on the
local Linux desktop.

=

. Atrust Client Setup
W System Information

'@ Terminal

+ To open Terminal via the hotkey, press Ctrl + Alt + T.

3. Click Save to apply your change.



3.2.15 Collecting Event Logs and Capturing Related Screens
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The Error Report feature allows you to collect event logs and capture related screens for error reporting.

Collecting Event Logs

To collect event logs of your mt188L, please do the following:

1. Plug a USB flash drive into your mt188L.

=) NOTE
Z

« This USB flash drive will be used for storing the event logs of your mt188L.

- Ensure that you have enabled the access and automount of USB storage devices.
For detailed instructions, please refer to section “3.4.3 Configuring Settings for USB
Storage Devices” on page 89.

% NOTE

- Please note that files saved on the local desktop will be deleted after restart.

2. On Atrust Client Setup, click System > Error Report.

BTt et et —— e | =N
® Atrust Client Setup 0| R R R
Atﬂ.l St Applications User Interface Derices Nemork System.
Navigator General
-~ Time Zone
- Password ¢ Collect Log

-~ Firmware Update
- Appliance Mode
Auto Setup
~Quick Connection
- Power Management
- Terminal
Error Report

Collect event logs to USB storage for troubleshooting.

Please send the Error Report file to your administrator,

Collect Log

- Certificate Manager
- Advanced
- System Information

~ Launch Screenshot

Execute a screenshot tool to capture your screen.

Launch Screenshot

- Upload Files

FTP Server Address: o | e
FTF Username: | ‘ =
FTP Password: [ | e

Upload Check

Save H Cancel |
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3. Click Collect Log. A window appears prompting you to choose where to save the log file set (named
events.tar.gz). The attached USB flash drive is the default location if attached. Click Save to apply.

Save Archive file to

e 2 mEE

Look in: [ImedlafBOOT
g Co... efi
user firmware

BOOT install. 386

File name: events.t-ar.

|

Files of type: [Archive Files (*.tar.gz)

£

Capturing Error-Related Screens

To capture error-related screens of your mt188L, please do the following:

1. On Atrust Client Setup, click System > Error Report.

2. Click Launch Snapshot to open the screen capturing program.

&

Screenshot
Take a screenshot

Screenshot

X

Region to capture

1 Entire screen

) Select & region

[1 Capture the mouse pointer

Delay before capturing

seconds

3. Configure screen capturing settings directly on the opened window if needed, and then click OK to capture

the desired screen.

TIP

@

« It's recommended to set the delay time before capturing to at least 2 seconds to
reserve time for switching to the desired screen or window.

« It's recommended to save the captured screens in the same USB flash drive where

the event logs were saved.

« Please note that files saved on the local desktop will be deleted after restart.



3.2.16 Uploading Files for Error Reporting

You can upload files to a specified FTP server for error reporting.
To upload files to an FTP server, please do the following:

1. On Atrust Client Setup, click System > Error Report.
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®) Atrust Client Setup e =Ll
Atl'l.l St Applications User Interface Derices Network System.
Navigator General
- Time Zone
.- Password ¢ Collect Log
- Firmware Update Collect event logs to USB storage for troubleshooting.
- Appliance Mode
-~ Auto Setup Please send the Error Report file to your administrator.
- Quick Connection
- Power Management
- Terminal
Error Report Collect Log
-~ Certificate Manager -
- Advanced ¢ Launch Screenshot
- System Information Execute a screenshot tool to capture your screen,
Launch Screenshot
- Upload Files
FTP Server Address: * | ‘ e
FTP Username: [ =
FTP Password: [ | e
Upload Check
Save ] | Cancel

2. Under the Upload Files section, type the IP address of the FTP server and credentials, click Upload to select

and upload files to that FTP server.

Lock in: [Ihome}user

e w2 mEE

user

Desktop
Documents
Music
Pictures
Public

Templates
Videos

File name: [

)| Bopen

Files of type: [Archlve Files (*.tar.gz)

5 e

<‘/ TIP

+ You can check the validity of the IP address and credentials first through the

Check button.
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3.2.17 Importing Certificates for Remote Computers

You can import certificates for remote computers through:

« Alocal device (from a USB storage device)

«  The network (from a remote computer or the management console)

NOTE

+ The available management console for mt188L is Atrust Device Manager, a remote
and group management console for multiple thin clients. For more information,
please refer to the User’s Manual for Atrust Device Manager.

Nl

Importing certificates through a USB storage device
To import certificates for remote computers through a USB storage device, please do the following:

1. Copy your certificates to a USB storage device, and then connect this storage device to your mt188L.
2. On Atrust Client Setup, click System > Certificate Manager.
3. Click Add on the top of the Certificate list.

® Atrust Client Setup oy Lol

Atﬂ.l St Applications User Interface Derices Network System.
ST o
- Time Zone Issuedto % Issued by Expired on walid Imported from
- Password

-~ Firmware Update

- Appliance Mode
Auto Setup

~Quick Connection

- Power Management

- Terminal

Error Report
- Advanced
- System Information
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4. In the From File section, click Browse to locate the desired certificate file, and then click Open to confirm.

Atrust Client Setup X
Atru St Applications User Interface Devices Network System
Navig: General
-~ Time Zone
~ Password ¢ From File
~ Firmware Update Specify the file you want to import (up to 16 certificates in total, including those from
- Appliance Mode servers).
Auto Setup
- Quick Connection File Mame: | Browse... Import
- Power Management
Terminal Note: Please select PEM or DER format certificate from your USB storage device,
Error Report
Certificate Manager -
- Advanced - From Server
- System Information
Enter the IP address / URL/ FQDN of the server where you want to get the certificate(s),
and then click Import (up to 16 certificates in total, including those from files).
IP address / URL/ FQDN: | | mpert
¢ From Atrust Device Manager
Click Import to get the certificate(s) from the Atrust Device Manager.
Import
Cancel
5. Click Import to start importing the certificate.
6. On completion, the certificate is shown in the Certificate list.
Atrust Client Setup Ll
Applications User Interface Devices Nework System
|+ add || = Delete |
-~ Time Zone w
 password Issued to Issued by Expired on

- Firmware Update Starfield Root Certificate Authority - G2 Microsoft Code Verification Root 2021-04-15

-~ Appliance Mode

- Auto Setup

~ Quick Connection

- Power Management
- Terminal

- Error Report

- Advanced

- System Information
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Importing certificates from remote computers through the network
To import the certificate from a remote computer through the network, please do the following:

1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.

3.

®

Atrust

Navigator

-~ Time Zone
-~ Password
- Firmware Update
-~ Appliance Mode
- Auto Setup
~ Quick Connection
ower Management
erminal

- Error Report

- Advanced

- System Infermation

In the From Server section, type the IP address / URL / FQDN of the remote computer, and then click Import.

Atrust Client Setup o+ EH|EX
Applications User Interface Devices Nework System
General
- From File
Specify the file you want to import {up to 16 certificates in total, including those from
servers).
File Name: I | Browse... Import

Note: Please select PEM or DER format certificate from your USE storage device,

- From Server

and then click Import (up to 16 certificates in tetal, including those from files).

Enter the IP address / URL / FQDN of the server where you want to get the certificate(s),

IP address / URL / FQDN: |wwwgoog\e.com | Import
» From Atrust Device Manager
Click Import to get the certificate(s) from the Atrust Device Manager.
Import
Cancel
4. On completion, the certificate is shown in the Certificate list.
®) Atrust Client Setup o Lol
Atru St Applications User Interface Devices Nework System
Navigator | + Add l | = Delete l
>.--.---ina2§v;zoige ssued to ¥ lssued by Expired on Valid Impo
- Firmware Update eoTrust Global CA Equifax Secure Certificate Authority 2018-08-21 Walid Serve
-~ Appliance Mode
- Auto Setup
~Quick Connection
Power Management
~Terminal
- Error Report

- Advanced
- System Infermation
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Importing certificates from Atrust Device Manager through the network
To import certificates from Atrust Device Manager through the network, please do the following:

=)) NOTE
=

- Before proceeding, ensure that (1) your thin client has been added into a managed
group in the management console, that is, Atrust Device Manager, and that (2) you
have imported certificates into the management console.

1. On Atrust Client Setup, click System > Certificate Manager.
2. Click Add on the top of the Certificate list.

3. Inthe From Atrust Device Manager section, click Import to start importing all certificates available in
Atrust Device Manager.

4. On completion, the certificates are shown in the Certificate list.

& Atrust Client Setup o alliCS
Atru St Applications User Interface Devices Network System
e JTEREETS
-~ Time Zone " :
- Password Issued to Issued by Expire

Go Daddy Secure Certificate Authority - G2 Go Daddy Root Certificate Authority - G2 2031-
Starfield Root Certificate Autherity - G2 Microsoft Code Verification Root 2021-
Starfield Secure Certificate Authority - G2 Starfield Root Certificate Authority - G2 2031-

Firmware Update
- Appliance Mode
- Auto Setup
~ Quick Connection
- Power Management
- Terminal
- Error Report
-~ Advanced
- System Information

71



72| Configuring Client Settings
Configuring System Settings

3.2.18 Enabling or Disabling Auto Registration

Auto Registration allows that thin clients automatically register with Atrust Device Manager when they are online
and then become managed by Atrust Device Manager.

NOTE

- For this feature to work, Auto Registration must be enabled on both sides: thin
clients and target Atrust Device Manager. In addition, some configurations on
DHCP or DNS server over your network are required. For details, please refer to the
User’s Manual for Atrust Device Manager.

=

- By default, Auto Registration is enabled on thin client side, disabled Atrust
Device Manger.

To enable or disable Auto Registration on your thin client, please do the following:

1. On Atrust Client Setup, click System > Advanced.
2. Check/ Uncheck to Enable Auto Registration to enable / disable Auto Registration.

- BEEEE
® Atrust Client Setup oy Lol

Atru St Applications User Interface Devices Network System
Time Zone

- Password - Auto Registration )
-~ Firmware Update
- Appliance Mode

.. ¥ Enable Auto Registration

-~ Auto Setup
- Quick Connection S 1 —
- Power Management | Save ] | Cancel |
- Terminal

- Error Report
- Certificate Manager

- System Information

3. Click Save to apply.
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3.2.19 Viewing System and Network Information

You can view detailed system and network information through Atrust Client Setup.
To view detailed system and network information through Atrust Client Setup, please do the following:

1. On Atrust Client Setup, click System > System Information.

2. Click System / Network tab to view system / network information.

Atrust Client Setup

Atl'l.l St Applications User Interface Derices Network System.
-~ Time Zone
- Password - System
~ Firmware Update Product Mame : mt188L
-~ Appliance Mode
- Auto Setup
- Quick Connecticn Host Name : atrust-047FCO
Power Management
~Terminal BIOS Information : 1.08
- Error Report
- Certificate Manager MCU ersion : vi7
Advanced
System Infarmation .
Firmware \ersion : Atrust Linux v5.25-PREE
CPU: Intel(R) Celeron(R) CPU N2807 1580MHz
RAM : 2048 MB
Flash : 4 GB
Serial Number : 000000000000
Back

Atrust Client Setup

Atru St Applications User Interface Devices Network System
- Time Zone
.- Password ¢ Ethernet
Firmware Update IP Address : 182.168.9.21
- Appliance Mode . S
- Auto Setup MAC Address : 00:1f:d8:04:7f.cO
- Quick Connection subnet Mask : 255,255,255.0
- Power Management
Terminal Gateway : 192.168.9.10
~ Error Report 192.168.9.4
-~ Certificate Manager DNS : 192.168.9.5
- Advanced 192.168.9.7
System Information Speed: 100Mbps
- Wireless
IP Address : 0.0.0.0
MAC Address : 3¢:95:09:73:03:37
Subnet Mask : 0.0.0.0
Gateway : 0.0,0.0
DMNS 0.0.0.0
Back
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3.3 Configuring User Interface Settings

3.3.1 User Interface Tab Overview

User Interface tab enables you to configure settings for the user interface of clients. To access available settings of

User Interface tab, click the tab on Atrust Client Setup.

User Interface Tab Overview

&) Atrust Client Setup

0............§.Display Display
= ;- isp
& Configure display settings

Atl'l.lSt Applications User Interface Derices

Network System

scee

“- Screensaver " Deskiop

— Configure desktop settings

) Keyboard

== Configure keyboard settings

Mouse
Configure mouse settings

- Screensaver

=l
=W Configure screensaver settings

Interface Elements

No. Name Description

1 Navigation area Click to select a setting item under User Interface tab.

2 Configuration area

Configures setting values when a setting item or entry is selected.
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3.3.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
Display ﬁ_. Click to configure display settings. 3.3.3 75
- 3.3.4 78
Desktop [ Click to customize desktop and system language. 3.3.5 81
— 3.3.6 82
User Interface Keyboard ;:.;. Click to adjust keyboard settings. 3.3.7 83
Mouse - Click to adjust mouse settings. 3.3.8 85
Screensaver 'EE: Click to configure screensaver settings. 3.3.9 86

3.3.3 Configuring Display Settings

To configure display settings for your mt188L, please do the following:

1. On Atrust Client Setup, click User Interface > Display.

- llalEEE
® Atrust Client Setup e ol

Atrust Applications  User Interface Devices Network System
Navigator General
Displa
- Desktop ¢ Display
- Keyboard Mumber of Display: | 1 Ll [
-~ Mouse
- Screensaver Display Layout: [use Lco =l
¢ Monitor Settings
‘ Resolution: [Auto (1920%1080) -l e ‘
| Save H Cancel

2. Click drop-down menus to select the number of attached display(s), arrangement of displays, resolution, etc.
Refer to the following table to select appropriate setting values.
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(i)

« The available setting items vary, depending on your model and the selected
number of display(s).

Display

Item

Description

Number of Display

Click to select the number of used display(s).

Option Description
1 One display is used.
2 Two displays are used.

Display Layout

Click to select the arrangement of displays.

Option Description
Use External Use the single external display attached.
Use LCD Use the single internal display (LCD panel).

Use dual displays.

Two displays are arranged horizontally:

the external one is on the left; the LCD the right.
The external one is the main display for local desktop
when Extend is selected.

External - LCD
horizontal

Use dual displays.

Two displays are arranged horizontally:

the LCD one is on the left; the external the right.

The LCD one is the main display for local desktop when
Extend is selected.

LCD - External
horizontal

Use dual displays.

Two displays are arranged vertically:

the external one is on the top; the LCD the bottom.
The external one is the main display for local desktop
when Extend is selected.

External - LCD
vertical

Use dual displays.

Two displays are arranged vertically:

the LCD one is on the top; the external the bottom.
The LCD one is the main display for local desktop when
Extend is selected.

LCD - External
vertical

Display Mode

This item is available only when 2 is selected in the Number of Display drop-
down menu:

Option Description

Extend One display is used as the extended display of the other.

Clone Two displays have the same display content.
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Monitor Settings

Item

Description

Enable Auto-Detection at
Power-up

Check/Uncheck to enable/disable the automatic detection of the used monitor(s)
when the client is powered on.

Option Description

Automatic detection of the used monitor(s) is enabled.
Enabled The system would set an appropriate resolution for the
used monitor(s) when the client is powered on.

Automatic detection of the used monitor(s) is disabled.
All resolutions supported by the client will be listed in the

Disabled Resolution drop-down menu when Auto-Detection at
Power-up is disabled. Please note that some resolutions
may not be applicable to your monitor(s).

Monitor Resolution

Use this item to set an appropriate resolution for the used display.

Option Description
A This option is available only when Enable Auto-Detection
uto -
at Power-up is selected.
Other Select the desired resolution from the Resolution drop-down
options menu for the used display.

NOTE: All resolutions supported by the client will be listed in the Resolution
drop-down menu when Auto-Detection at Power-up is disabled.
Please note that some resolutions may not be applicable to
your monitor(s).
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3.3.4 Customizing Desktop and System Language Settings

To customize desktop and system language settings for your mt188L, please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

®) Atrust Client Setup o alliCS
Atrust Applications  User Interface Devices Network System
Navigator General
- Displa .
Desktop ¢ System Language L —
- Keyboard Language: [English -1&
-~ Mouse . .
- Screensaver This setting will take effect after reboot,
- Desktop Fonts
Default Font: [sans N
Default Font Style: |Regu\ar hd Il
Default Font Size: [12 hd 'S
Title Font: [sans N
Title Font Style: |Regu\ar hd Il
Title Font Size: [1z N
- Desktop lcons
e Remote Desktop
e Citrix
L | VMware View
e Parallels 2X Client
e Firefox Web Browser
d
[T,
Save ] | Cancel

2. Click drop-down menus or tick/untick checkboxes to choose desired settings. Refer to the following table for
a description of each setting item.

System Language

Item Description

Click the drop-down menu to select the system language.

Language NOTE: Available languages may vary with the firmware version of your device.
NOTE: You need to restart the system for the change to take effect.

Desktop Fonts

Item Description

Default Font Click the drop-down menus to select the desired font, its style and size used for
the user interface of the operating system, such as menus, options on menus,

Default Font Style text labels for desktop shortcuts, tabs on program windows etc.

NOTE: Your changes will not apply to the titles of opened windows, the Atrust
Client Setup console, and the System Information window (START >

Default Font Size System Settings > System Information).
Title Font
Title Font Style Click the drop-down menus to select the desired font, its style and size used for

the titles of the opened windows.

Title Font Size
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Desktop Icons

Item

Description

Remote Desktop

-

Check/Uncheck to show/hide shortcuts Remote Desktop [ on the START

menu and local Linux desktop for service quick access.

For more information, please refer to section “3.3.5 Hiding or Showing Quick
Access Shortcuts” on page 81.

Citrix

Check/Uncheck to show/hide shortcuts Citrix on the START menu and local

Linux desktop for service quick access.

For more information, please refer to section “3.3.5 Hiding or Showing Quick
Access Shortcuts” on page 81.

VMware View

Check/Uncheck to show/hide desktop shortcuts VMware View on the
START menu and local Linux desktop for service quick access.

For more information, please refer to section “3.3.5 Hiding or Showing Quick
Access Shortcuts” on page 81.

Parallels 2X Client

Check/Uncheck to show/hide desktop shortcuts Parallels 2X Client B on the
START menu and local Linux desktop for service quick access.

For more information, please refer to section “3.3.5 Hiding or Showing Quick
Access Shortcuts” on page 81.

Firefox Web Browser

Check/Uncheck to show/hide desktop shortcuts Firefox Web Browser e: on
the START menu and local Linux desktop for quick access.

Also see “Topic 5: Using Built-in Applications” on page 33.

LibreOffice

Check/Uncheck to show/hide desktop shortcuts LibreOffice D on the START
menu and local Linux desktop for quick access.

Also see “Topic 5: Using Built-in Applications” on page 33.

PDF Viewer (Document Viewer)

Check/Uncheck to show/hide desktop shortcuts Document Viewer _Q"'
START menu and local Linux desktop for quick access.

on the

Also see “Topic 5: Using Built-in Applications” on page 33.

Icon Size

Click the drop-down menu to select the desired size of desktop icons/shortcuts.

Icon Font Size

Click the drop-down menu to select the desired text label size of desktop
icons/shortcuts.

Desktop Background

Item

Description

Enable Desktop Wallpaper

Check/Uncheck to enable/disable the use of Atrust wallpaper.

NOTE: If disabled, the solid color background (dark blue) will be used.

Enable Custom Wallpaper

Download From

Custom Wallpaper File

Check/Uncheck to enable/disable the use of a custom wallpaper. More settings
appear when checked.

For details, please refer to “3.3.6 Using a Custom Wallpaper” on page 82.
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Wallpaper Style

Click the drop-down menu to select the way to apply the wallpaper. Five options
are available: Centered, Tiled, Stretched, Scaled, and Zoomed.

Option Description

Centered Centers the original image on the screen.

Tiled Tiles the screen with the original image.

Stretched Centers and extends/shrinks the image to fit the screen.
Scaled Centers and sizes the image proportionally to fit the screen

until the top-bottom or left-right sides fit the screen.

Zoomed Centers and sizes the image proportionally to fill the screen.

NOTE: Depending on the size of the connected display, two options might have
the same effect.

Wallpaper

Click the drop-down menu to select the color of Atrust wallpaper. Four colors are
available: Green, Blue, Orange, and Cyan.

3. Click Save to apply.
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3.3.5 Hiding or Showing Quick Access Shortcuts

In case you want to access services quickly right on the local desktop, you can choose to show Quick Access
shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop. These shortcuts
enable you to access services quickly by clicking.

NOTE
+ They're hidden by default.

i

To show/hide shortcuts Remote Desktop / Citrix / VMware View on the START menu and local Linux desktop,
please do the following:

1. On Atrust Client Setup, click User Interface > Desktop.

®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Dervices Nework Sysem

Navigator General
- Displa .

Desktop ¢ System Language -

- Keyboard Language: [English 1o
- Mouse
- Screensaver This setting will take effect after reboot,

- Desktop Fonts

Default Font: [sans hd Il
Default Font Style: |Regu\ar hd 'S
Default Font Size: [12 hd Il
Title Font: [sans hd Il
Title Font Style: [Regular N
Title Font Size: [12 hd Il -

- Desktop lcons
Remote Desktop

Citrix

[

=

- VMware View

e Parallels 2X Client
B

+ Firefox Web Browser

i en i =l

Save H Cancel |

2. Click to check/uncheck Remote Desktop / Citrix / VMware View in the Desktop Icons section to show/hide
the quick access shortcuts Remote Desktop / Citrix / VMware View on the START menu and
local Linux desktop.

3. Click Save to apply the change.
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4. The selected shortcuts will be shown/hidden.

| B2 Atrust Quiclk Con
=« Remote Deslktop
@ Citrix
@& VMware View
| Settings

® Log Out Atrust
.

stTART er@at. .

| us 0 « Les|19:01

3.3.6 Using a Custom Wallpaper
To use a custom wallpaper, please do the following:
1. On Atrust Client Setup, click User Interface > Desktop.

—_ T
®) Atrust Client Setup o ol
Atrust Applications

User Interface Devices Nework Sysem

General

¢ Deskiop Icons
e Remote Desktop

Citrix

-~ Mouse
- Screensaver

&

L | VMware View
| ¥ Firefox Web Browser

e Libreoffice

E PDF Viewer (Document Viewer)

lcon Size: [32 ~] l-
lcon Font Size: [10 -] l-

- Desktop Background

L. ¥/ Enable Desktop Wallpaper

.;_ Enable Custom Wallpaper

Wallpaper Style: | Stretched LI .__
wallpaper: [Blue B
| Save ] | Cancel ]

2. Check or Uncheck Enable Custom Wallpaper to enable or disable the use of a custom wallpaper.
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3. Select the way to apply the wallpaper and where to download or get the image file. Three options are
available to get the wallpaper: Auto Setup, Atrust Device Manager, and File.

NOTE

i

- If Auto Setup is selected, your thin client must be in Auto Setup environment and
be well-configured for that environment. Please see “3.2.9 Enabling or Disabling
Auto Setup” on page 56 for more information.

- If Atrust Device Manager is selected, your thin client must be managed by Atrust
Device Manager. For details, please see the User’s Manual for Atrust Device Manager.

4. Provide other information if required.

NOTE

(adlf |

- IfFile is selected, you need to specify where to get the image file locally, for
example, a locally attached USB flash drive.

+ The maximum allowed size of a custom wallpaper file is 5 MB.

5. Click Save to confirm.

3.3.7 Adjusting Keyboard Settings

To adjust keyboard settings for your mt188L, please do the following:

1. On Atrust Client Setup, click User Interface > Keyboard.

® PP EN R

Atrust Client Setup o Lol
Atl'l.l St Applications User Interface Dervices Network System
General
- Keyboard
= Use Custom Keyboard Settings
Screensaver keyboard Layout: |Japanese {is) ‘ e
Keyboard Type: |Japanese 106-key ‘ =
NumLock
NumLock Mode: [Single Numeric Key -] =
E Enable NumLock on Boot
Cursor
L. ¥ Show Blinking
Blink Delay 1300 E
Type Settings
Repeat Speed [20 | e
— ] ]
Repeat Delay \SUU | =
Save ] | Cancel

2. Click drop-down menus, tick/untick checkboxes, or move sliders to choose desired settings. Refer to the
following table for a description of each setting item.
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Keyboard

Item

Description

Use Custom Keyboard Settings

Check/Uncheck to enable/disable the use of custom keyboard settings.

NOTE: You are allowed to set the keyboard layout and type only when this
setting is enabled.

Keyboard Layout

Click the drop-down menu to select the desired keyboard layout.

Keyboard Type

Click the drop-down menu to select the desired keyboard type.

Single Numeric Key
NumLock

In NumLock mode, single numeric key is sufficient to enter a number.

Mode .
Fn + Numeric Key

In NumLock mode, Fn plus numeric key is required to enter a number.

Enable NumLock on Boot

Check/Uncheck to enable/disable the NumLock key after system startup.

Show Blinking Check/Uncheck to enable/disable the cursor blinking (local desktop only).
Cursor
Blink Delay Move the slider to select the blink delay between each occurrence of cursor.
T Repeat Speed Move the slider to select the character repeat rate when a key is held down.
ype
Settings

Repeat Delay

Move the slider to select the character repeat delay between its each occurrence.

G TIP

+ Hang your mouse over the Up/Down arrow to quickly scroll up/down the Keyboard

Layout

list.

Up arrow

Arabic

Arabic (AZERTY)

Arabic (AZERTY /[ digits)
Arabic (digits)

Arabic (QWERTY)

Arabic frusrmaTy e o
Canada (French Dvorak)
Canada (French (legacy))
Canada (Multilingual)

Canada (Multilingual first part)
Canada (Multilingual second part)

-

Down arrow —I

- To fine-tune a setting value, click its slider, and then use the Right/Left key to
increase/decrease the value by 1 or the Page Up/Page Down key to increase/
decrease by 10.

3. Click Save to apply.
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3.3.8 Adjusting Mouse Settings

To adjust mouse settings for your mt188L, please do the following:

1. On Atrust Client Setup, click User Interface > Mouse.

Afrust Client

Atrust Applications  User Interface Devices Network System

- Display

- Desktop - Mouse

- Keyboard Button Order: [Right handed -l e

- Screensaver Enable touchpad: [ves =l o
Disable touchpad when the USB mouse inserted:  [No -] =
Feedback
Acceleration [z | =
Threshold [17 | e
Save ] | Cancel ]

2. Click the drop-down menu or move sliders to choose desired setting values. Refer to the following table for a
description of each setting item.

Mouse

Item Description
Button Order Click the drop-down menu to switch mouse buttons for right-hand/left-hand use.
Enable touchpad Click the drop-down menu to enable or disable the touchpad.

Disable touchpad when the Click the drop-down menu to choose whether to disable the touchpad when a USB
USB mouse inserted mouse is attached.

Acceleration | Move the slider to select the rate at which the mouse increases speed while moving.

Feedback
Move the slider to select the moved distance (pixels) after which the mouse starts

Threshold

to accelerate.
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3.3.9 Configuring Screensaver Settings

To configure screensaver settings for your mt188L, please do the following:

1. On Atrust Client Setup, click User Interface > Screensaver.

Atrust

- Display
- Desktop - Screensaver
- Keyboard
. Mouse B Enable Screensaver
Display Mode: ]
Display After (minte): 3
B Enable Display Sleep Mode
Enter Display Sleep Mode after Screensaver (minute): [
= 0n Resume, Password Protect
- Additional Settings
when | close the lid: Turn off LCD hd 'S

Atrust Client Setup

Applications User Interface Derices Network System

Save H Cancel |

2. Click drop-down menus or tick/untick checkboxes to choose desired settings.

Screensaver

Item

Description

Enable Screensaver

Check/Uncheck to enable/disable screensaver.

Display Mode

Click to select the display mode of screensaver. Three options are available:
Blank, Logo, and Image.

Option Description

Blank Displays a black screen.

Logo Displays the Atrust floating logo.
Image Displays the specified images.

Display After (minute)

Click to select the wait time for screensaver.
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Specify the source

Click to select where to get the images and use for screensaver. Three options
are available: Default, Auto Setup, Atrust Device Manager.

Option Description
Default Uses the default image in your P2T thin client.
Auto Setup Gets and uses images from Auto Setup.

Atrust Device Manager  Gets and uses images from Atrust Device Manager.

NOTE: For details on Auto Setup, please refer to its User’s Guide.

NOTE: For details on Atrust Device Manager, please refer to its User’s Manual.

Change picture every

Click to set the interval to change the displayed image.

Enable Display Sleep Mode

Check to turn off (i.e. stop sending signals to) the display to maximize the
energy savings.

Enter Display Sleep Mode after
Screensaver (minute)

Click to select when to turn off (i.e. stop sending signals to) the display after
Screensaver starts.

On Resume, Password Protect

Check/Uncheck to resume with/without a password.

Additional Settings

Item

Description

When I close the lid

Click to select what to do when you close the lid.

TIP

@

- While setting wait time for screensaver, you can hang your mouse over the Up /
Down arrow to quickly scroll up / down the Minute list.

3. Click Save to apply.
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3.4 Configuring External Device Settings

3.4.1 DevicesTab Overview

Devices tab enables you to configure settings for external devices of clients. To access available settings of Devices
tab, click the tab on Atrust Client Setup.

Devices Tab Overview
N S Ty | — ||| ][]
® Atrust Client Setup Gillod LGS
Atl'l.lSt Applications User Interface Devices Network System
0ooooooooocoo§oUSB Storage
- Audio USB Stwrage X oooco...o@

- Printer

Configure USE storage settings

Q| At

Configure audio device settings

. Printer
==¥ Add local and network printers

Interface Elements

No. Name

Description

1 Navigation area

Click to select a setting item under Devices tab or to select a setting
entry under a selected setting item.

2 Configuration area

Configures setting values when a setting item or entry is selected.
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3.4.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
USB Storage 'LP Click to configure settings for USB storage devices. g:i gg
Devices Audio Q“' Click to configure settings for audio devices. g:g g;
Printer & Click to add local or network printers. g:; gg

3.4.3 Configuring Settings for USB Storage Devices

To configure settings for USB storage devices, please do the following:

—=)) NOTE
=
« To access locally attached USB storage devices in a local or virtual session, you need
to configure appropriate settings under this setting item.

1. On Atrust Client Setup, click Devices > USB Storage.

® Atrust Client Setup | =W | NN [
Atl'l.l St Applications User Interface Devices Network System
Navigator General
LSB Storage
- Audio r USB Storage
- Printer v Enable USB Storage

L. ¥ Enable Automount

¥ This setting will take effect after reboot.

Save H Cancel |

2. Tick/untick the checkboxes to choose the desired settings.



90| Configuring Client Settings

Configuring External Device Settings

Settings for USB Storage Devices

Item Description

Tick/Untick this checkbox to allow/disallow the access of USB storage devices.

NOTE: To use the locally attached USB storage devices in an RDP / ICA / View / 2X
session, the mapping of local USB storage devices must be enabled in this
session’s RDP / ICA / View / 2X connection settings. For detailed instructions

Enable USB Storage and more related settings, please refer to sections:

"3.6.5 Configuring Advanced RDP Connection Settings” on page 137

"3.6.11 Configuring Advanced ICA Connection Settings” on page 176

"3.6.14 Configuring Advanced View Connection Settings” on page 209

"3.6.22 Configuring Advanced RAS / RDP Connection Settings” on page 228

Tick/Untick this checkbox to enable/disable the automount of USB storage devices.

NOTE: If this setting is disabled, users need to manually mount the attached USB
Enable Automount storage devices. For detailed instructions, please refer to section “3.4.4
Manually Mount and Eject Attached USB Storage Devices” on page 90.

3. Click Save to save your change.

NOTE

- For your changes to take effect, you need to restart your system.

Wi

3.4.4 Manually Mount and Eject Attached USB Storage Devices

To mount/eject an attached USB storage device, please do the following:

NOTE

- If Enable Automount is checked (see section “3.4.3 Configuring Settings for USB
Storage Devices” on page 89), then an attached USB storage device will be
mounted automatically.

(alll |

1. Right click the desktop icon of the attached USB storage device.

2. A popup menu appears.

Mount Volume & Eject Volume

3. Click to select Mount Volume/Eject Volume to mount\eject the attached USB storage device.
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3.4.5 Disabling or Enabling Attached Audio Devices

To disable/enable attached audio devices, please do the following:

—=)) NOTE
g
- If you disable locally attached audio devices, client users are not allowed to perform
audio playback or recording with these devices in an RDP / ICA / View session.

+ To perform audio playback or recording with local audio devices in an RDP / ICA /
View session, you need to enable locally attached audio devices here
(the Audio setting item under Devices tab) and configure audio related settings
in the RDP /ICA / View connection settings. For detailed instructions, please
refer to sections:
< “3.6.5 Configuring Advanced RDP Connection Settings” on page 137
< “3.6.11 Configuring Advanced ICA Connection Settings” on page 176
< “3.6.14 Configuring Advanced View Connection Settings” on page 209

1. On Atrust Client Setup, click Devices > Audio.

o llalEEE
®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Devices Nework Sysem
Navigator General
- LUSB Storage
Audio - Audio

- Printer .. ¥ Enable System Audio Device

* This setting will take effect after reboot.

| Save H Cancel |

2. Click to check/uncheck Enable System Audio Device.

3. Click Save to confirm your selection.

NOTE

il

- The change will not take effect until mt188L has been restarted.
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3.4.6 Using Audio Devices

By default, your mobile thin client would use built-in speaker and/or audio devices attached to 3.5 mm audio ports.
In case that you want to use an audio device of other interfaces, you need to change the default.

To configure default audio devices, please do the following:
1. Connect the desired audio device to your thin client.

2. Open the Mixer window:

+ On the Quick Connection screen, click “/ icon in the bottom-right corner.

« On the local desktop, right-click Q,, icon in the bottom-right corner, and then select Sound Preferences.

Sound el
Settings ‘

Output volume: @

o'EN |

Output | Input ‘Apphcations ‘

Choose a device for sound output:

® Spealcers - Buit-in Audio

Q Spealers - USB PnP Sound Device

Settings for the selected device:
Balance: —_
Left Right

Profile: Analog Stereo Output |v | Test Speakers

3. Click the Output / Input tab, select the default device for sound output / input.
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3.4.7 Adding aLocal Printer

To add a local printer for your mt188L, please do the following:

1. Connect the desired printer to your mt188L and turn on the printer.

2. On Atrust Client Setup, click Devices > Printer.

. LR
®) Atrust Client Setup o ol
Atl'l.l St Applications User Interface Devices Nework Sysem
[+ add || = Delete |
- USE Storage Printer Name % Printer URI Description

’““AUdiU
Printer

Click Add on the top of the Printer list.
The system automatically start searching for available local printers.

Upon completion, the discovered local printers will be listed on the Printer Port drop-down menu.

o v ok W

Click the Printer Port drop-down menu to select the desired local printer.

TCP Metwaork Printer
LPD Network Printer
IPP Metwork Printer
EPSON EPL-6200L

7. Fields in the Add Printer section will automatically change to fit the type of the selected printer.
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8. Afield for the selected printer appears and the printer URI (Uniform Resource Identifier) data is automatically
filled out in the field.

- llalEEE
® Atrust Client Setup | =W | NN [
Atl'l.l St Applications User Interface Devices Network System
General
- USB Storage
- Audio ¢+ Add Printer
Printer Name * | \ [
[Prmter Fort: EPSON EPL-6200L 'I [ ]
EPSON EPL-6200L * [?serial=23P160612111836080 B
Description: | ‘ e
Manufacturer: [Generic 1&
Printer Model: | j e
e Share Printer
. ¥ Mapping in RDP Sessions
L. ¥ Mapping in ICA Sessions
L. ¥ Mapping in VMware Sessions
Windows Driver Name [ | =
RDP Printer Mapping Name [ =
Save l | Cancel

NOTE

A

« A URI (Uniform Resource Identifier) is a sequence of characters that is used to
identify a resource on the Internet.

9. Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the
attached local printer.

NOTE

Nl

« For the printer to operate normally, you need to specify the correct information in
these two fields. Otherwise, the printer would fail to work.

10. Refer to the following table to configure desired settings.

—)) NOTE
i
+ You may need to provide the Windows driver name for your printer. For details,
please refer to descriptions in the table.

11. Type the desired printer name, and then click Save to apply.
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Settings for Printers

Item

Description

Share Printer

Check/Uncheck to share the printer.

Once Share Printer is checked, other computers in the same network segment
will be allowed to use the printer.

To add this shared printer for use on other computers, please do the following:

1. For computers running a Windows Server operating system, such as
Windows Server 2008 R2, please add the Internet Printing Client
feature first (Click Start > All Programs > Administrative Tools >
Server Manager > Action > Add Features > Internet Printing Client,
follow the wizard to complete the task, and then restart your system).

2. Click Start > Devices and Printers > Add a printer >
Add a network, wireless or Bluetooth printer.

3. Click Stop to cancel the automatic printer search, and then click
The printer that I want isn’t listed.

4. Under Select a shared printer by name, enter
http://IP address of your thin client:631/printers/Printer Name.

NOTE: For example, if a printer is locally attached to your thin client and is
added as a local printer through Atrust Client Setup with the printer
name EPS, and the IP address of your thin client is 192.168.50.146.
Here you should enter: http://192.168.50.146:631/printers/EPS

5. Click Next to continue.

6. Select the manufacturer and model of the printer, and then click OK to
install the correct driver.

7. Upon completion, a success message appears. Click Next to continue.
8. On the appeared page, click Print a test page to test the printer.
9. Click Finish to apply. The printer is added to the Printers and Faxes list.

Mapping in RDP Sessions

Check/Uncheck to enable/disable the locally connected printer in an RDP session.

Mapping in ICA Sessions

Check/Uncheck to enable/disable the locally connected printer in an ICA session.

Mapping in VMware Sessions

Check/Uncheck to enable/disable the locally connected printer in a View session.

Windows Driver Name

Keep this field blank, if the printer works well in a session. In case that the
printer fails to work, filling in this field may solve the problem.

To find out the required information, please do the following:

1. Attach the printer to a computer running a Windows OS, complete the
required installation, and ensure the printer works well.

2. Click Start > Devices and Printers, and then, in the opened window,
right click the printer to open a popup menu.

3. On the popup menu, click to select Printer properties.
4. In the opened window, click Advanced. The driver name is shown.

/=1 Epson EPL-6200L Properties ===

General | Sharng | Pots | Advanced | Color Management | Securty | Optional Settngs |

@ Always available

© Available from 00:00 : 00:00

Priority: 1

)
Driver: Epson EPL-6200L = || | New Driver
J

RDP Printer Mapping Name
(for RDP sessions only)

Type in the desired printer name in a session (Windows desktop). If this field
remains blank, the name you typed in the Printer Name field will be used.
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3.4.8 Adding a Network Printer

To add a network printer for your mt188L, please do the following:

1.

Bl S

8.

9.

Ensure that your mt188L is connected to the network and the desired network printer is turned on.
On Atrust Client Setup, click Devices > Printer.
Click Add on the top of the Printer list.

The system automatically starts searching for available local printers. Upon completion, the discovered local
printers will be listed on the Printer Port drop-down menu.

Click the Printer Port drop-down menu to select the desired network printer. Three types of network printers
are available: TCP Network Printer, LPD Network Printer, and IPP Network Printer.

TCP Network Printer
LPD Metwork Printer
IPP Network Printer

Fields in the Add Printer section will automatically change to fit the type of the selected printer.

Type in the IP address of the network printer in the TCP Printer Server, LPD Printer Server, or IPP URI field.

~ Add Printer

Printer Name * |

TCP Print Server * |

TCP Port [9100

|
Printer Port: [ TCP Network Printer -]
|
|
|

Description: |

- Add Printer
Printer Name = |

Printer Port: [LPD Network Printer ~|

LPD Print Server * |

LPD Queue Name |

Description: |

 Add Printer
Printer Name * |

IPP URI * |

|
Printer Port: [1PP Network Printer -]
|
|

Description: |

Click the Manufacturer and Printer Model drop-down menus to select the manufacturer and model for the
desired network printer.

Refer to the table on page 95 to configure other printer settings, and then click Save to apply.
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3.5 Configuring Network Settings

3.5.1 Network Tab Overview

Network tab enables you to configure network settings for clients. To access available settings of Network tab, click
the tab on Atrust Client Setup.

Network Tab Overview
® Atrust Client Setup Gillod LGS
Atﬂ-lSt Applications User Interface Devices Network System
0........... Ethernet
Eth R edofrenn @
Hosts Configure wired network settings

Host Name

Wireless
- Proxy &y VPN

e Configure VPN (\irtual Private Network) connection settings

i Hosts
E Create the mapping of IP addresses to host names and aliases

Host Name
Adjust the host name for your client

1

) Wireless

Configure wireless network settings

-\f.";j Proxy
=" Configure proxy settings for Web-based access to services

Interface Elements

No. Name Description

Click to select a setting item under Network tab or to select a setting

1 Navigation area entry under a selected setting item.

2 Configuration area Configures setting values when a setting item or entry is selected.
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3.5.2 Available Settings at a Glance

Tab Setting Icon
Ethernet L]
VPN NG
A
Hosts - "',
Network

Host Name l;

Wireless

[ e

Proxy '»‘.l::,.

Description

Click to configure wired network settings.

Click to configure VPN (Virtual Private Network)

connection settings and create a VPN connection.

Click to create the mapping of IP addresses to
names or aliases of hosts and create the Failover
Cluster list.

Click to change the host name of your thin client.

Click to configure wireless network settings and
create a wireless connection.

Click to configure proxy settings for Web-based
access to services.
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3.5.3 Configuring Wired Network Settings
The Ethernet setting enables you to configure the wired network settings for your mt188L thin client.

Enabling or Disabling the Ethernet Network Interface
To enable/disable the Ethernet network interface, please to the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under Interface section, check/uncheck Enable to enable/disable the Ethernet network interface.

- Interface
a v Enable

- |IP Address
IP Type:

[ DHCP M

- DNS
DNS Type:

[Dynamic DNS {via DHCP)  ~] |

3. Click Save to apply.

Using a Dynamic IP Address

To use a dynamic IP address, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select DHCP for the IP type field.

NOTE

i

- If DHCP is selected, the DHCP server over the network will automatically assign
an IP address to your mt188L thin client. This is the default setting.

3. Click Save to apply.

Using a Static IP Address

To use a static IP address, please do the following:

%‘/ NOTE

+ It's recommended to use a dynamic IP address for your mt188L thin clientin a
corporate network environment.

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the IP address section, click the drop-down menu to select Static IP for the IP type field.

3. The IP address, Subnet mask, and Gateway fields appear in the IP address section.
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® Atrust Client Setup o ol
Atrust Applications User Interface Devices Nework System
Ethernet
PN ¢ Interface
~ Host
‘-“-“;Vireless ¢ IP Address ~
e IP Type: [Static IP -le
IP Address: [ | e
subnet Mask: | =
Gateway: | ‘ e
: DNS
Search Domain: [ | e
Nameserver 1: [ =
Nameserver 2: | ‘ e
4. Typein the IP address, subnet mask, and gateway for your mt188L thin client.
- IP address
IP type: | static IP MES
IP address: + [192.168.12.88 |
Subnet mask: = [255.255.255.0 |
Gateway: = [192.168.12.254 | &

=) NOTE
o
- Consult your network administrator for a free IP address and other required data
about the network to which your mt188L connects.

+ The red asterisks indicate the required fields.

5. Click Save to apply.

=) NOTE
i
+ You need to further specify DNS server addresses manually if you choose to use a
static IP address.

Obtaining DNS Server Addresses Automatically
To obtain DNS Server addresses automatically, please do the following:

NOTE

Ll

-+ You cannot obtain DNS server addresses automatically through the DHCP server if
you choose not to get the IP address via the DHCP server.



Configuring Client Settings
Configuring Network Settings

1. On Atrust Client Setup, click Network > Ethernet.

2. Under the DNS section, click the drop-down menu to select Dynamic DNS (via DHCP) for the DNS type field.

3. Click Save to apply.

Specifying DNS Server Addresses Manually
To specify DNS Server addresses manually, please do the following:

1. On Atrust Client Setup, click Network > Ethernet.
2. Under the DNS section, click the drop-down menu to select Manual setting.

3. The Search domain, Nameserver 1, and Nameserver 2 fields appear in the DNS section.

NOTE

]

« If you choose to use a static IP address for your mt188L thin client, then you need
to specify DNS server addresses manually. In this case, the DNS type field will not
appear for you to select Manual setting or Dynamic DNS (via DHCP).

Atrust Client Setup

Atrust Applications  User Interface Derices Network System.
Navigator General
~ Ethernet
WPN - Interface ~
Hosts « Enable ‘
Host Name =
\';\v:geless - IP Address )
xy ‘ IP Type: [DHCP -l e ‘
- DNS )
DNS Type: [Manual setting -l e
Search Domain: [ | e
Nameserver 1: [ =
Nameserver 2: | ‘ e
¢ Wake On LAN
‘ Wake On LAN: [Enabled -] e
| Save ] | Cancel

4. Type in the preferred DNS server address in the Nameserver 1 field and the alternate DNS server address in
the Nameserver 2 field if any.

% -) NOTE
— . Specifying a domain name in the Search Domain field will enable your system to

discover a computer in that domain simply with its computer name rather than its
FQDN (Fully Qualified Domain Name).

5. Click Save to apply.
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3.5.4 Establishing and Stopping a VPN connection

The VPN setting enables you to establish/stop a virtual private network connection for your t180L/t180LB.

NOTE

« The VPN setting also allows you to configure and manage virtual private network
settings. For instructions on how to configure and manage virtual private network
settings, please refer to section “3.5.5 Configuring Virtual Private Network Settings”
on page 106.

=

Adding a Virtual Private Network
To add a virtual private network, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

Atrust Client Setup

Atrust Applications User Interface Devices Network System
Navigator Connections Seftings
- Ethernet
HEN + Add = Delete
- Hosts
-~ Host Name Connection Name VPN Type  Status Comment

- Wireless
- Proxy

NOTE

- If you haven't created any entry, the Virtual Private Network list will be empty.

W

2. Click Add on the top of the Virtual Private Network list.
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3. On General tab, click the drop-down menu to select the desired VPN type. Three types are available: PPTP,

L2TP, and Cisco AnyConnect.

Atrust

Navigator

- Ethernet
VPN

- Hosts

- Host Name

Wireless

- Proxy

Applications

- Connection Settings

Atrust Client Setup

General Options

User Interface Devices Network

System

Connection Name: * |

VPN type: [peTP

Server Address: *

- Login Settings

Username: * |

Password: o

Domain: [

- Security and Compression Setting

e Use Point-to-Point encryption (MPPE)

- Authentication Settings

e Enable PAP

E Enable CHAP

.. ¥ Enable MSCHAP
+ Fnahle MSCHAPw?

Save H Cancel

=)) NOTE
=

+ The setting items will vary with the selected VPN type.

4. Type in or click drop-down menus to provide information about configuration and authentication.

%‘/ NOTE

« Consult your network administrator for required information on configuration and
authentication.

5. On Options tab, configure the DNS-related settings if needed.

6. Click Save to add the virtual private network.

Establishing a Virtual Private Network Connection
To establish a virtual private network connection for your t180L/t180LB, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.
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Atrust Client Setup

Al:l'usl: Applications User Interface Devices Nemwork System
Navigator Connections Settings
- Ethernet
VPN + Add = Delete
- Hosts
» ‘I‘*Vl?:élle\lsasme Connection Name VPN Type Status Comment
- Proxy : ATSVPN PPTP Connected before

) NOTE
- If you haven't created any entry, the Virtual Private Network list will be empty. For
instructions on adding a virtual private network, please see the preceding topic.

2. Click to check the desired virtual private network. The Connect # Connect  putton then appears on the top
of the Virtual Private Network list.

Atrust Client Setup

Atrust Applications  User Interface Devices Network System
Navigator Connections Settings
- Ethernet
VPN + Add — Delete ~ Edit 4 Connect
- Hosts
:*V?rsetlz";sme Connection Name VPN Type  Status Comment
~ Proxy o o ATSVPN PPTP Connected before

3. Click Connect to create a virtual private network connection through the selected network entry.
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4. Upon completion, the Status column of the virtual private network will show connected.

Navigator

- Ethernet
VPN

- Hosts

- Host Name
Wireless

- Proxy

Atrust Applicatlons

Connections

+ Add

User Interface

Settings

= Delete

Atrust Client Setup

Devices

Connection Name VPN Type  Status

ATSVEN

PPTP

connected

Newwork Syseem

Comment
Connected before, auto connect

Stopping a Virtual Private Network Connection
To stop a virtual private network connection, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Disconnect /# Discennect pytton appears on the top of

the Virtual Private Network list.

3. Click Disconnect to stop the virtual private network connection.

Deleting a Virtual Private Network
To delete a virtual private network, please do the following:

1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network.

3. Click Delete to remove the selected virtual private network.
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3.5.5 Configuring Virtual Private Network Settings

Adjusting Connection settings for a Virtual Private Network
To adjust connection settings for a virtual private network, please do the following:
1. On Atrust Client Setup, click Network > VPN to open the Virtual Private Network list.

2. Click to check the desired virtual private network. The Edit .~ Edit  button appears on the top of the
Virtual Private Network list.

3. Click Edit to adjust the settings, and then click Save to apply.

Configuring General Settings for Virtual Private Network Connections
To configure general settings for virtual private network connections, please do the following:

1. On Atrust Client Setup, click Network > VPN, and then click Settings sub-tab.

Atrust Client Setup

Atrust Applications  User Interface Derices Network System

Navigator Connections Settings

Ethernet
VPN
Hosts

Connection
Auto connect when startup

=
Host Name
Wireless Automatic VPN Connection: ATSVPN | E
Proxy L J
Save Cancel

2. Under the Connection section, click to check/uncheck Auto connect when startup to allow/disallow
automatic virtual private network connection after system startup. When this feature is enabled, select the
desired virtual private network through the drop-down menu.
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3.5.6 Creating the Mapping of IP Addresses to Names of Hosts

Atrust Client Setup allows you to use the name or alias of a host instead of its IP address wherever you need to
specify an IP address while configuring client settings. To use this feature, first you need to create the mapping of IP
addresses to names or aliases of hosts.

Creating the Mapping List
To create the mapping of IP addresses to names or aliases, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

& Atrust Client Setup o alliCS

Atru St Applications User Interface Devices Network System

Navigator | + Add H = Delete ]

- Ethernet
LWPN
Hosts

Hostname ¥ IP Address Alias / Group Priority

- Host Name
~ Wireless
- Proxy

2. Click Add to start adding a new host entry.
3. Typein the name, IP address, alias of a host, leave the Priority field blank, and then click Save to apply.

~ Hosts Table Settings
Hostname: * |WS2012R2RDSH | k&
IP Address: * [192.168.7.12 | &
Alias / Group: |ws12 | k&
Priority. | | B
_J

NOTE

« If your host belongs to a domain, please don’t enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the
computer name of the host in this required field.

ol

+ You need to type a number in the Priority field only when creating a Failover Cluster
list to allow host failover feature. For details, please refer to “3.5.7 Configuring the
Failover Cluster List” on page 109.
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4. The newly added entry appears in the Host list.

. e e P R
® Atrust Client Setup N =W | NN [

Atrust Applications User Interface Derices Network System
Navigator | + Add H = Delete l

;'__'__E,LTmEt Hostname ¥ |IP Address Alias / Group Priority

Hosts WS2012R2RDSH 102,168.7.12  WS12 0
- WS2012RZRDSH

~Host Name

- Wireless

- Prosy

5. Repeat steps 2 through 3 to add another new entry.

6. Now you can use the name or alias of a host instead of its IP address wherever you need to specify an IP
address on Atrust Client Setup while configuring client settings.

Managing the Mapping List
To manage the Mapping list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Mapping list.

« To delete an entry, check off the entry, and then click Delete on the top of the Mapping list.

+ To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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3.5.7 Configuring the Failover Cluster List

Atrust Client Setup allows you to create the Failover Cluster list, maintaining the high availability of services from
that group of servers (failover cluster).

Creating the Failover Cluster List
To create a Failover Cluster list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

& Atrust Client Setup o alliCS
Atru St Applications User Interface Devices Network System
Navigator | + Add H = Delete ]
:_:_Eg;fmet Hostname ¥ IP Address Alias / Group Priority
Hosts
- Host Name
-~ Wireless
- Proxy

2. Click Add to start adding a new host entry.

3. Typein the name, IP address, alias and also cluster (group) name, priority order in the cluster (group), and
then click Save to apply.

~ Hosts Table Settings
Hostname: * |ADM1 | B
IP Address: * [192.168.7.21 | &
Alias / Group: |ADM | k&
Priority (1 | &
_J

;——; ) NOTE
— « If your host belongs to a domain, please don't enter the FQDN (Fully Qualified
Domain Name) or full computer name in the Hostname field. Enter only the

computer name of the host in this required field.
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4. Repeat steps 2 though 3 to add another new entry.
5. All added entries appear on the Host list.

& Atrust Client Setup o alliCS
Atru St Applications User Interface Devices Network System
Navigator | + Add H = Delete ]
)'__'__ELTmEt Hostname ¥ IP Address Alias / Group Priority
Hosts ADM1 192.168.7.21 ADM 1
ADM1 ADMZ 192.168.7.22 ADM 2
- ADM2 ADM3 192.168.7.23  ADM 3

- ADM3
~-Host Name
Wireless
- Prowy

6. Your mt188L will follow the given priority order while connecting to this failover cluster (group).

Hostname % IP Address Alias / Group Priority
ADM1 192.168.7.21 ADM 1
ADM2 192.168.7.22 ADM 2
ADM3 192,168,7.23 ADM 2

Managing the Failover Cluster List
To manage the Host list, please do the following:

1. On Atrust Client Setup, click Network > Hosts to open the Host list.

2. Select to manage entries on the Host list.

« To adjust the settings of an entry, double click the entry, or check off an entry, and then click the Edit
button on the top of the Host list.
« To delete an entry, check off the entry, and then click Delete on the top of the Host list.

- To delete multiple entries, check off all the desired entries, and then click Delete. A window appears
prompting for confirmation. Click Yes to confirm.
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3.5.8 Changing the Host Name of Your Thin Client

To change the host name of your thin client, please do the following:

1. On Atrust Client Setup, click Network > Host Name.

2. Change the default host name of your thin client.

- i Gladl=lEad
®) Atrust Client Setup o Lol
Atl'l.l St Applications User Interface Derices Network System.
Navigator General
-~ Ethernet
PN - Name Setting
- Hosts Host Name * [atrust-03CEZA] =
- Wireless

* This setting will take effect after reboot.
- Proxy

| Save H Cancel |

3. Click Save to confirm.

4. Arestart is required for the change to take effect.
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3.5.9 Enabling or Disabling the Wireless Interface

To enable or disable the wireless interface, please do the following:

%J’ NOTE

By default, the wireless interface is enabled.

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

®) Atrust Client Setup o ol

Atl'l.lSt Applicati User Interf: Devices Network System
Connections Wireless
Ethernet
PN ¢ Interface
-~ Hosts §
" Host Name Enable wireless interface: Yes LI =
- Promwy
Save Cancel

2. Under the Interface section, click the drop-down menu to enable / disable the wireless network interface.

3. Click Save to apply.
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3.5.10 Configuring the Trigger Threshold for Roaming

To configure the roaming trigger threshold for your wireless connection, please do the following:

1. On Atrust Client Setup, click Network > Wireless, and then click Wireless sub-tab.

" LElEEE
®) Atrust Client Setup o alliCS

Atl'l.lSt Applicati User Interf; Devices Network System
- Ethernet
PN ¢ Interface
- Hosts ; ; . e
- Host Name Enable wireless interface: [ves -] = ‘
- Proxy ¢ Roaming
‘ Roaming Signal Strength Trigger: |-70 dBm j = ‘
Save Cancel

2. Under the Roaming section, click the drop-down menu to choose the desired trigger threshold.

NOTE

- To disable wireless roaming, you can choose No roaming here.

=

3. Click Save to apply.
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3.5.11 Establishing and Stopping a Wireless Connection

NOTE

« Ensure that the wireless interface is enabled. Please refer to “Enabling or Disabling
the Wireless Interface” on page 112.

% :

Establishing a Wireless Network Connection
To establish a wireless network connection for your mt188L thin client, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

N T e T T L =l 2
®) Atrust Client Setup o =llCS
Atl'l.l St Applications User Interface Devices Network System
Connections Wireless
- Ethernet
VPN + Add = Delete O, scan
Hosts
— Host Name 55D Priority  Signal *  Security Status Comment 2
HP-Print-F2-L.., 20 100 Insecure
Proxy IT-APO2 20 100 WPA
SMCWGERL4... 20 100 WPA
roaming24 20 100 WPA
roaming3 20 100 WPA
Demo-APO1 20 a7 WPA 802.1x
HTC Portable... 20 94 WPA
TP-LINK_F36E... 20 94 WPA
MIX2 20 91 WPA
sophia_2.4G 20 81 WPA
Demo-AP02 20 8l WPA
KiKi-KR2 20 80 WPA
guest00l 20 80 WPA
TP-LINK_EFO1... 20 74 WPA
Battenlife_5G6 20 72 WPA
IT-APO3 20 70 WPA
DSR-1000N 20 70 WPA -
Kerker~HerH... 20 68 WPA
MIX5 20 64 WPA
IT-APOL 20 62 WPA
HITRON-6SB0 20 &0 WPA
= HITRON-2920 20 55 WPA
CHT1081 20 54 WPA
-I- min home 20 54 WPA | hd
« 3

NOTE

+ Your mt188L will perform network discovery once and specify all available wireless
networks. To refresh, click Scan on the top of the Wireless Network list.

i)

2. Click to check the desired wireless network. The Connect .~ Cennect button then appears on the top of the
Wireless Network list.
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- T T T e
®) Atrust Client Setup o ol
Atrust Applications User Interface Devices Network System
Connections Wireless
- Ethernet
o WPN + Add = Delete ©) Scan ¥ Connect
-~ Hosts
_~Host Name SSID Priority  Signal * Security Status Comment |
“HP-Print-F9-L.. 20 100 Insecure
Proxy ¥ maPo2 20 100 WeA
SMCWGERL4... 20 100 WPA
roaming24 20 100 WPA
roamings 20 100 WPA
Demo-APO1 20 a7 WPA 802.1x
HTC Portable... 20 94 WPA
TP-LINK_F36B... 20 24 WPA
MIX2 20 = WPA
sophia_2.4G 20 81 WPA
Demo-AP0O2 20 81 WPA
KiKi-KR2 20 80 WPA
guest00l 20 80 WPA
TP-LINK_EFOL... 20 74 WPA
Battenlife_ 56 20 72 WPA
IT-APO3 20 70 WPA
DSR-1000N 20 70 WPA -
Kerker~HerH... 20 68 WPA
MIX5 20 64 WPA
IT-APOL 20 62 WPA
HITRON-62B0 20 &0 WPA
HITRON-8920 20 55 WPA
CHT1091 20 54 WPA
-I- min home 20 54 WPA | e
. 3

Click Connect to create a wireless network connection through the selected wireless network.

A window appears prompting for confirmation or authentication.

Wireless Network Authentication Required

Authentication required by wireless network, Passwerds or encryption
keys are required to access the wireless network.

Wireless Security: [WPa & wPaA2 Personal |
Key: * [ ]

Show character

Connect Cancel

NOTE

- If you ever accessed this wireless network before, the password will be automatically
recorded for future access. In this case, you don't need to provide the password
again; you only need to confirm the establishment of a wireless connection.

it
« Consult your network administrator for required information on authentication.

Type in the required password, and then click Connect to continue. Or, click OK to confirm the establishment
of a wireless connection.

Upon completion, the Status column of the wireless network will show connected.

SSID Priority ~ Signal Security Status * Comment
IT-APO2 20 100 WPA connected Connected before
sophia_2.4G 20 92 WPA

roamings 20 87 WPA

roaming24 20 100 WPA

guest00l 20 87 WPA

dlink_DWR-113 20 38 WPA

dir-810-5g 20 45 WPA

dir-810-2g 20 94 WPA

amphenol_S... 20 72 WPA

v
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Stopping a Wireless Network Connection
To stop a wireless network connection, please do the following:
1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network. The Disconnect / Disconnect pytton appears on the top of the
Wireless Network list.

3. Click Disconnect to stop the wireless network connection.

Adding a Wireless Network
In case that you cannot find the desired wireless network in the Wireless Network list, you can manually add it.

To add a wireless network to the Wireless Network list, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.
2. Click Add on the top of the Wireless Network list.

3. On the opened window, type the wireless network name (SSID), select the used wireless security method,
and then provide the required information.

Confirm Dialog

You are going to connect this network.
Are you sure?

Wireless Network Name (SSID); *

Security: |Disab|e Encryption ;l

[ Connect H Cancel l

4. Click Connect to create a wireless connection.

NOTE

- For instructions on how to configure the IP address settings, please refer to section
“3.5.3 Configuring Wired Network Settings” on page 99.

i |

« The default is to use a dynamic IP address assigned by the DHCP server.

5. Upon completion, the added wireless network will be shown on the Wireless Network list and connected will
be shown on its Status column.

Deleting a Wireless Network
To delete a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network, and then click Delete to remove the selected wireless network.

NOTE

+ Your mt188L detects available wireless networks automatically and put the
discovered networks on the Wireless Network list. A deleted wireless network may
therefore appear again on the list, but the connection settings, including the stored
authentication data, will be removed.

i |
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3.5.12 Configuring Wireless Connection Settings

To adjust connection settings for a wireless network, please do the following:

1. On Atrust Client Setup, click Network > Wireless to open the Wireless Network list.

2. Click to check the desired wireless network which is currently connected. The Edit =~ .« Edit  putton
appears on the top of the Wireless Network list.

3. (lick Edit to adjust the settings:

i NG
® Atrust Client Setup o Lokl
Atrust Applications User Interface Derices Nemwork System
- Ethernet
PN ¢ Wireless Settings )
- Hosts Wireless Network Name (SSID): * [IT-APOZ | &
- Host Name
Mode: [Managed &
P
rexy Connect automatically: |Enab\ed hd IS
Priority: |20 hd I
¢ Authentication
Security: [WPA & WPAZ Personal | B
Network Key * |wwmmm | &
Save H Cancel

+ On the General tab, click the drop-down menu to configure the automatic connection when this wireless
network is in range, the priority, and other connection settings.

=) NOTE
5/
- By default, your client will connect to a wireless network automatically if it ever
connected to that network successfully.

« To connect to wireless networks in order of priority, you can set Priority. By default,
there is no priority, and the lowest value, 20, is given for all networks.

« On the IPV4 Settings tab, click the drop-down menu or type values in fields to configure IP settings.

NOTE

i |

« For instructions on how to configure connection settings on the General tab, please
see section “3.5.11 Establishing and Stopping a Wireless Connection” on page 114.
For instructions on how to configure IP address settings on the IPV4 Settings tab,
please see section “3.5.3 Configuring Wired Network Settings” on page 99.

4. Click Save to apply.
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3.5.13 Configuring Proxy Settings for Web-based Access to Services

To configure proxy settings for Web-based access to services, please do the following:

NOTE

- Settings available here are only applicable to services that use Web-based access,
such as (Microsoft) Remote Web Access and (Citrix) Web Logon connection types.

=

1. On Atrust Client Setup, click Network > Proxy.

2. Click the Mode drop-down menu to select the desired configuration mode. Four modes are available:
No Proxy, Auto-detect proxy settings, Manual proxy configuration, and Auto proxy configuration.

=) NOTE

« The setting items will vary with the selected mode.

Gl

® Atrust Client Setup o Lol
Atl'l.l St Applications User Interface Derices Network System
-~ Ethernet
PN + Connection Settings )
- Hosts Mode: |N0 Proxy ;I e

~~Host Mame
-~ Wireless
Pro:

* These settings are only applicable to services that use Web-based access, such as
(Microsoft] Remote Web Access and (Citrix) Web Logon connection types.

| Save H Cancel |
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3. Provide the data as required. Please refer to the following table for a description of each setting item.

Connection Settings

Item Description

Click to select the desired proxy configuration mode.

Mode Description

No Proxy Don’t use any proxy server.

Auto-detect proxy Detects the proxy settings for your network
Mode settings automatically.

Manual proxy

configuration Configures the proxy settings manually.

Auto proxy Loads proxy settings automatically through the
configuration connection to a proxy configuration file.

Mode: Manual proxy configuration

HTTP Proxy Provides the IP address of your HTTP proxy server.

Port Provides the port number which your HTTP proxy server uses.

Provides No Proxy list.

No Proxy for Don’t use any proxy server while connecting to the specified URLs.

Mode: Auto proxy configuration

Provides the URL of a proxy configuration file where proxy settings can be loaded

URL through the network.
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3.6 Configuring Service Access Settings

3.6.1 Applications Tab Overview

Applications tab enables you to configure settings for service access on clients. To access available settings of
Applications tab, click the tab on Atrust Client Setup.

Applications Tab Overview

® Atrust Client Setup CEN =N W= [
Atl'l.lSt Applications User Interface Devices Network System
0......... e s eeRemote Desktop
R SK08 |  emote Desktop Avalable Sessions: 0 e e @
VMware View 2 configure RDP (Remote Desktop Protocol) connection settings
S5H

Web Browser

Parallels 2X Client Citrix ICA Available Sessions: 0

Configure Citrix ICA connection settings

VMware View Available Sessions: 0

Configure WVMware Wiew connection settings

SSH Available Sessions: 0
<& Configure SSH (Secure Shell) session settings

Web Browser Available Sessions: 0
Configure local browser settings

Parallels 2X Client Available Sessions: 0
Configure Parallels 2X Client settings

Interface Elements

No. Name Description

Click to select a setting item under Applications tab or to select a setting
entry under a selected setting item.

1 Navigation area

2 Configuration area Configures setting values when a setting item or entry is selected.
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3.6.2 Available Settings at a Glance

Tab Setting Icon Description Section Page
=1 Click to configure RDP (Remote Desktop Protocol) 3.6.3 122

Remote Desktop = connection settings and create shortcuts on the local 3.6.4 131
— desktop and START menu for Remote Desktop sessions. 3.6.5 137

3.6.6 153

Click to configure ICA (Independent Computing ggg 123

Citrix ICA Architecture) connection settings and create shortcuts 3.6.9 168

on the local desktop and START menu for ICA sessions. 3.6.10 169

3.6.11 176

Click to configure VMware View connection settings and 3.6.12 205

VMware View create shortcuts on the local desktop and START menu 3.6.13 207
Applications for View sessions. 3.6.14 209
Click to configure SSH (Secure SHell) connection 3.6.15 514

SSH [o—— settings and create shortcuts on the local desktop and 3.6.16 216

- START menu for SSH sessions. e
_ Click to configure settings and create shortcuts on the Fo:17 2Ly
Web Browser y : 3.6.18 219
/ local desktop and START menu for browser sessions.
3.6.19 220
Click to configure RAS (Remote Application Server) / 3.6.20 221
Parallels 2X RDP (Remote Desktop Protocol) connection settings and e
. 3.6.21 226
Client create shortcuts on the local desktop and START menu 3.6.22 228

for RAS / RDP sessions.
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3.6.3 Configuring Basic RDP Connection Settings

The Remote Desktop setting allows you to configure RDP (Remote Desktop Protocol) connection settings and
create shortcuts on the local desktop and START menu for service access. You can access remote desktops or
applications for work simply through these shortcuts.

NOTE

« For more information on Mirosoft Remote Desktop services, please visit Microsoft
website at www.microsoft.com.

(W)

Three connection types are available:

Connection Type Description Page
Remote Desktop Select to access remote desktop/application services. 123
Remote Web Access  Select to access remote application services through a Web browser. 125

Web Feed Select to access remote application services through published desktop shortcuts. 127


www.microsoft.com

Connection Type: Remote Desktop

To quickly configure RDP connection settings for the Remote Desktop connection type, please do the following:

1.

2. The RDP Connection list appears in the Configuration area.

Configuring Client Settings

Configuring Service Access Settings

On Atrust Client Setup, Click Applications > Remote Desktop.

® Atrust Client Setup 5 =l
Atl'l.lSt Applications User Interface Derices Network System
Reote Desktop Session Name *  Server Address Connection Type
- Citrin ICA
VMware View
-55H
- Web Browser
- Parallels 2X Client
a\ ) NOTE
- If you haven't created any entry, the RDP Connection list will be empty.
3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
® Atrust Client Setup Lalloulllallies
Al:l'l.lSt Applications User Interface Devices Newwork System
Navigator General Options RD Gateway
Remote Desktop
- Citrix ICA ¢ Server Settings
VMware View Session Name: * ‘ | [
-55H
- Web Browser Computer: @ ] I
- Parallels 2X Client S
Connection Type: [Remote Desktop -l
Network Level
Authentication: [Enabled -l

4. On General sub-tab, type in the session name and the server/virtual machine address under the Server

Server Authentication:

‘ Connect and don't warn me LI e

- Login Settings

Username: | | =
Password: [ | e
Domair: [ | =
e Use Smart Card Login

: Common Settings
Autostart When Startup: [Mo e
0on Application Exit: |Do MNothing e

Save l | Cancel

Settings section.
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NOTE

« The red asterisks indicate the required fields.

i

+ The remote service-hosted computer can be a physical server or a virtual machine.
Please visit Microsoft’s websites at www.microsoft.com or support.microsoft.com for
more information.

+ mt188L supports up to two Remote Desktop sessions at the same time.

« Windows® RemoteFX™ is the technology that offers a rich user experience over a
network for remote desktop users.

NOTE

il

- To create an entry of RDP connection settings for MultiPoint™ Remote Desktop
sessions, please do the following:

e
5 \-—{ to start discovering MultiPoint™

WMS

1. Inthe Server Settings section, click
Server systems over your network.

2. Inthe opened window, click the drop-down menu to select the desired
server, and then click OK to confirm.

3. The name and IP address of the selected server will be filled out in the
corresponding fields automatically.

« The default session name will be the name of the selected MultiPoint host server,
but you still can change the default.

+ Windows® MultiPoint™ Server is a shared resource technology. This Windows-based
operating system enables a host server to power multiple and independent stations,
allowing users to share the computing power of one single server. Based on this
operating system, Atrust offers a complete solution including both servers and
clients. For more information, please visit our website at www.atrustcorp.com.

5. Click Save to add this RDP connection entry.

6. The shortcuts for Remote Desktop services are automatically created on the local desktop and START menu.

NOTE

Wl

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced RDP connection settings for service
access. For more information on other available settings, please refer to section
“3.6.5 Configuring Advanced RDP Connection Settings” on page 137.
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Connection Type: Remote Web Access

To quickly configure RDP connection settings for the Remote Web Access connection type, please do the following:

5/ NOTE

+ Atrust mt188L supports only RD Web Access based on Windows Sever 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

® Atrust Client Setup Lalloullollies

Atl'l.lSt Applications User Interface Devices Network System
: ote Desktop Session Name *  Server Address Connection Type
s Citriv ICA

~WMware View

- SSH

- Web Browser

- Parallels 2X Client

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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® Atrust Client Setup N =N | W= B
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
trix 1CA - Server Settings
VMware View Session Name: [ |k
“8SH
Web Browser Computer: ‘Q | 1%
- Parallels 2X Client Mg
Connection Type: \ Remote Desktop ;I =
Network Level -
Authentication: (Enabled R [

Server Authentication:

[Connect and don't warn me =] e

- Login Settings
Username:

Password:
Domain:

e Use Smart Card Login

4. On General sub-tab, click the Connection Type drop-down menu to select Remote Web Access.

® Atrust Client Setup Lalloulllallies
Al:l'l.lSt Applications User Interface Devices Nework System
Navigator General Options RD Gateway
Remote Desktop
trix ICA - Server Settings
VMware View
-55H .
- Web Browser Session Name: * | | =
- Parallels 2X Client
Connection URL: * | | e
Connection Type: [Rernote Web Access hd 'S
« Common Settings
Autostart When Startup: [Mo -] e
On Application Exit: |D0 MNothing j e

Save

] | Cancel

5. Type in the session name and connection URL through which Web-based remote applications is accessible.

5/ NOTE

« The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate connection URL.

6. Click Save to add this RDP connection entry.

7. The shortcuts for Remote Web Access are automatically created on the local desktop and START menu.
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Connection Type: Web Feed
To quickly configure RDP connection settings for the Web Feed connection type, please do the following:

5/ NOTE

+ Atrust mt188L supports only RD Web Feed based on Windows Sever 2012 R2;
Windows Server 2008 R2 based is not supported.

1. On Atrust Client Setup, Click Applications > Remote Desktop.

2. The RDP Connection list appears in the Configuration area.

® Atrust Client Setup Lalloullollies

Atl'l.lSt Applications User Interface Devices Network System
: ote Desktop Session Name *  Server Address Connection Type
s Citriv ICA

~WMware View

- SSH

- Web Browser

- Parallels 2X Client

%J‘ NOTE

- If you haven't created any entry, the RDP Connection list will be empty.

3. Click Add on the top of the RDP Connection list to create a new entry of RDP connection.
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Atrust Client Setup | =N =
l\l:l'l.lSl: Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
Citrix ICA ¢ Server Settings
VMware View Session Name: [ |k
S5H
Web Browser Computer: ‘Q | 1%
- Parallels 2X Client Mg
Connection Type: \ Remote Desktop ;I =
Network Level -
Authentication: (Enabled R [

Server Authentication: [Connect and don't warn me =] e

- Login Settings

Username: [
Password: | | e
Domain: | | =
e Use Smart Card Login
- Common Settings
Autostart When Startup: |No hd I
On Application Exit: |Do Nothing hd I
Save l | Cancel
4. On General sub-tab, click the Connection Type drop-down menu to select Web Feed.
® Atrust Client Setup N =N | W= B
l\tl'l.ISt Applications User Interface Devices Network System
Navigator General Options RD Gateway
Remote Desktop
Citrix ICA ¢« Server Settings
WMware View
55H i .
Web Browser Session Name: * | | =
- Parallels 2X Client
web Feed URL: L | &
Connection Type: |Web Feed e
- Login Settings )
Username: [ | =
Password: | | e
Domain: * | | =
- RemoteApp and Desktop Connections
Update Now
summary:
Last Update:
Save l | Cancel

5. Type in the session name, Web Feed URL through which remote applications is accessible, and your
credentials for Web Feed.

5’/ NOTE

+ The red asterisks indicate the required fields.

« Consult your IT administrator about the appropriate Web Feed URL.
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6. Click Update Now in the RemoteApp and Desktop Connections section. After completion, the result will be
shown as below in that section.

RemotefApp and Desktop Connections

Summary: 3 applications, 0 desktops
Last Update: Marn Jun 30 2014 10:13:16

%J’ NOTE

+ You can and need to use Update Now to refresh the Web Feed summary if there are
newly published applications. Otherwise, new applications will not be accessible.

7. Click Save to add this RDP connection entry.

8. Afolder named Work Resources with access shortcuts will be automatically created on the local desktop.

B2l | @ (Terminal]
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9. Access shortcuts for available applications can be found in that folder.

Work Resources - File Manager

File Edit View Go Help

@ B 4 B |fhome!user!DesIaop!Work Resources/ §|
DEVICES
@ File System
Calculator Paint WordPad
PLACES
@ user
C“-' Desktop

Trash

3 items (745 bytes), Free space: 390.2 MB 4

%J‘ NOTE

+ You need to use Update Now described in Step 6 to refresh the Web Feed if there
are newly published applications. Otherwise, new applications will not be shown.
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3.6.4 Accessing Remote Desktop Services

Connection Type: Remote Desktop
To access remote desktops, please do the following:

1. Double click the created shortcut on the desktop.
2. Follow the on-screen instructions and provide required credentials if needed.

3. The remote desktop will be displayed on the screen.

Example: Windows MultiPoint Server 2012

°
WMSUT &

Example: Windows Server 2012

28 Windows Server 2012R2
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Example: Windows 8 Enterprise

= NOTE
)
+ The connection type of Remote Desktop also allow you to launch application-
only sessions; only a specific application is launched rather than a full desktop.

For details, please refer to section“3.6.5 Configuring Advanced RDP Connection
Settings”on page 137.



Connection Type: Remote Web Access
To access remote applications, please do the following:

1. Double click the created shortcut on the desktop.

2. A window appears prompting for credentials.

Work Resources

(2¢) RemoteApp and Desktop Connection

Configuring Client Settings

Configuring Service Access Settings

his web page, you
complies with your

‘@/ NOTE

« A warning message “This Connection is Untrusted” might appear. Consult the
IT administrator for details and ensure the connection is secure first. To import
a security certificate, please refer to section “3.2.17 Importing Certificates for
Remote Computers” on page 68.To bypass, click | Understand the Risks > Add

Exception > Confirm Security Exception.

& ¥ TIP

- To exit this Logon screen or other screens and return to the local desktop, please

press Alt + F4.

3. Provide your credentials, and then click Sign in.
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4. Access shortcuts will be shown on the screen.

S h .
Work Resources s u'

RemoteApp and Desktop Connection

RemoteApp and Desktops Help  Sign out

Current folder: /

paint Wordpa

Current folder: /

P

Calculator Paint

5. Click or Double-click to select the desired application.

6. A window appears prompting for credentials.

- Windows Security i
Enter your credentials

These credentials will be used to connect to
VRDWEB12RZ2.RDWEB.FOC: 3389,

7. Provide your credentials, and then click OK to launch the selected application.

Q/ TIP

+ Use Alt + Tab to select and restore a hidden or minimized application or desktop.
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Connection Type: Web Feed

1. Double click Work Resources folder on the local desktop.

Atrust

Bl | @ rerminal us 9 0
—

2. Access shortcuts for available applications can be found in that folder.

le Manager

File Edit View Go Help

@ B 4 B |fhome!user!DesIaop!Work Resources/ @|
DEVICES _
g B
@ File System
Calculator Paint WaordPad

PLACES

@ user

C “ Desltop

Trash

3 items (745 bytes), Free space: 390.2 MB 4

3. Double-click to select the desired application.
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4. A window appears prompting for credentials.

Windows Security

Enter your credentials

These credentials will be used te connect to
VRDWEB1 2R2.RDWERB.POC: 3389,

Username: o D
Password: :]
Domain: :]

5. Provide your credentials, and then click OK to launch the selected application.

Remote Application Examples
Mozilla Firefox and Calculator

@ MoilaFirefox tart Page

Ele Edt View Go Help
4 ® & € B/nhomeluser/Desktop/Work Resources/
DEVICES e 3
Google (=) File System

Caleulator  Mozilla Firefox Paint

PLACES
: :
() GrmRs = - =

() Desktop WordPad

¥ * O % O @ rreminn &

Downloads  Bookmarks  History Add-ons Sync

Choose What I Share | %

Calculator
View Edit Help

"Calculator” (251 bytes) desktop configuration file

Calculator @ Mozilla Firefox Start ... | & [Terminal]

B

Work Resources - File.. us 9 0
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3.6.5 Configuring Advanced RDP Connection Settings

The tables below provide a description of each setting item for RDP connections. Please refer to these tables to
configure advanced settings and customize shortcuts on local desktop and START menu for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Remote Desktop

= NOTE
— - For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 145.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 148.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Desktop sessions.
C Type in the computer name or IP address of the server where to deliver a
omputer .
Remote Desktop session.
This table only provides descriptions for available settings when Remote
Desktop is selected.
Three connection types are available:
Option Description
Connection Type Remote Desktop Select to access remote desktop/application services.
Remote Web Access Select to access remote application services through

a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.

Select to enable/disable Network Level Authentication.

NOTE: Network Level Authentication is the authentication method used to
enhance the server security by requiring that the user be authenticated
before the logon screen is displayed and a session is created. This is a
more secure authentication method that can help protect the remote
computer from malicious users and software.

Network Level Authentication

137



138 | Configuring Client Settings

Configuring Service Access Settings

Server Authentication

Select what to do next if the client cannot verify the identity of the remote
computer. Three options are available: Connect and don’t warn me,
Warn me, and Do not connect.

Option Description

Connect and don't Connects anyway without any warning.

warn me
Warns and allows users to choose whether t
Warn me a and allo o choo (o]
connect or not.
Do not connect Disallows the connection.

NOTE: To import certificates for remote computers, please refer to section
"3.2.17 Importing Certificates for Remote Computers” on page 68.

Login Settings

Item Description
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Type in the domain of the server.
Domain NOTE: Domain is a collection of computers on a network that share a common

database and security policy. Leave this field blank if the server doesn’t

belong to any domain.

Use Smart Card Login

Check to enable logon with a smart card.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a Remote Desktop session automatically or not when
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description
The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.
Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

2 Autostart

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

e Returning to the local desktop
e Re-launching a new session

e Restarting the thin client

e Turning off the thin client

3 Quick Connection

The client will enter Atrust Quick Connection
screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a Remote Desktop session is ended. Five options are
available: Do Nothing, Restart Application, Force-Restart Application,

Reboot, and Shutdown.

Option

Description

Do Nothing

Returns to the mt188L local Linux desktop.

Restart Application

Opens a Remote Desktop session again.

Force-Restart Application

Opens a Remote Desktop session again and
skips any messages in-between.

Reboot

Restarts your mt188L.

Shutdown

Turns off your mt188L.
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Options Sub-tab

Programs

Item

Description

Start the following program on
connection

Click the drop-down menu to enable or disable the Application mode. Use this
option to select the session type. Two remote session types are available:

e Remote Desktop (when the Application mode is disabled)
e Remote Application (when the Application mode is enabled)

NOTE: Remote Application sessions are Remote sessions used to access only
specific applications rather than full desktops.

NOTE: Before you can open a Remote Application session, you need to add the
desired application to the RemoteApp Programs list with RemoteApp
Manager on the host server. For detailed instructions on how to add a
desired application to the RemoteApp Programs list on the server, please
visit Microsoft’s website at www.microsoft.com.

Start in the following folder

Type in the location of the desired application (on the host server) if Start the
following program on connection is enabled.

NOTE: You can type in the location/path of the desired application in this field,
and specify only the name of the application in Program path and file
name (the next field). Or, you can type in the full path and name of the
application in Program path and file name, and leave this field empty.

Program path and file name

Type in the name of the desired application if Start the following program on
connection is enabled.

Remote APP Format Example

Windows Media Player C:\Programs Files (x86)\Windows Media Player\wmplayer.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32.exe
Adobe Reader X C:\Programs Files (x86)\Adobe\Reader 10.0\Reader\ArcoRd32

NOTE: the file extension can be omitted.

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.
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Resolution

Click the drop-down menu to select the desired display resolution on a Remote
Desktop session. Four options are available: Fullscreen, Large Window,
Medium Window, and Small Window.

Option Description

Opens a Remote Desktop session in full screen with the same

Fullscreen display resolution as the local desktop.

Large Window Opens a Remote Desktop session in a large display resolution.

Medium Window Opens a Remote Desktop session in a medium display resolution.

Small Window Opens a Remote Desktop session in a small display resolution.

NOTE: To configure the display resolution of the local desktop, please refer to
section “3.3.3 Configuring Display Settings” on page 75.

Use Toolbar

Click the drop-down menu to select whether to use the Atrust Toolbar on a
Remote Desktop session. The tool bar allows you to adjust a session window size
or suspend a session.

Atrust & %

Fullscreen Toggle

Click the drop-down menu to allow/disallow fullscreen toggle for a remote
session by Ctrl + Alt + Enter.

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
mt188L thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Progressive Rendering

Click the drop-down menu to disable/enable progressive rendering.

When enabled, images and videos will be encoded and sent over progressively
when the network bandwidth is limited. This new RemoteFX feature is supported
by Windows Sever 2012 and Windows 8.

NOTE: This option is shown only when Use RemoteFX is enabled.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.
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Optimization Settings

Item

Description

Connection Quality

Select the option that best describes the quality of your network connection.
Three options are available: LAN (Very Fast), Broadband (Fast), and
Modem (Slow).

NOTE: Selection here will determine the defaults of items in this section as
listed below.

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.

Connection Settings

Item

Description

Multimedia Redirection

Click the drop-down menu to disable/enable multimedia redirection.

When enabled, the client receives original compressed multimedia streams and
decodes locally for display. This feature increases the load on the client, but
saves server resources, decreases the bandwidth usage, and improves audio and
video playback experiences.

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
"3.4.3 Configuring Settings for USB Storage Devices” on page 89.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your mt188L first, and then
enable this feature here to use that printer in a Remote Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt188L, please refer to section “3.4.7 Adding a Local Printer” on page
93 or “3.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.
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Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Server Status Check

Click the drop-down menu to enable/disable connection status check.

NOTE: Some servers deployed for remote sessions may not support connection
status check. Enabling this feature would cause remote sessions
disconnected. In this case, disable it to avoid disconnection.

Connection Dialog Settings

Item

Description

Show Connection Information
Using

Click the drop-down menu to select what to show for a remote computer in the
connection dialog window: Computer field or Session Name field.

Show Domain Field

Click the drop-down menu to show/hide the domain field in the connection
dialog window.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
session using audio devices attached to the
remote computer.

Play on remote computer

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.

Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description

Recording from this
computer

Allows audio recording in a Remote Desktop
session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.
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RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your client.

. Ensure that RemoteFX is enabled on your mt188L (see “Use RemoteFX"
on page 141).
3. Click to check Use RemoteFX USB Redirection.

4. A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable
RemoteFX USB Redirection in a Remote Desktop session. For instructions

on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.

RD Gateway Sub-tab

Connection Settings

Item

Description

Use RD Gateway server

Check/Uncheck to enable/disable the use of an RD Gateway server. When
checked, the following two items in this table appear.

Server Name

Type the name of the RD Gateway server. Ask the network administrator for
this information.

Use my Remote Desktop
credentials for the RD Gateway

Check to use the same set of credentials for authenticating to both the Remote
Desktop computer and the RD Gateway server.

Bypass RD Gateway for
local address

Check to prevent traffic to and from local network addresses from being routed
through the RD Gateway server. This could make your RDP connection faster.
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Settings for the Connection Type of Remote Web Access

=) NOTE

- For descriptions of settings for the connection type of Remote Desktop, please refer
to “Settings for the Connection Type of Remote Desktop” on page 137.

- For descriptions of settings for the connection type of Web Feed, please refer to
“Settings for the Connection Type of Web Feed” on page 148.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for Remote Web Access sessions.
Connection URL Type in the URL of the server where to deliver Remote Web Access sessions.

This table only provides descriptions for available settings when Remote
Web Access is selected.

Three connection types are available:

Option Description

Connection Type Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through
Web Feed published desktop shortcuts.
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Common Settings

Item Description

Select whether to open a Remote Web Access session automatically or not when
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Microsoft RDP session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a Remote Web Access session is ended. Five options
are available: Do Nothing, Restart Application, Force-Restart Application,
Reboot, and Shutdown.

Option Description
Do Nothing Returns to the mt188L local Linux desktop.
On Application Exit Restart Application Opens a Remote Web Access session again.

Opens a Remote Web Access session again and

Force-Restart Application skips any messages in-between.

Reboot Restarts your mt188L.

Shutdown Turns off your mt188L.
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Options Sub-tab

NOTE

i)

- No settings are available under the Options sub-tab in the connection type of
Remote Web Access.

RD Gateway Sub-tab

NOTE

i)

- No options are available under the RD Gateway sub-tab in the connection type of
Remote Web Access.
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Settings for the Connection Type of Web Feed

=

General Sub-tab

NOTE

For descriptions of settings for the connection type of Remote Desktop, please
refer to “Settings for the Connection Type of Remote Desktop” on page 137.

For descriptions of settings for the connection type of Remote Web Access, please
refer to “Settings for the Connection Type of Remote Web Access” on page 145.

Server Settings

Item

Description

Session Name

Type in the name for Web Feed sessions.

Web Feed URL

Type in the URL of the server where to deliver Web Feed sessions.

Connection Type

This table only provides descriptions for available settings when Web Feed
is selected.

Three connection types are available:

Option Description

Remote Desktop Select to access remote desktop/application services.

Select to access remote application services through

Remote Web Access a Web browser (Mozilla Firefox).

Select to access remote application services through

Web Feed published desktop shortcuts.

Login Settings

Item Description

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

RemoteApp and Desktop Connections

Item

Description

Update Now

Click to fetch and update the published applications list from the server.
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Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for a Remote
Desktop session. Five options are available: Automatic, 15 Bit, 16 Bit, 24 Bit,
and 32 Bit.

NOTE: If RemoteFX is enabled, then no matter which color depth you choose
here, 32 bit per pixel will be applied.

NOTE: The Automatic option uses the setting defined by the host server.
NOTE: You can configure the upper limit of the color depth for a Remote Desktop

session on the host server. In this case, no matter which color depth you
choose here, the value cannot exceed the defined limit.

Cursor Auto-hide

Click the drop-down menu to enable/disable the auto-hiding of the mouse cursor
or pointer on inactivity in Remote Desktop sessions.

Use RemoteFX

Click the drop-down menu to disable/enable RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: To enable the RemoteFX feature for Remote Desktop sessions on your
mt188L thin client, you still need to configure the host server. For
detailed instructions on how to enable RemoteFX on a host server, please
visit Microsoft Support website at support.microsoft.com.

Use Bulk Compression

Click to enable/disable the bulk compression for the data traffic between the
server and client.

Optimization Settings

Item

Description

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Visual styles

Check to allow non-classic themes.

Persistent bitmap caching

Check to allow client-side cache of bitmaps for a session.
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Connection Settings

Item

Description

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in a Remote Desktop session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in a Remote Desktop session.
The default is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
“3.4.3 Configuring Settings for USB Storage Devices” on page 89.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in a
Remote Desktop session.

NOTE: You need to add a local or network printer for your mt188L first, and then
enable this feature here to use that printer in a Remote Desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt188L, please refer to section “3.4.7 Adding a Local Printer” on page
93 or “3.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in a Remote Desktop session.

Parallel Port Mapping

Click the drop-down menu to enable/disable parallel port mapping.

When Enable is selected, users can access a parallel device, such as a printer or
scanner, in a Remote Desktop session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in a Remote Desktop session.

Connection Dialog Settings

Show Connection Information
Using

Click the drop-down menu to select what to show for a remote computer in the
connection dialog window: Computer field or Session Name field.

Show Domain Field

Click the drop-down menu to show/hide the domain field in the connection
dialog window.
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Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in a Remote Desktop

Play on this computer session using locally attached audio devices.

Allows audio playback in a Remote Desktop
Play on remote computer  session using audio devices attached to the
remote computer.

Disables audio playback in a Remote Desktop

Do not play session using locally attached audio devices.

Remote Audio Recording

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Two options are available: Recording from this computer
and Do not record.

Option Description
Recording from this Allows audio recording in a Remote Desktop
computer session using locally attached audio devices.

Disables audio recording in a Remote Desktop

Do not record session using locally attached audio devices.

RemoteFX USB Redirection Settings

Item

Description

Use RemoteFX USB Redirection

Check/Uncheck to enable/disable locally attached USB devices in a Remote
Desktop session (virtual machine based only).

NOTE: RemoteFX USB Redirection allows the redirection of USB devices into
server-hosted virtual machines (with guest operating systems).

NOTE: RemoteFX USB Redirection is only applicable to the virtual machine based
Remote Desktop service not to session based one. For more information,
please visit Microsoft Support website at support.microsoft.com.

On the client side, please do the following to enable locally attached USB devices
in a virtual machine based desktop:

1. Ensure that the desired USB device has been connected to your mt188L.
Ensure that RemoteFX is enabled on your mt188L (see “Use RemoteFX”
on page 141).

3. Click to check Use RemoteFX USB Redirection.

4. A new checkbox appears with the required device driver. Check to enable
the driver.

5. Click Save to apply.

NOTE: You also need to configure the host server and its guest OSs to enable
RemoteFX USB Redirection in a Remote Desktop session. For instructions
on server-side configuration, please visit Microsoft Support website at
support.microsoft.com.
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RD Gateway Sub-tab

NOTE

i)

- No options are available under the Options sub-tab in the connection type of
Web Logon.
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3.6.6 Configuring Basic ICA Connection Settings
The Citrix ICA setting allows you to configure ICA connections for Citrix services and create shortcuts on the local

desktop and START menu for service access. You can access virtual desktops and applications for work simply
through these shortcuts.

NOTE

@I

« For more information on Citrix desktop virtualization solutions, please visit Citrix
website at www.citrix.com or Citrix Knowledge Center at support.citrix.com.

Six connection types are available:

Connection Type Description Page
Web Logon Select to access desktop/application services through a Web browser. 154
StoreFront Select to access desktop/application services through a StoreFront. 156

VDI-in-a-Box Select to access desktop services through VDI-in-a-Box. 158
XenDesktop Select to access desktop services through an earlier version of XenDesktop. 160
XenApp Select to access application services through an earlier version of XenApp. 162
Server Connection Select to access service delivery servers (XenApp servers only). 164
= NOTE
7

+ You can refer to the following table for Citrix products and recommended
connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon
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Connection Type: Web Logon
To quickly configure ICA connection settings for the Web Logon connection type, please do the following:
1. On Atrust Client Setup, click Applications > Citrix ICA.
2. The available ICA Connection list appears in the Configuration area.
® Atrust Client Setup Lalloullollies

Atru'—'-'t Applications User Interface Devices Network System

Sessions Global

. Remote Desktop

_ Citrix ICA + Add — Delete
“WMware View

SSH Session Name  * Server Address Connection Type
- Web Browser

- Parallels 2 Client

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.



4. On General sub-tab, leave the connection type as Web Logon as default, and then type in the desired
session name and the IP address / URL / FQDN of the server through which Citrix services are accessible.
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Remote Desktop
- Citrix ICA

WMware \iew
S5H

Web Browser
Parallels 2X Client

Atrust Client Setup

Applications User Interface Devices Nework System
General Options
¢ Server Settings

Session Name: * | | =
Connection Type: |Web Logon j =
Server Address: * | | '

« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e

Save l | Cancel

i)

5. Click Save to add this ICA connection entry. The access shortcuts are automatically created on the local
desktop and START menu.

%é

NOTE

« For newer versions of XenDesktop and XenApp, you may need to further specify

the sub-path of the server. Refer to the following table for details:

Citrix Product

Component to
Connect

Connection Address

XenApp 6.5 or
earlier

Web Interface

IP / URL / FQDN

XenDesktop 5.6
or earlier

Web Interface

IP / URL / FQDN

XenApp and
XenDesktop 7.5

StoreFront

IP / URL / FQDN plus sub-path

For example —

FQDN: X75.CTX.poc

Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

- FQDN is the acronym of Fully Qualified Domain Name.

NOTE

- Depending on your plan of service delivery and the configuration of your server(s),

you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.
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Connection Type: StoreFront
To quickly configure ICA connection settings for the connection type of StoreFront, please do the following:

%\ NOTE

-4

« You can refer to the following table for Citrix products and recommended
connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

® Atrust Client Setup o=l
Atru'—'-'t Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA + Add — Delete
WMware \iew
S5H

Session Mame ¥ Server Address Connection Type
Web Browser

Parallels 2X Client

%‘ NOTE

—

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select StoreFront.

- Ladlodlzlled
® Atrust Client Setup Lalloulllallies
Atl'l.lSt Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings
VMware View Session Mame: [ | =
S5H
Web Browser Connection Type: [StoreFront hd 'S
- Parallels 2X Client
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group / Application: 'O_é) * | | e
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications/
desktops are accessible, and the name of desktop group or application.

NOTE

&

+ You can use the Search icon Qg to help you discover available desktop groups or
applications for a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.
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Connection Type: VDI-in-a-Box
To quickly configure ICA connection settings for the connection type of VDI-in-a-Box, please do the following:

%\ NOTE

-4

« You can refer to the following table for Citrix products and recommended
connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, Click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

® Atrust Client Setup o=l
Atru'—'-'t Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA + Add — Delete
WMware \iew
S5H

Session Mame ¥ Server Address Connection Type
Web Browser

Parallels 2X Client

%‘ NOTE

—

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select VDI-in-a-Box.

- Ladlodlzlled
® Atrust Client Setup Lalloulllallies
Atl'l.lSt Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings
VMware View Session Mame: * | | =
SSH
Web Browser Connection Type: [VDHin-a-Box hd 'S
Parallels 2X Client
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group: ':Q_é) * | | B
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the name of the desktop group.

=) NOTE
i
+ You can use the Search icon QQ’ to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.
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Connection Type: XenDesktop
To quickly configure ICA connection settings for the connection type of XenDesktop, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

i)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

® Atrust Client Setup o=l
Atru'—'-'t Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop

_ Citrix ICA + Add — Delete

55H Session Mame ¥ Server Address Connection Type
- Web Browser

" Parallels 2X Client

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenDesktop.

- Ladlodlzlled
® Atrust Client Setup Lalloulllallies
Atl'l.lSt Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix [CA - Server Settings
- WMware View Session Mame: [ | =
SSH
- Web Browser Connection Type: [¥enDesktop hd 'S
“Parallels 2X Client
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Desktop Group: ':Q_é) * | &
« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual desktops are
accessible, and the desired desktop group.

=) NOTE

bl

+ You can use the Search icon Q‘% to help you discover available desktop groups for
a given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

NOTE

« Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.

=
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Connection Type: XenApp
To quickly configure ICA connection settings for the connection type of XenApp, please do the following:

NOTE

« You can refer to the following table for Citrix products and recommended
connection types:

i)

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon
VDI-in-a-Box VDI-in-a-Box / Web Logon

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

® Atrust Client Setup o=l
Atru'—'-'t Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop

_ Citrix ICA + Add — Delete

55H Session Mame ¥ Server Address Connection Type
- Web Browser

" Parallels 2X Client

NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

&

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.
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4. On General sub-tab, click the Connection Type drop-down menu to select XenApp.

- Ladlodlzlled
® Atrust Client Setup Lalloulllallies
Atl'l.lSt Applications User Interface Devices Network System
General Options
- Remote Desktop
Citrix ICA ¢ Server Settings
- WMware View Session Mame: [ | =
SSH
- Web Browser Connection Type: [xenapp hd 'S
“Parallels 2X Client
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Application Name: 'O_é) * | | B
« Common Settings
Autostart When Startup: | No e
on Application Exit: |DU Nothing e
Manual Parameters: [ | e
Save l | Cancel

5. Type the session name, the IP address / URL / FQDN of the server through which virtual applications are
accessible, and the desired application name.

=) NOTE
=
+ You may need to provide the XML port number as well for your server address
(for example, XA65P.CTX.poc:8080), depending on your server-side configuration.
=) NOTE
= N

+ You can use the Search icon O% to help you discover available applications for a
given set of credentials.

6. Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and
START menu.

Z/ NOTE
- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.
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Connection Type: Server Connection
To quickly configure ICA connection settings for the connection type of Server Connection, please do the following:

5/ NOTE

- This connection type is used to connect to XenApp server for administration and
supports only XenApp 6.5 and earlier.

1. On Atrust Client Setup, click Applications > Citrix ICA.

2. The available ICA Connection list appears in the Configuration area.

. A
® Atrust Client Setup Lalloullollies

Atru'—'-'t Applications User Interface Devices Network System

Sessions Global

- Remote Desktop

_ Citrix ICA + Add — Delete
“WMware View

SSH Session Name  * Server Address Connection Type
- Web Browser

- Parallels 2X Client

%J‘ NOTE

- If you haven't created any entry, the ICA Connection list will be empty.

3. Click Add on the top of the ICA Connection list to create a new entry of ICA connection.



4. On General sub-tab, click the Connection Type drop-down menu to select Server Connection.

Atrust

‘Web Browser
- Parallels 2X Client
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- Ladlodlzlled
® Atrust Client Setup Lalloulllallies
Applications User Interface Devices Nework System
General Options
¢ Server Settings
Session Mame: L | =
Connection Type: [server connection =] e
Server Address: | | e
Username: | | =
Password: [ | e
Domain: | | =
Server Name: 'O_é) | | B
« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |DU Nothing e
Save l | Cancel

5. Type the session name, server address, and server name.

NOTE

(allt]

- You may need to provide the XML port number as well for your server address
(for example, 192.168.77.10:8080), depending on your server-side configuration.

% NOTE

+ Only connections to XenApp servers are supported by this connection type.

+ You can use the Search icon O% to help you detect the server name.

START menu.

%J NOTE

Click Save to confirm. The customized access shortcuts are automatically created on the local desktop and

- Depending on your plan of service delivery and the configuration of your server(s),
you may need to configure other advanced ICA connection settings for service
access. For more information on other available settings, please refer to section
“3.6.11 Configuring Advanced ICA Connection Settings” on page 176.
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3.6.7 Switching the Citrix Receiver Version

Two versions of Citrix Receiver are switchable in case that an older version of Citrix Receiver is required for your
Citrix environment.

To change the version of Citrix Receiver, please do the following:

NOTE

i

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select the desired Citrix Receiver version. Two options are available:
12.x and 13.x.

Atrust Client Setup

Atl'l.lSt Applications User Interface Devices Network System
Sessions Global
- Remote Desktop
Citrix [CA - Common Settings
“WMware View o . .
-55H Citrix Receiver Version: |13.x -l &
- Web Browser ] .
" parallels 2x Client Use Esc to quit Web Logon: |\"es -
Keyboard Layout Depends on: |L0ca| - o
Keyboard Type: |Default ME -
Input Language: |Default M
Session Reliability: |Disab|ed M
* The change to the used Receiver version will affect all sessions.
*All current Citrix sessions will be disconnected after switching the Receiver version.

Save Cancel

<\/ TIP

« The default Citrix Receiver version is 13.x.

+ You can refer to the following table for Citrix products and recommended Citrix
Receiver version:

Citrix Product Recommended Receiver Version
XenApp earlier than 6.5 12.x
XenDesktop earlier than 5.6 12.x
XenApp / XenDesktop 7.x or later 13.x

3. Click Save to apply.
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3.6.8 Enabling or Disabling Esc to Quit on the Web Logon Screen
You can choose whether to allow the use of Esc key to quit the Web Logon screen:
- If Yes is selected, you can use both Esc and Alt + F4 to quit the Web Logon screen.

- If Nois selected, only Alt + F4 works.

To enable or disable Esc to Quit on the Web Logon screen, please do the following:

NOTE

Ml

- This is a global setting; the change will affect all Citrix connections.

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click the drop-down menu to select Yes or No to enable or disable Esc to Quit.

{ Atrust Client Setup Lol LELILG:
Atru'—'_'t Applications User Interface Devices Network System
Sessions Global
mote Desktop
Citrix [CA - Common Settings

“WMware View o . .

L S5H Citrix Receiver Version: |13.x j =

~Web Browser

arallels 2X Client Use Esc to quit Web Logon: |\"es j -

Keyboard Layout Depends on: |Loca| j e
Keyboard Type: |Default j B
Input Language: |Default j =
Session Reliability: |Disab|ed j [
* The change to the used Receiver version will affect all sessions.
*Alf current Citrix sessions will be disconnected affer switching the Receiver version.

Save Cancel

3. Click Save to apply.
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3.6.9 Configuring Keyboard Layout and Type for Citrix ICA Sessions

To set the used keyboard layout and type for all Citrix ICA sessions, please do the following:

1. On Atrust Client Setup, click Applications > Citrix ICA > Global.

2. Click drop-down menus to select what determines the keyboard layout and the desired keyboard type.

® Lol

L Atrust Client Setup N =N | W= B
Atl'l.lSt Applications User Interface Devices Network System
Navigator Sessions Global
- Remote Desktop
Citrix ICA - Common Settings
“WMware View
~S5H Citrix Receiver Version: |13,>< j =
Web Browser i .
- Parallels 2X Client Use Esc to quit Web Logon: |Yes j -
Keyboard Layout Depends on: |Loca| j e
Keyboard Type: |Default j [
Input Language: |Default j =
Session Reliability: |Disab|ed j B
*The change fo the used Receiver version will affect all sessions.
*All current Citrix sessions will be disconnected affer switching the Receiver version.

Save Cancel

i'/ NOTE

« These are global settings; the changes will affect all ICA sessions.

3. Click Save to apply.



Configuring Client Settings | 169

Configuring Service Access Settings

3.6.10 Accessing Citrix Services

For Connection Types of StoreFront, VDI-in-a-Box, XenDesktop, XenApp, and Server Connection
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop, and then provide your credentials if needed.

2. The desired desktop or application will be displayed on the screen.

For Connection Type of Web Logon
To access Citrix services, please do the following:

1. Double click the created (customized) shortcut on the desktop.

2. The Web browser is launched in full-screen with the Citrix Logon screen.

Citrix Logon Screen Example: XenApp 6.0 Fundamentals

Citrix Logon Screen Example: XenApp 6.5 Platinum

& cmpx

Citrix XenApp

Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX' [o%]
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Citrix Logon Screen Example: XenDesktop 5.6 Platinum

a ..
i CITRIX

Citrix XenDesktop

‘Your Windows desktops and apps on demand - from any PC, Mac, smartphone or tablet.

CITRIX" [0x]

Citrix Logon Screen Example: VDI-in-a-Box

Citrix Receiver
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Citrix Logon Screen Example: XenApp and XenDesktop 7.5 Platinum

Citrix Receiver

3. Type in the required credentials, and then click Log On.

=)) NOTE

- If your XenApp server doesn’t belong to any domain, type in the server name in the
Domain field instead.

al
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4. On the Desktop or Application Selection screen, click to select the desired desktop or application(s).

@ NOTE

+ You might enter the virtual desktop directly if only one type of virtual desktop is
assigned to the provided credentials.

Selection Screen Example: XenApp 6.5 Platinum

Lompon - 2,8 dmx

= e
<) = &

Notepad POF Reader X PP Viewer 2007

Hint: ik D 10 pause any runming

Selection Screen Example: XenDesktop 5.6 Platinum

CITRIX'

&
LogOtf

W7Ue WS2KBR2e
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Selection Screen Example: XenApp 7.5 Platinum

Selection Screen Example: XenDesktop 7.5 Platinum
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5. The selected virtual desktop or application(s) will be displayed on the screen.

Virtual Application Examples
PowerPoint Viewer, Adobe Reader, and Notepad

Logpeon secrcs

Il

File Edt View Window Help
Dl

RAFBEX |

Tools i Sign i Comment

ADOBE' READER X

Open a Recent File Acrobat.com Services

Open. @ CreatePDF Online
] Convert PDF to Word or Exce Online
% Share Files Using Sendiow Online

@ Get Documents Signed

i [Fowmens 5] @3 2@

Hame -+ || Date modfied || Type 1=
N items fatch your search,

wur PDF File:

Jey Note and Highlighter
ments to your FOF

gl | o

Fi name: 2 Dpen

Files o type: FowerPaint Presertalions ~ E=)
%

Virtual Application Examples
Adobe Reader, Mozilla Firefox, and PowerPoint Viewer

CitrixReceiver

@ MosilaFifocstartPage % |

Vindow_Help

poaments G B @ @ [ & =2

Search

Open a Recent File
& W Computer.

2 Aobatcom

T

[PonerPort Fresetans.
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Virtual Desktop Example
Windows 7 Ultimate

Welcome to your Citrix XenDesktop

Any Device

Access is easyfrom any PG,
Wac, smartphone or tablet
The choice s yours.

Welcome to the virtual workstyle -

Your desktop, apps and documents at your fingertips o e it =Rt

top, and the freedom to do whatever, whenever, graphics over any network,
XenDeskiop including Wi-Fi or 3

S ) B35
2O

Virtual Desktop Example
Windows Server 2008 R2

)

=l
/|




176 | Configuring Client Settings
Configuring Service Access Settings

3.6.11 Configuring Advanced ICA Connection Settings

The tables below provide a description of each setting item for ICA connections. Please refer to these tables to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

—=)) NOTE
w/f
« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Web Logon

=) NOTE
7
- For descriptions of available settings for the connection type of StoreFront, please
refer to “Settings for the Connection Type of StoreFront” on page 180.

- For descriptions of available settings for the connection type of VDI-in-a-Box, please
refer to “Settings for the Connection Type of VDI-in-a-Box” on page 185.

- For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 190.

« For descriptions of settings for the connection type of XenApp, please
refer to “Settings for the Connection Type of XenApp” on page 195.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 200.
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Server Settings

Item

Description

Session Name

Type in the name of browser sessions for Citrix service access.

Connection Type

This table only provides descriptions for available settings when Web Logon
is selected.

Six connection types are available:

Option Description
Web Logon Provides access to virtual desktops and applications

9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications

through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.

Provides access to virtual applications for an earlier
XenApp h

version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Server Address

Type in the IP address / URL / FQDN of the server through which Citrix services
are accessible.

Refer to the table below for details:

Component to

Connect Connection Address

Citrix Product

XenApp 6.5 or

carlier Web Interface IP / URL / FQDN

XenDesktop 5.6

or earlier Web Interface IP / URL / FQDN

IP / URL / FQDN plus sub-path

For example —

StoreFront FQDN: X75.CTX.poc
Sub-path: /Citrix/StoreWeb (default)
Connection Address:
X75.CTX.poc/Citrix/StoreWeb

XenApp and
XenDesktop 7.5
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Common Settings

Item

Description

Autostart When Startup

Select whether to open a browser session for Citrix service access automatically
or not when your mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a browser session for Citrix service access is ended.
Four options are available: Do Nothing, Restart Application, Reboot, and
Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens a browser session again for service access.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB
drive(s) and to select access type in a Citrix ICA session. Three options are
available: No, Read Only, and Read Write. If Read Only or Read Write is
selected, the locally attached USB drive(s) will become available in launched
Citrix ICA sessions.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial
device(s) in a Citrix ICA session. If Yes is selected, the locally attached serial
device(s) will become available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s)
in a Citrix ICA session. If Yes is selected, the locally attached printer(s) will
become available in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 58 for detailed instructions on these similar settings.
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Settings for the Connection Type of StoreFront

=) NOTE

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 176.

- For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 185.

- For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 190.

- For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 195.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 200.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when StoreFront
is selected.

Six connection types are available:

Option Description

Provides access to virtual desktops and applications

Web Logon through the interface of a Web browser (Mozilla Firefox).

Provides access to virtual desktops and applications

Storefront through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
or applications are accessible (where a StoreFront is hosted).

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group / Application

Type in the name of the desktop group / application or use the Search icon "‘Qxx,
in front of the field to discover available desktop groups / applications.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Options Sub-tab

Window Settings

Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.

Click the drop-down menu to select the desired window size of a Citrix ICA

Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.

. Click the drop-down menu to select the desired window mode. Two options are
Window Mode

available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @a moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on

page 58 for detailed instructions

on these similar settings.
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Settings for the Connection Type of VDI-in-a-Box

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 176.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 180.

For descriptions of settings for the connection type of XenDesktop, please refer to
“Settings for the Connection Type of XenDesktop” on page 190.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 195.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 200.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when VDI-in-a-Box

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group / Application

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.

187



188

Configuring Client Settings
Configuring Service Access Settings

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 58 for detailed instructions on these similar settings.

189



190| Configuring Client Settings

Configuring Service Access Settings

Settings for the Connection Type of XenDesktop

=) NOTE

- For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 176.

- For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 180.

- For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 185.

- For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 195.

- For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 200.

General Sub-tab

Server Settings

Item Description

Session Name Type in the name for Citrix ICA sessions.

This table only provides descriptions for available settings when XenDesktop is
selected.

Six connection types are available:

Option Description

Provides access to virtual desktops and applications

Web Logon through the interface of a Web browser (Mozilla Firefox).

Provides access to virtual desktops and applications

Storefront through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.
. Provides access to virtual applications for an earlier
Connection Type XenApp version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon
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Server Address

Type in the IP address / URL / FQDN of the server through which virtual desktops
are accessible (where a Web Interface is hosted).

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Desktop Group

Type in the name of the desktop group or use the Search icon O\g in front of the
field to discover available desktop groups.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on

page 58 for detailed instructions

on these similar settings.
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General Sub-tab

NOTE
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For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 176.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 180.

For descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 185.

For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 190.

For descriptions of settings for the connection type of Server Connection, please
refer to “Settings for the Connection Type of Server Connection” on page 200.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

is selected.

This table only provides descriptions for available settings when XenApp

Six connection types are available:

Option Description
Web Loaon Provides access to virtual desktops and applications
9 through the interface of a Web browser (Mozilla Firefox).
StoreFront Provides access to virtual desktops and applications
through a StoreFront.
VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.
Provides access to virtual desktops for an earlier version
XenDesktop
of XenDesktop.
Provides access to virtual applications for an earlier
XenApp .
version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Refer to the table below for Citrix products and recommended connection types:

Citrix Product

Recommended Connection Type

XenApp 6.5 or earlier XenApp / Web Logon

XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box

VDI-in-a-Box / Web Logon
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Server Address Type in the IP address / URL / FQDN of a XenApp server.

Username Type in the user/account name used for authentication.

Password Type in the password of the user account used for authentication.

Domain Type in the domain of the server.

Application Name Type in the application name or use the Search icon O\g in front of the field to
discover available applications.

Common Settings

Item Description

Select whether to open a Citrix ICA session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance
e Re-launching a new session

e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.

Manual Parameters

Type in parameters for extended parameter passing.

Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color quality for a Citrix ICA
session. Three options are available: 16 Bit, 24 Bit, and Automatic.

Window Size

This item is available only when Regular Window is selected.

Click the drop-down menu to select the desired window size of a Citrix ICA
session. Four options are available: Full Screen, 1280x1024, 1024x768, and
800x600.

Window Mode

Click the drop-down menu to select the desired window mode. Two options are
available: Regular Window and Seamless Window.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a delivered application.
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Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.

Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio

Check/Uncheck to enable/disable sound in an ICA session.
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Audio Quality

Click the drop-down menu to choose the desired sound quality in an ICA session.

Three options are available: High Quality, Medium Quality, and Low Quality.

Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where

bandwidth is plentiful and sound quality is
important.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 64Kbps, resulting
in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Low Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.

Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on
page 58 for detailed instructions on these similar settings.
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Settings for the Connection Type of Server Connection

General Sub-tab

NOTE

For descriptions of available settings for the connection type of Web Logon, please
refer to “Settings for the Connection Type of Web Logon” on page 176.

For descriptions of settings for the connection type of StoreFront, please refer to
“Settings for the Connection Type of StoreFront” on page 180.

Fore descriptions of settings for the connection type of VDI-in-a-Box, please refer to
“Settings for the Connection Type of VDI-in-a-Box” on page 185.

For descriptions of available settings for the connection type of XenDesktop, please
refer to “Settings for the Connection Type of XenDesktop” on page 190.

For descriptions of settings for the connection type of XenApp, please refer to
“Settings for the Connection Type of XenApp” on page 195.

Server Settings

Item

Description

Session Name

Type in the name for Citrix ICA sessions.

Connection Type

This table only provides descriptions for available settings when
Server Connection is selected.

Six connection types are available:

Option Description

Provides access to virtual desktops and applications

Web Logon through the interface of a Web browser (Mozilla Firefox).

Provides access to virtual desktops and applications

Storefront through a StoreFront.

VDI-in-a-Box Provides access to virtual desktops through VDI-in-a-Box.

Provides access to virtual desktops for an earlier version

XenDesktop of XenDesktop.

Provides access to virtual applications for an earlier
XenApp .

version of XenApp.
Server Provides access to servers for administration (XenApp
Connection servers only).

Citrix Product Recommended Connection Type
XenApp 6.5 or earlier XenApp / Web Logon
XenDesktop 5.6 or earlier XenDesktop / Web Logon

XenApp and XenDesktop 7.5 StoreFront / Web Logon

VDI-in-a-Box VDI-in-a-Box / Web Logon

Refer to the table below for Citrix products and recommended connection types:




Configuring Client Settings
Configuring Service Access Settings

Server Address

Type in the IP address / URL / FQDN of the XenApp server.

NOTE: Server Connection only supports connections to XenApp servers.

Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Domain Type in the domain of the server.

Server Name

Type in the name of the server.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a Citrix ICA session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired
Citrix ICA session and perform the configured
action after exiting the session.

Available actions include:

2 Autostart e Returning to the local desktop

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will enter Atrust Quick Connection

3 Quick Connection oo Sfter system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.
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On Application Exit

Select what to do when a Citrix ICA session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description

Do Nothing Returns to the Local Linux desktop.

Restart Application  Opens an ICA session again.

Reboot Restarts your thin client.
Shutdown Turns off your thin client.
Options Sub-tab
Window Settings
Item Description
Color Depth Click the drop-down menu to select the desired color quality for a Citrix ICA
P session. Three options are available: 16 Bit, 24 Bit, and Automatic.
Click the drop-down menu to select the desired window size of a Citrix ICA
Window Size session. Four options are available: Full Screen, 1280x1024, 1024x768, and

800x600.

Device Mapping

Item

Description

Mapping Local USB Storage

Click the drop-down menu to enable/disable the mapping of the local USB drive(s) in a
Citrix ICA session.

NOTE: You need to enable local USB storage drive(s) as well. See section “3.4.3
Configuring Settings for USB Storage Devices” on page 89 for details.

Mapping Local Serial Ports

Click the drop-down menu to enable/disable the mapping of the local serial device(s)
in a Citrix ICA session. If Yes is selected, the locally attached serial device(s) will become
available in launched Citrix ICA sessions.

NOTE: This setting item is not applicable to your mt188L. However, if you use a
serial-based barcode scanner, and attach it to your mt188L with a serial-
to-USB adapter, you need to enable this setting in order to use the local
barcode scanner in a virtual server desktop.

Mapping Local Printers

Click the drop-down menu to enable/disable the mapping of the local printer(s) in a
Citrix ICA session. If Yes is selected, the locally attached printer(s) will become available
in launched Citrix ICA sessions.

NOTE: To enable locally attached printer(s), please refer to section “3.4.7
Adding a Local Printer” on page 93 for detailed instructions.
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Connection Settings

Item

Description

Rendering Type

Click the drop-down menu to select resources rendering on the endpoint or the
server. Two options are available: Server Rendering and Client Rendering.

NOTE: The Client Rendering option may not be available on your system.

HDX RealTime WebCam

This item is available only when Client Rendering is selected.

When Yes is selected, a locally attached webcam can be used in an ICA session.

Use H264 Compression

Click to enable/disable H.264 compression support on the client, allowing session
data are sent from the server side using H.264 format encoding.

Network Protocol

Click the drop-down menu to select the protocol(s) used for connection. Three
options are available: TCP/IP, TCP/IP + HTTP server location, and
SSL/TLS + HTTPS server location.

Enable Automatic Reconnect

Check/Uncheck to enable/disable automatic reconnecting after an ICA session
was interrupted.

NOTE: Automatic reconnecting (Auto Client Reconnect) may not work for a
XenDesktop ICA session. This is a known issue. For more details, please
visit Citrix websites at support.citrix.com or www.citrix.com.

Number of Retries

Click the drop-down menu to select the number of retries, ranging from 1 to 10.

Delay between Retries

Click the drop-down menu to select the delay time between retries, ranging from
5 to 60 seconds.

Enable Audio Check/Uncheck to enable/disable sound in an ICA session.
Click the drop-down menu to choose the desired sound quality in an ICA session.
Three options are available: High Quality, Medium Quality, and Low Quality.
Option Description
Allows endpoint devices to play a sound
file at its native data transfer rate. This
High Quality is recommended for connections where
bandwidth is plentiful and sound quality is
important.
Compresses any sounds sent to endpoint
Audio Quality devices to a maximum of 64Kbps, resulting

in @ moderate decrease in the quality

of the sound. This option is suitable for
speeches and recommended for most LAN-
based connections.

Medium Quality

Compresses any sounds sent to endpoint
devices to a maximum of 16Kbps, resulting
in a significant decrease in the quality

Low Quality of the sound. This option is suitable for
low-bandwidth connections, allowing
reasonable audio performance during a
low-speed connection.

Enable Audio Input

Check/Uncheck to enable/disable audio input in an ICA session.
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Windows Key Combination

Click the drop-down menu to select where to apply Windows Key Combinations.
Three options are available: On the local computer, On the remote server,

and In full screen mode only.

Option

Description

On the local computer

Applies to the local desktop only.

On the remote server

Applies to the virtual desktop only.

In full screen mode only

Applies to the virtual desktop only when the
desktop is running in the full-screen mode.

USB Redirection Settings

Item

Description

USB Storage

Printers

Redirect Connected
USB Devices

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for Citrix ICA Sessions” on

page 58 for detailed instructions

on these similar settings.
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3.6.12 Configuring Basic VMware View Connection Settings

The VMware View setting enables you to configure View connection settings for VMware View or Horizon View
services and create shortcuts on the local desktop and START menu for service access. You can access on-demand
services for work simply through these shortcuts.

NOTE

« For more information on VMware desktop virtualization solutions, please visit
VMware website at www.vmware.com.

% :

To quickly configure VMware View connection settings, please do the following:

1. On Atrust Client Setup, click Applications > VMware View.

2. The View Connection list appears in the Configuration area.

- Ll ozl
® Atrust Client Setup N =N | W= B
Atrust Applications User Interface Derices Network System

| +add H -Delete]

-~ Remote Desktop
o CIErix ICA

VMware View
--55H
- Web Browser
- Parallels 2x Client

Session Name ¥ Connection Server

NOTE

- If you haven't created any entry, the View Connection list will be empty.

i

3. Click Add on the top of the View Connection list to add a new entry of View connection.
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e e [ e T
Atrust Client Setup | R R

Atl'l.lSt Applications User Interface Devices Network System
General Options SECUREMATRIX
- Server Settings ]
Mware View Session Name: Al =
-55H
Web Browser Connection Server: * | | e
-Parallels 2X Client
Port: [ | &
Use Secure Connection(SSL): |‘r‘es ;l B
Certificate checking mode: [warn before connecting to 1~ e
When Connection Ends: [Return to VMware Pool | [
- Login Settings
User Name: | | =
Password: | | e
Domain: | | =
Desktop [ Application Name: ‘Q‘g | | B
erify before Access: | No hd ' B
Preferred Display Protocaol: |Manua| hd 'S
- Common Settings )
| o= . A
Save l | Cancel

4. Type in the desired session name and the computer name or IP address of the View Connection Server, and
then click Save to confirm.

5‘/ NOTE

« These are the only required fields for the creation of a service access shortcut on the
desktop. Other data can be provided during the period of service access. Depending
on your needs, you might choose to type in more other data.

5. The new entry is added to the View Connection list and the access shortcuts are automatically created
on the local desktop and START menu.
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3.6.13 Accessing VMware View or Horizon View Services

To access VMware View or Horizon View services, please do the following:

1. Double click the created (customized) access shortcut on the desktop.

NOTE

- A window might appear with a certificate message about the remote server.
Consult the IT administrator for details and ensure the connection is secure first.
To import a security certificate, please refer to section “3.2.17 Importing Certificates
for Remote Computers” on page 68. To bypass, click Connect Insecurely.

= \

2. AWelcome window might appear. Click OK to continue.

3. A window appears prompting for the credentials. Enter your user name, password, click the Domain drop-
down menu to select the domain, and then click OK.

=) Server Login R |

vmware Horizon

Server: & bitps/AMCSVHVpoc

Username: |
Password:
Domain: WVHV v

Cancel Ol

4. A window appears with available desktops and/or applications for the provided credentials.

El VMware Horizon Client S W ISR
File Connection View Help

&% [ bitpsiMVCS VHVIpOC * ke

Acrobat Reader Calculator Mozilla Firefox Notepad Paint

SV T or ,
(S = - QJ”
Snipping Tool w7y WS08R2 Windows Media

Player

5. Double click to select the desired desktop or application.
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6. The selected desktop or application will be displayed on the screen.

NOTE

Wl

- Your desktop or application will be displayed in full screen. You can:

< Click File > Return to Desktop and Application List on the top tool bar to
recall the Desktop and Application list.

@ Connection * View ¥ Connect USB Device» Help~ | (O O X
< Disconnect from Server...
| Return to Desktop and Application List

{88 Preferences

] Quit

< Click View on the top tool bar to switch to a virtual desktop or application.

Eilev Connection = |View = [Help~ | [ @ X

) Windowed

® Full Screen - This Monitor

O Full Screen - All Monitors
Resize »

Show Favaorites
B Adobe Acrobat Reader DC
@ Firefox
-] Windows Calculator
|0 Windows Media Player
=wW7U
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3.6.14 Configuring Advanced View Connection Settings

The table below provides a description of each setting item for View connections. Please refer to this table to
configure advanced settings and customize shortcuts on the local desktop and START menu for service access.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for VMware View or Horizon View sessions.

Connection Server

Type in the computer name or IP address of the View Connection Server.

NOTE: For more information on View Connection Server, please visit VMware
website at www.vmware.com.

Port

Type in the port number used to communicate with the View Connection Server.
To use the default value, simply leave it blank.

Use secure connection (SSL)

Check/Uncheck to enable/disable secure connection.

Certificate Checking Mode

Click the drop-down menu to select if to check server identity certificates

and if to connect to untrusted servers. Three options are available: Do not
verify server identity certificates, Warn before connecting to untrusted
servers, and Never connect to untrusted servers.

When Connection Ends

Click the drop-down menu to select what to do when the connection ends. Two
options are available: Return to VMware Pool and Quit VMware Client.

Option Description

When the connection ends, return to the Desktop

Return to VMware Pool and Application list for given credentials.

When the connection ends, close VMware Client.
Quit VMware Client To access virtual desktops and applications, you
need to provide the credentials again.

Login Settings

Item Description

Username Type in the user name for authentication.

Password Type in the password for authentication.

Domain Type in the domain name of the View Connection Server.

Desktop / Application Name

Type in the desktop / application name. Or, leave it blank for users to select one.

NOTE: You can use the Search icon O\g: to help you discover available desktops
or applications for a given set of credentials.
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Verify before Access

Click the drop-down menu to select whether to verify the entitlement to the

virtual desktop

or application provided in the previous setting item:

Option Description
Verify the entitlement to the virtual desktop or application
Yes provided in the previous setting item. Stop if the given
credentials do not pass this verification.
If the given credentials are not entitled to the virtual
No desktop or application provided in the previous setting

item, just ignore that error and provide the Desktop and
Application list available for that credentials.

Preferred Display Protocol

Click the drop-down menu to select the desired display protocol. Three options
are available: Manual, Microsoft RDP, and PCoIP.

Option

Description

Manual

Manually select the desired display protocol.

Microsoft RDP

Use Microsoft RDP as the display protocol.

PCoIP

Use VMware PColIP as the display protocol.

Common Settings

Item

Description

Non-Interactive Mode

Select Yes or No to allow or disallow the Non-Interactive mode. The default is to
use the Non-Interactive mode.

Option Description
The Non-Interactive mode is used. Users are not allowed to
Yes re-select different settings if the settings have been specified
in View connection settings.
The Interactive mode is used. Users are allowed to
No re-select different settings even if the settings have been

specified in View connection settings.
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Autostart When Startup

Select whether to open a VMware View or Horizon View session automatically or
not when your mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode

Description

1 Appliance

The client will start up directly with the desired
VMware View session and perform the configured
action after exiting the session.

Available actions include:

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

2 Autostart

The client will start up directly with the desired
VMware View or Horizon View session and perform
the configured action after exiting the session.

Available actions include:

e Returning to the local desktop
e Re-launching a new session

e Restarting the thin client

e Turning off the thin client

3 Quick Connection

The client will enter Atrust Quick Connection
screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when a VMware View or Horizon View session is ended.
Four options are available: Do Nothing, Restart Application, Reboot,

and Shutdown.

Option Description

Do Nothing Returns to the local desktop.

Restart Application Opens a VMware View or Horizon View session again.

Reboot Restarts your thin client.

Shutdown Turns off your thin client.
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Options Sub-tab

Window Settings

Item Description
Click the drop-down menu to select the desired display size of a View session.
Three options are available: Full Screen, Large Window, and Small Window.
Option Description
Resolution Full Screen Opens the selected View session in full screen.

Large Window  Opens the selected View session in a large window.

Small Window  Opens the selected View session in a small window.

USB Redirection Settings

Item

Description

Mass Storage

Smart Card

Human Interface Device

Printer

Plugged USB Devices

Redirection Rules

Please refer to "Advanced Quick Connection Settings for VMware View Sessions”
on page 60 for detailed instructions on these similar settings.

Microsoft RDP Protocol Only

Item

Description

Printer Mapping

Click the drop-down menu to enable/disable printer mapping when RDP protocol
is used for VMware View connections.

When Enable is selected, users can access a local or network printer in a virtual
desktop session.

NOTE: You need to add a local or network printer for your mt188L first, and then
enable this feature here to use that printer in a virtual desktop session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt188L, please refer to section “3.4.7 Adding a Local Printer” on page
93 or “3.4.8 Adding a Network Printer” on page 96.
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Connection Settings

Item

Description

Use SECUREMATRIX

Check to use SECUREMATRIX authentication.

GSB Server Address

Type the server address of GSB server, the server for SECUREMATRIX
authentication service.

Username

Type your user name (Login ID).

(]

NOTE

- For details, please refer to “A.3 Using SECUREMATRIX Authentication for VMware
Connections” on page 244.
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3.6.15 Configuring SSH Connection Settings

To configure SSH (Secure SHell) connection settings, please do the following:

1. On Atrust Client Setup, click Applications > SSH.

2. The SSH Connection list appears in the Configuration area.

o Ladl Jlellsad
® Atrust Client Setup N =N | W= B
Atrust Applications User Interface Derices Network System
U ) -
-~ Remote Desktop ] v ]
- Cltrix ICA Session Name Server Address Connection Type
- WMware View

- S5H
- Web Browser
- Parallels 2X Client

5/ NOTE

- If you haven't created any entry, the SSH Connection list will be empty.

3. Click Add on the top of the SSH Connection list to add a new entry of SSH connection.
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- SR
® Atrust Client Setup N =N | W= B
l\l:l'l.lSl: Applications User Interface Devices Network System
- Remote Desktop
< Citrix ICA - Server Settings .
~\WMware View Session Name: il | &
S5H .
- Web Browser Connection Server: * | | e
- Parallels 2 Client -
Connection Type: [ssH M
Port: [22 | &
Username: * | | h
Save H Cancel

Click the drop-down menu to select the desired connection type. Two types are available: SSH and Telnet.

Type in the desired session name, the computer name or IP address of the remote server, the user name, and
then click Save to confirm.

The new entry is added to the SSH Connection list and the access shortcuts are automatically created
on the local desktop and START menu.

- TP
® Atrust Client Setup TN =N W=
Atrust Applications User Interface

ST ) -]

- Remote Desktop

Devices Network System

Citrix ICA Session Name * Server Address Connection Type
WMware View U IsCA bbs.iscabbs.com Telnet
B BRI _
o 1SCA
" SDF

- Web Browser
- Parallels 2X Client
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3.6.16 Launching SSH and Telnet Sessions

To launch an SSH or Telnet session, please do the following:

1. Double click the created shortcut on the local desktop.

2. The SSH or Telnet session starts in the opened window.

Example: SSH Session

Terminal

Eile Edit View Terminal Geo Help

lelcome to the
You are the 11

[30-Jun-14 20:12:16
% full time

Example: Telnet Session

L= Terminal oo O

Eile Edit \iew Terminal Go Help

Own version of Citadel)

Welcome to the I . BBS.

Login as 'Guest' to just look around, or 'bh to create & new account.

lable to you, type <?>
e <l>
in depth, type <h> to enter the

account here,
in mind.
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3.6.17 Configuring Basic Settings for Browser Sessions
To configure basic settings for a browser session, please do the following:

1. On Atrust Client Setup, click Applications > Web Browser.

2. The Web Page Access list appears in the Configuration area.

- Ll ozl
® Atrust Client Setup N =N | W= B

Atl'l.lSt Applications User Interface Devices Network System

-~ Remote Desktop

o Cltrix ICA + Add — Delete
“WMware View
- 55H -

Web Browser Session Name URL

- Parallels 2X Client

5/ NOTE

- If you haven't created any entry, the Web Page Access list will be empty.

3. Click Add on the top of the Web Page Access list to add a new entry.
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4. Type in the desired session name, the URL of the web page, and then click Save to confirm.

S T T A T G
® Atrust Client Setup 40| R R
Atl'l.ISt Applications User Interface Devices Network System
- Remote Desktop
- Citris ICA - Basic Settings
WVMware View
-SSH
_ _
" Parallels 2X Client Session Mame: * || | E
Initial Page: * | h

« Common Settings

Autostart When Startup: No -] .‘

Save l | Cancel

5. The new entry is added to the Web Page Access list and the access shortcuts are automatically created
on the local desktop and START menu.

e | | L ]
® Atrust Client Setup Lalloulllallies
Atl'l.ISt Applications User Interface

Devices Network System

- Remote Desktop

Citrir ICA + Add = Delete
WVMware View
“5SH -
LU LA T :
¢ e Gmail . iGmail www. google.com/gmail/

" Parallels 2X Client
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3.6.18 Launching Browser Sessions

To launch a browser session, please do the following:

1. Double click the created shortcut on the local desktop or START menu.

2. The session starts in the opened browser.

Example: Gmail Login Session

/& Gmail

Ix \ &

« ) @ https://accounts.googl

viceLogin?service=mail ontinus P google.com/mail ¥ &|[Q search

lwe 9 ¢ A ® =

Google

One account. All of Google.

Sign in to continue to Gmail

Enter your email

Find my account

Create account

One Google Account for everything Google
GMmROLH e

B English (United States) |~
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3.6.19 Configuring Advanced Settings for Browser Sessions

The tables below provide a description of each setting item for browser sessions. Please refer to these tables to
configure advanced settings and customize for Web access.

General Sub-tab

Common Settings

Item

Description

Session Name

Type in the name for browser sessions.

Initial Page

Type in the URL of the Web page.

Common Settings

Item

Description

Autostart When Startup

Select whether to open a browser session automatically or not when your
mt188L is started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
browser session and perform the configured action
after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The client will start up directly with the desired

2 Autostart -
browser session.

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Global Sub-tab

Common Settings

Item

Description

Home Page

Set the desired home page for the web browser.
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3.6.20 Configuring Basic RAS / RDP Connection Settings

The Parallels 2X Client setting allows you to configure RAS / RDP connection settings and create shortcuts on the
local desktop and START menu for service access. You can access remote desktops or applications for work simply
through these shortcuts.

NOTE

« For more information on RAS (Remote Application Server) and RDP (Remote
Desktop Protocol), please visit Parallels website at www.parallels.com.

(W)

Two connection types are available:

Connection Type Description Page

Select to access remote desktops and applications via Parallels

Remote Application Server. i

Parallels Remote Applicaton Server

Select to access remote desktops via standard Microsoft Remote

Standard RDP Desktop Services.
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Connection Type: Parallels Remote Application Server
To quickly configure RAS connection settings for this connection type, please do the following:

1. On Atrust Client Setup, Click Applications > Parallels 2X Client.
2. The RAS /RDP Connection list appears in the Configuration area.

Atru'—'-'t Applications User Interface Devices Network System

Navigator | + Add H = Delete |

- Remote Desktop
o Citrik ICA

S WMware View
-SSH

- Web Browser

Parallels 2X Client

Session Name *  Server Address Connection Type

%J‘ NOTE

+ If you haven't created any entry, the RAS / RDP Connection list will be empty.

3. Click Add on the top of the RAS / RDP Connection list to create a new entry of RAS connection.
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Atl'l.lSt Applications User Interface Devices Network System
Remote Desktop
- Citrix ICA - Server Settings
WMware View Session Name: * &
-S5H "
" Web Browser Primary Server: * \ ||_
Parallels 2X Client Secondary Server: \ ||_
Connection Type: \ Parallels Remote Applicatior ;l e
Connection Mode: \ Gateway Mode ;l '
Port: *[80 &
- Login Settings
Username: [ | =
Password: [ | e
Domain: | | =
« Common Settings
Autostart When Startup: |N0 e
on Application Exit: |Do MNothing e
Save l | Cancel

On General sub-tab, ensure that Parallels Remote Application Server is selected for the connection type,
type in the session name and the primary server address under the Server Settings section.

Click Save to confirm.

The new entry is added to the RAS / RDP Connection list and the access shortcuts are automatically created
on the local desktop and START menu.

Atl'l.lSt Applications User Interface Devices Network System

TR < (oo
. _Eﬁ??fltgADESkt‘jp Session Name * Server Address Connection Type

WMware View P2X-RAS-G 192,168.0.10 Parallels Remote Application Server
-SSH

Web Browser

Parallels 2X Client

- P2X-RAS-G
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Connection Type: Standard RDP
To quickly configure RDP connection settings for this connection type, please do the following:

1. On Atrust Client Setup, Click Applications > Parallels 2X Client.
2. The RAS /RDP Connection list appears in the Configuration area.

Atru'—'-'t Applications User Interface Devices Network System

Navigator | + Add H = Delete |

- Remote Desktop
o Citrik ICA

S WMware View
-SSH

- Web Browser

Parallels 2X Client

Session Name *  Server Address Connection Type

%J‘ NOTE

+ If you haven't created any entry, the RAS / RDP Connection list will be empty.

3. Click Add on the top of the RAS / RDP Connection list to create a new entry of RDP connection.
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Atrust

Navigator

- Remote Desktop
- Citrise ICA
“WMware View

- SSH

- Web Browser

" Parallels 2X Client

Applications User Interface Devices Network System
General Options

¢ Server Settings )
Session Name: *\ ||_
Primary Server: 4 ||‘
Connection Type: \ Standard RDP hd h
Network Level Authentication: [Enabled e
Port: +[3389 &

- Login Settings )
Username: | | =
Password: | | I-.
Domain: [ | &

« Common Settings
Autostart When Startup: |N0 i I-.
on Application Exit: |D0 MNothing i I-.
Save l | Cancel

On General sub-tab, ensure that Standard RDP is selected for the connection type, type in the session name

and the primary server address under the Server Settings section.

Click Save to confirm.

The new entry is added to the RAS / RDP Connection list and the access shortcuts are automatically created
on the local desktop and START menu.

Atrust

Applications

User Interface

CETE

+ Add ]| - Delste |

- Remote Desktop
- Citrix ICA
~WMware View
~55H

- Web Browser

arallels 2X Client

- P2X-RDP-G

Session Name
P2X-RDP-G

* Server Address
192.168.0.11

Devices Network

Connection Type
Standard RDP
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3.6.21 Accessing Remote Desktops or Applications

Connection Type: Parallels Remote Application Server
To access remote desktops or applications, please do the following:

1. Double click the created shortcut on the desktop.

2. On the opened window, provide your credentials as required, and then click OK.

User * [ ]
Password * [ ]
Domain [ ]

3. A window appears with available applications and desktops.

culator

<4 Paint
Wordpad

- ¥ Windows Server 2012 R2 Data...

Connect H Cancel

4. Click to select the desired application or desktop, and then click Connect to confirm.

5. The application or desktop will be displayed on the screen.

Document - WordPad

blect

L]

Home  View

8@ oalid @7 = M L“‘l:‘{..} }Il:l "
Clipboard Image g # Q [Bushes| shapes sze | Color | Color i it i T Eat
i s il * B OODOOO0000 e

T

Calculator
- paint

= ST % & Wordpad
L Calculator [ = 8 Windows Server 2012 R2 Data..

10 1152 % 648px

1 Untitled - Paint

WordPad [® PRAS.G @ [Terminal - user@at... | us O « 5

-
|0 catcuator & Document -
D
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=8 Windows Server 2012R2

—)) NOTE
« The desktop will be displayed in full screen.

al

Connection Type: Standard RDP
To access remote desktops, please do the following:

1. Double click the created shortcut on the desktop.

2. On the opened window, provide your credentials as required, and then click OK.

Althentication

User ©
Password *
Domain

3. The desktop will be displayed in full screen.
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3.6.22 Configuring Advanced RAS / RDP Connection Settings

The tables below provide a description of each setting item for RAS / RDP connections. Please refer to these tables
to configure advanced settings and customize shortcuts on local desktop and START menu for service access.

NOTE

(]

« Please note that available settings vary with the selected connection type.

Settings for the Connection Type of Parallels Remote Application Server

= NOTE
7
- For descriptions of settings for the connection type of Standard RDP, please see
“Settings for the Connection Type of Standard RDP” on page 234.

General Sub-tab

Server Settings

Item Description
Session Name Type in the name for RAS (Remote Application Server) sessions.

; Type in the computer name or IP address of the server through which to deliver
Primary Server

an RAS session.

Type in the 2nd computer name or IP address of the server (if available) in case
Secondary Server . . . -
that the primary server fails to deliver a session.

This table only provides descriptions for available settings when Parallels
Remote Application Server is selected.

Two connection types are available:

Option Description

Connection Type .
Parallels Remote Select to access remote desktops and applications
Application Server via Parallels Remote Application Server.
Standard RDP Select to access remote desktops via standard

Microsoft Remote Desktop Services.
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Connection Mode

Click the drop-down menu to select the desired connection mode. Four options
are available:

Option Description

Connected with the RAS (Remote Application Server)
Secure Client Gateway and data tunneled through the
first available connection.
Gateway Mode NOTE: This mode is ideal for servers which are only
reachable via the gateway and do not require a
high level of security.

First connected to the RAS (Remote Application Server)
Secure Client Gateway for the best available Server
and then connected directly with that particular Server.
Direct Mode
NOTE: This is best used when the client and the server
are on the same network.

Connected with the RAS (Remote Application Server)
Gateway SSL Mode  Secure Client Gateway securely and data encypted and
tunneled through the first available connection.

First connected to the RAS (Remote Application Server)
Secure Client Gateway using SSL for the best available
server and then connect directly with that particular
Server.
Direct SSL Mode
NOTE: This is best when the client and the server
are on the same network and high security
safeguardsare required.

Port

The port used by default will be given automatically after you select a connection
type and mode. Type a different one if needed.

Login Settings

Item Description
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Type in the domain of the server.
Domain NOTE: Domain is a collection of computers on a network that share a common

database and security policy. Leave this field blank if the server doesn’t
belong to any domain.
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Common Settings

Item Description

Select whether to open an RAS session automatically or not when mt188L is
started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description

The client will start up directly with the desired
RAS session and perform the configured action
after exiting the session.

Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client
Autostart When Startup

The client will start up directly with the desired
RAS session and perform the configured action
after exiting the session.

Available actions include:

2 Autostart e not to do anything

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

The default. The client will enter Atrust Quick

3 Quick Connection Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

Select what to do when a Parallel 2X session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option Description
o ) Do Nothing Not to do anything.
On Application Exit
Restart Application Launches an RAS session again.
Reboot Restarts your mt188L.

Shutdown Turns off your mt188L.
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Window Settings

Item Description
Click the drop-down menu to select the desired color depth for an RAS session.
Five options are available: 8 Bit, 15 Bit, 16 Bit, 24 Bit, and 32 Bit.
NOTE: If RemoteFX is enabled in Graphics Acceleration, only 32 bit per pixel
Color Depth could be selected here.

NOTE: You can configure the upper limit of the color depth for an RAS session
on the host server. In this case, no matter which color depth you choose
here, the value cannot exceed the defined limit.

Graphics Acceleration

Click the drop-down menu to set graphics acceleration. Three options are
available: None, Basic, and RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: If RemoteFX is selected here, 32 bit per pixel color depth will be chosen
automatically in Color Depth.

Optimization Settings

Item

Description

Connection Quality

Select the option that best describes the quality of your network connection.
Three options are available: LAN (Very Fast), Broadband (Fast), and
Modem (Slow).

NOTE: Selection here will determine the defaults of items in this section as
listed below.

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Themes

Check to allow non-classic themes.

Connection Settings

Item

Description

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in an RAS session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in an RAS session. The default
is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
“3.4.3 Configuring Settings for USB Storage Devices” on page 89.
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Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in an
RAS session.

NOTE: You need to add a local or network printer for your mt188L first, and then
enable this feature here to use that printer in an RAS session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt188L, please refer to section “3.4.7 Adding a Local Printer” on page
93 or “3.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in an RAS session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in an RAS session.

Clipboard Mapping

Click the drop-down menu to enable/disable Clipboard mapping.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in a Remote
Desktop session. Three options are available: Play on this computer, Play on
remote computer, and Do not play.

Option Description

Allows audio playback in an RAS session using

Play on this computer locally attached audio devices.

Disables audio playback in an RAS session using

Do not play locally attached audio devices.

Allows audio playback in an RAS session using

Play on remote computer audio devices attached to the remote computer.

Windows key combination

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local computer, On the remote server,
and In full screen mode only.

Option Description
On the local computer Applies to the local desktop only.
On the remote server Applies to the virtual desktop only.

Applies to the virtual desktop only when the

In full screen mode only desktop is running in the full-screen mode.

Proxy Settings

Item

Description

Use Proxy Server

Check this item if a proxy server is used and then specify the details.




Configuring Client Settings
Configuring Service Access Settings

Click the drop-down menu to select the type of the proxy server according to the
used protocol.

Proxy Type

Four options are available: SOCKS 4, SOCKS 4A, SOCKS 5, and HTTP 1.1.
Proxy Host Specify the IP address of the proxy server.
Proxy Port Specify the port used for proxy service.

Use Proxy Credentials

Check if user authentication is required for a proxy server and then specify
the credentials.

Username

Type the user / account name of the proxy server.

Password

Type the password of the user account.

Additional Settings

Item

Description

Compression

Click the drop-menu to enable / disable the compression for the data traffic.
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Settings for the Connection Type of Standard RDP

NOTE

Wi

- For descriptions of settings for the connection type of Parallels Remote Application
Server, please refer to “Settings for the Connection Type of Parallels Remote
Application Server”on page 228.

General Sub-tab

Server Settings

Item

Description

Session Name

Type in the name for RDP sessions.

Primary Server

Type in the computer name or IP address of the server through which to deliver
an RDP session.

Connection Type

This table only provides descriptions for available settings when Standard RDP
is selected.

Two connection types are available:

Option Description

Parallels Remote
Application Server

Select to access remote desktops and applications
via Parallels Remote Application Server.

Select to access remote desktops via standard

Standard RDP Microsoft Remote Desktop Services.

Network Level Authentication

Select to enable/disable Network Level Authentication.

NOTE: Network Level Authentication is the authentication method used to
enhance the server security by requiring that the user be authenticated
before the logon screen is displayed and a session is created. This is a
more secure authentication method that can help protect the remote
computer from malicious users and software.

Port

The port used by default will be given automatically after you select a connection
type and mode. Type a different one if needed.

Login Settings

Item Description
Username Type in the user/account name used for authentication.
Password Type in the password of the user account used for authentication.
Type in the domain of the server.
Domain NOTE: Domain is a collection of computers on a network that share a common

database and security policy. Leave this field blank if the server doesn’t
belong to any domain.
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Common Settings

Item

Description

Autostart When Startup

Select whether to open an RDP session automatically or not when mt188L is
started up (Autostart mode).

NOTE: There are three similar but different modes for your mt188L and only one
mode will take effect if all are enabled. Three modes and the order of
priority are listed as follows:

No. Mode Description
The client will start up directly with the desired
Remote Deskto session and perform the configured
action after exiting the session.
Available actions include:
1 Appliance

e Re-launching a new session
e Restarting the thin client
e Turning off the thin client

2 Autostart

The client will start up directly with the desired
RDP session and perform the configured action
after exiting the session.

Available actions include:

e not to do anything

e Re-launching a new session
e Restarting the thin client

e Turning off the thin client

3 Quick Connection

The default. The client will enter Atrust Quick

Connection screen after system startup.

NOTE: To use the Autostart mode, ensure that the Appliance mode is disabled.

On Application Exit

Select what to do when an RDP session is ended. Four options are available:
Do Nothing, Restart Application, Reboot, and Shutdown.

Option

Description

Do Nothing

Not to do anything.

Restart Application

Launches an RDP session again.

Reboot

Restarts your mt188L.

Shutdown

Turns off your mt188L.
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Options Sub-tab

Window Settings

Item

Description

Color Depth

Click the drop-down menu to select the desired color depth for an RDP session.
Five options are available: 8 Bit, 15 Bit, 16 Bit, 24 Bit, and 32 Bit.

NOTE: If RemoteFX is enabled in Graphics Acceleration, only 32 bit per pixel
could be selected here.

NOTE: You can configure the upper limit of the color depth for an RDP session
on the host server. In this case, no matter which color depth you choose
here, the value cannot exceed the defined limit.

Resolution

Click the drop-down menu to select the desired display resolution on an RDP
session. Four options are available: Fullscreen, Large Window, Medium
Window, and Small Window.

Option Description

Opens an RDP session in full screen with the same display

Fullscreen resolution as the local desktop.

Large Window Opens an RDP session in a large display resolution.

Medium Window Opens an RDP session in a medium display resolution.

Small Window Opens an RDP session in a small display resolution.

NOTE: To configure the display resolution of the local desktop, please refer to
section “3.3.3 Configuring Display Settings” on page 75.

Graphics Acceleration

Click the drop-down menu to set graphics acceleration. Three options are
available: None, Basic, and RemoteFX.

NOTE: Windows® RemoteFX™ is a technology that offers a rich user experience
over a network for remote desktop users.

NOTE: If RemoteFX is selected here, 32 bit per pixel color depth will be chosen
automatically in Color Depth.

Optimization Settings

Item

Description

Connection Quality

Select the option that best describes the quality of your network connection.
Three options are available: LAN (Very Fast), Broadband (Fast), and
Modem (Slow).

NOTE: Selection here will determine the defaults of items in this section as
listed below.

Desktop background

Check to use the desktop background.

Font smoothing

Check to use ClearType® technology to make fonts clear and smooth.

Show window contents while
dragging

Check to show window contents while dragging a window.

Menu and window animation

Check to show menu and window animation.

Themes

Check to allow non-classic themes.
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Connection Settings

Item

Description

USB Storage Mapping

Click the drop-down menu to enable/disable USB storage mapping.

When Enable is selected, users can access the local USB storage devices, such
as a USB flash drive and memory card reader, in an RDP session.

NOTE: Atrust Client Setup also allows you to enable or disable the use of locally
attached USB storage devices. You need to enable locally attached USB
storage devices first in order to use them in an RDP session. The default
is enabled.

NOTE: To configure the use of USB storage devices, please refer to section
"3.4.3 Configuring Settings for USB Storage Devices” on page 89.

Printer Mapping

Click the drop-down menu to enable/disable printer mapping.

When Enable is selected, users can access a local or network printer in an
RDP session.

NOTE: You need to add a local or network printer for your mt188L first, and then
enable this feature here to use that printer in an RDP session.

NOTE: For detailed instructions on how to add a local or network printer for your
mt188L, please refer to section “3.4.7 Adding a Local Printer” on page
93 or “3.4.8 Adding a Network Printer” on page 96.

Serial Port Mapping

Click the drop-down menu to enable/disable serial port mapping.

When Enable is selected, users can access a serial device, such as a barcode
scanner, in an RDP session.

Smart Card Mapping

Click the drop-down menu to enable/disable smart card mapping.

When Enable is selected, users can access smart cards through a smart card
reader in an RDP session.

Clipboard Mapping

Click the drop-down menu to enable/disable Clipboard mapping.

Local Resources Settings

Item

Description

Remote Audio Playback

Click the drop-down menu to configure the audio playback setting in an RDP
session. Three options are available: Play on this computer, Play on remote
computer, and Do not play.

Option Description

Allows audio playback in an RDP session using

Play on this computer locally attached audio devices.

Disables audio playback in an RDP session using

Do not play locally attached audio devices.

Allows audio playback in an RDP session using

Play on remote computer audio devices attached to the remote computer.

237



238

Configuring Client Settings
Configuring Service Access Settings

Windows key combination

Click the drop-down menu to select where to apply Windows key combinations.
Three options are available: On the local computer, On the remote server,
and In full screen mode only.

Option Description
On the local computer Applies to the local desktop only.
On the remote server Applies to the virtual desktop only.

Applies to the virtual desktop only when the

In full screen mode only desktop is running in the full-screen mode.

Proxy Settings

Item

Description

Use Proxy Server

Check this item if a proxy server is used and then specify the details.

Click the drop-down menu to select the type of the proxy server according to the
used protocol.

Proxy Type

Four options are available: SOCKS 4, SOCKS 4A, SOCKS 5, and HTTP 1.1.
Proxy Host Specify the IP address of the proxy server.
Proxy Port Specify the port used for proxy service.

Use Proxy Credentials

Check if user authentication is required for a proxy server and then specify
the credentials.

Username

Type the user / account name of the proxy server.

Password

Type the password of the user account.

Additional Settings

Item

Description

Compression

Click the drop-menu to enable / disable the compression for the data traffic.




Appendices

This chapter provides instructions on advanced settings, maintenance, and
upgrade for your mt188L thin client.

A.1 Resetting Your mt188L to the Factory Default

How to restore factory default settings for your mt188L

A.2 Updating Firmware for Your mt188L

Four ways to update firmware for your mt188L

A.3 Using SECUREMATRIX Authentication for VMware Connections
Enabling SECUREMATRIX authentication
Using SECUREMATRIX authentication
Changing Your Password Pattern

A.4 Auto Setup Flowchart

Sequence of actions in Auto Setup mode
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A.1 Resetting Your mt188L to the Factory Default

To reset your mt188L to the factory default, please do the following:

@ WARNING

+ Resetting your mt188L to the factory default will erase all current settings in Atrust
Client Setup and restore all settings to defaults.

1. Restart your mt188L.

1. During the POST (Power-on Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

Atrust Thin Client Menu

Normal Mode
Safe Mode
Reset Mode

Firmware update

Reboot
Shutdown

—1) NOTE

i
« You might need to wait about 15 seconds for this menu to appear on the screen.
- Six options are available on Atrust Thin Client Menu: Normal Mode, Safe Mode,

Reset Mode, Firmware update, Reboot, and Shutdown. See the table below for
the description of each option:

Menu Option Description

Normal Mode Boots up your mt188L as the normal startup procedure.
Safe Mode Clears and resets the current screen resolution setting.
Reset Mode Resets your mt188L to the factory default.

Firmware update  Updates firmware for your mt188L through the network.
Reboot Reboots your mt188L.

Shutdown Shuts down your mt188L.

2. Use arrow keys on the keyboard to select Reset Mode, and then press Enter on the keyboard to continue.

3. A message appears prompting for confirmation. Click y on the keyboard to confirm.

4. After completion, press Enter on the keyboard to restart your system.
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A.2 Updating Firmware for Your mt188L

Four ways are available to update firmware for your mt188L:

Method Description
Atrust Thin Client Menu  Downloads firmware from a remote computer and updates firmware for your thin client.
USB Flash Drive Updates firmware with a USB flash drive created by Recovery USB Disk Creator.
Atrust Client Setup Initiates firmware update locally on the thin client with the help of Atrust Client Setup.

Atrust Device Manger Initiates firmware update remotely on the remote computer with Atrust Device Manager.

Using Atrust Thin Client Menu

To update firmware using Atrust Thin Client Menu, please do the following:

1. Connect your thin client to the network, and then restart it.
2. During the POST (Power-On Self-Test) period, press Esc on the keyboard to enter Atrust Thin Client Menu.

3. Select Firmware update and then follow the on-screen instructions to complete the task.

NOTE

+ You need to specify the IP address of the firmware server over the network. A
firmware server is the server where Atrust Device Manager is installed and client
firmware files are imported through Atrust Device Manager.

W)

« For more information about Atrust Device Manager, please refer to the User’s
Manual for Atrust Device Manager.

Using a USB Flash Drive

To update firmware using a USB flash drive created by Recovery USB Disk Creator, please do the following:

NOTE

(alll |

- Forinstructions on how to create a USB flash drive using Recovery USB Disk Creator,
please refer to the Quick Guide for USB Creator.

1. Plug the USB flash drive, and then restart your thin client.
During the POST period, press F7 to enter the Boot Device menu.

Select the USB flash drive on that menu to enter Atrust Thin Client Recovery System screen.

> W

Follow the on-screen instructions to complete the task.
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Using Atrust Client Setup

To update firmware using Atrust Client Setup, please refer to section“3.2.7 Updating Firmware from the
Management Computer” on page 50.

Using Atrust Device Manager

To update firmware using Atrust Device Manager, please refer to the User’s Manual for Atrust Device Manager.
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A.3 Using SECUREMATRIX Authentication for VMware Connections
Enabling SECUREMATRIX Authentication for Custom VMware Connections

To enable SECUREMATRIX authentication for a custom VMware connection, please do the following:

NOTE
- SECUREMATRIX authentication is not available in Quick Connection mode.

&

1. On the local desktop, click START > Settings > Atrust Client Setup to launch Atrust Client Setup.
2. Click Applications > VMware > Add to create a new entry of connection settings.

3. On the General tab, type the desired session name and the server address of View Connection Server.

: Lol dlalisal
® Atrust Client Setup o Lol
Atl'l.lSt Applicati User Interf: Devices Network System
General Options SECUREMATRIX
-~ Remote Desktop
o Citrix ICA - Server Settings
= WMware Wiew Session Name: * |VHV5 ‘ [
S5H Connection Server: * |VCS.V1—Mpoc ‘ e
Port: [ | &
Use Secure Connection(SSL): [ves hd I
Certificate checking mode: [Warn before connectingtor ~]
¢ Login Settings
User Name: | ‘ e
Password: [ =
Domain: [ | &
Desktop / Application Mame: < | E
Preferred Display Protocel: [Manual -l e
¢ Common Settings
Non-nteractive Mode: [ves 1&
Autostart When Startup: [Mo -] =
On Application Exit: | Do Nothing ;l e
Save l | Cancel

4, On the SECUREMATRIX tab, click to check Use SECUREMATRIX.
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B S HHHEE R HHHHHHHSSS SIS
®) Atrust Client Setup o ol
Atrust Applications  User Interface Devices Network System

General Options SECUREMATRIX
- Remote Desktop
- Citrix ICA - Connection Settings
- VMware View .__ Use SECUREMATRIX

WHVE
- SSH

Save H Cancel |

% NOTE

- By default, SECUREMATRIX authentication is disabled.

5. Two fields appear for you to provide SECUREMATRIX related information. Type the server address of GSB
server (the server for SECUREMATRIX authentication service).

- Connection Settings
L« Use SECUREMATRIX

GSB Server Address: + [192.168.0.77 | &

Username: | | L

6. Configure other connection settings if needed, and then click Save to confirm.

7. The access shortcuts will be created on the local desktop and START menu.
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Using SECUREMATRIX Authentication in VMware Connections

When SECUREMATRIX is enabled in your VMware connection, follow the steps and instructions below to use
SECUREMATRIX authentication:

1. Click the shortcut on the local desktop or START menu.
2. A window appears to prompt for the Login ID of SECUREMATRIX authentication.

i) Login

Login ID

( Change Password

3. Type your Login ID, and then click OK to confirm.

% NOTE

+ To change your password pattern, click Change Password. For details, please see
“Changing Your Password Pattern for SECUREMATRIX Authentication” on page 249.

4. The SECUREMATRIX window appears prompting for the password.

SECUREMATRIX

SECUREMATRIX

(7Jla)lz)e]) [e)(s](s])le) [2)(s)(z)(2) (z)[z](e]1]
[4)l7)ls)(e] [e)(e]lo])(s) [a)(7]()[2] [oJ[7](s](3]
s)lsl(z)la) [)s]le)ln) (3)(s)lz)le) [n)la](4](e]
[4)(s](z)s] [o)(z](s])lo] [s](s]lz)[s] (ell=](e](z]

Authentication

Password [ l

5. Type numbers under your password pattern using the keyboard or click numbers directly on the window,
and then click OK to confirm.



247

- For example, if your password pattern is shown as below, type or click numbers,
0,0,4,51,3,6,2 insequence.

(ells)(s)e) [2)(s]07)(z]) [2)(2](o](2]
[e)ls)l2)(s] [a)x)(a)r) [eJ()(o)(=]
[2)(s)a)7) [=l(s)z)le]) [)(a](4](e]
[o)(2](s]e) [o)(s](7)(s]) [e)l=](e](1]

6. A message appears when SECUREMATRIX authentication is completed. Click OK to continue.

Motification from SECUREMATRIX
Last Login Timestamp : 2015-11-16
05:56:33

7. A message appears prompting to provide credentials for access to VMware virtual desktops and applications.
Click OK to continue.

No credentials, please enter,

User o [ ]
Password * [ ]
Domain e [ v]

9. The Desktop and Application list appears. Double-click to select the desired desktop or application.
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Changing Your Password Pattern for SECUREMATRIX Authentication
To change your password pattern for SECUREMATRIX authentication, please do the following:

1. On the window prompting for the Login ID as shown, type your Login ID, and then click Change Password.

Login ID [ |

( Change Password )

2. Type or click numbers under your old password pattern, and then click OK to continue.

SECUREMATRIX |

SECUREMATRIX

7Jls)lz)(e) [e)(s]ls]le) [2)(s]lz)(2]) (z)(2](s](1]
4)l7)le)le] [e)le]le])ls) [a)l7)l3)(2]) (o)(7](s](3]
(s)lells)la) [1)is]le)ln) [3)(slz)le) (7)la])l4](e]
[4)ls)l2)(s] [oJ(2]ls])le] [s](s]lz)ls) Lello]le](z]

Authentication

Password [ l

3. Type or click numbers under your new password pattern, and then click OK to continue.

SECUREMATRIX —
Your new SECUREMATRIX
e | FOEE BEEE @EEE

(2){s](5)(3] [7)z][e](7] [e][3](8][3]
(3){a)lo]2] [s)(7](e][2] [e][4](z][7]
[7){2](2]{3] [z](e][3][e] [e][e](2](2]

Authentication

Mew Password [ l
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4. Type or click numbers under your new password pattern again, and then click OK to continue.

SECUREMATRIX e

SECUREMATRIX

g7 l(3)(2)(2] [e](z]la]le] [2](2][2][2] [e][4](5](6]
flis](2)(s] [e](7])lel(s] [2](s)(s][z] [e][2](5](e]
[lellell2] [e][a]lal2] [2](4][3][2] [e][7](7](5]
lel(sfi[2](4] (6]{4][e]e] [2][7][0](e]

Authentication

Confirm Passward [ l

5. A window appears showing your new password pattern in numerical order and prompting for confirmation.
Click OK to confirm.

SECUREMATRIX

8
7
6
5

Bl W NP

Confirmation
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A.4 Auto Setup Flowchart

Please see next page for sequence of actions in Auto Setup mode.

For details, please refer to User’s Guide for Auto Setup.
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When Auto Setup is enabled, user environment might
vary with preset configurations.

AUTO SETUP REQUIREMENTS

* Auto Setup enabled endpoint devices

* Auto Setup environment and mechanism
*  Network connectivity

» Target virtualization services for use




Specifications

Atrust mt188L mobile thin client

Specifications

Flash Memory

Processor Intel® Celeron® N2807, Dual-core, 1.58 GHz
System Memory 2GB
4GB

Display Type: 15.6” 16:9 Anti-Glare, HD 1366 x 768

Keyb()ard /TOUCh Pad Keyboard: full layout including the numeric keypad
Touchpad: 2-button Glide pad

Sound Built-in speakers

I/O interfaces

Leftside: Right side:

1x RJ-45 1xDCIN 1 x Power button
3xUSB3.0 1 x mini DisplayPort

1 x Microphone port 1x HDMI

1 x Headphone port 1x USB Type-C

Display and base:
2 x Built-in microphone
1 x Webcam (optional)

2 x Built-in speaker

Networking

10/100/1000 Mb Ethernet
Wi-Fi 802.11 ac/a/b/g/n (M.2 interface)
Bluetooth 4.2

AC Adapter

INPUT: 100-240V, 50-60 Hz
OUTPUT: 19V, 3.42A,65W

Battery

Built-in Rechargeable battery
5700 mAh, 64.98 Wh

Operating system

Atrust Linux

Supported Protocols

Microsoft RDP with RemoteFX / Citrix ICA with HDX / VMware PColP

Man agement Atrust Client Setup / Atrust Device Manager
Security Kensington security slot

Dimensions (W)390 x (D)266 x (H)20.05 mm
Weight 1.69 kg (approx.)

Environment

Operating Temperature: 5°C~35°C
Non-operating Temperature: -30°C~60°C
Operating Humidity (Rh): 10% ~ 90% (non-condensing)

Non-operating Humidity (Rh): 5%~ 95%
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